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General Safety Summary

General Safety Summary

Review the following safety precautions to avoid injury and prevent damage to this product or any
products connected to it.

To avoid potential hazards, use this product only as specified.
Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of a larger system. Read the safety sections
of the other component manuals for warnings and cautions related to operating the system.

To Avoid Fire or Personal Injury

Use Proper Power Cord. Use only the power cord specified for this product and certified for the country
of use.

Connect and Disconnect Properly. Do not connect or disconnect probes or test leads while they are
connected to a voltage source.

Connect and Disconnect Properly. Connect the probe output to the measurement instrument before
connecting the probe to the circuit under test. Connect the probe reference lead to the circuit under test
before connecting the probe input. Disconnect the probe input and the probe reference lead from the circuit
under test before disconnecting the probe from the measurement instrument.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings and markings on the product.
Consult the product manual for further ratings information before making connections to the product.

Do Not Operate Without Covers. Do not operate this product with covers or panels removed.

Do Not Operate With Suspected Failures. If you suspect that there is damage to this product, have it
inspected by qualified service personnel.

Avoid Exposed Circuitry. Do not touch exposed connections and components when power is present.

DPOIJET Jitter and Eye Diagram Analysis Tools ix



General Safety Summary

Terms in this Manual

These terms may appear in this manual:

c WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in damage to this product or other
property.
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Introduction to the Application Welcome

Welcome

DPOJET is a jitter, timing, and eye analysis tool for Tektronix Performance Digital Oscilloscopes
(DSA/DPO7000 and DSA/DPO70000 series). DPOJET enables you to achieve new levels of productivity,
efficiency, and measurement reliability on complex clock, digital, and serial data signals.

Some of the features of DPOJET are:

B Advanced Jitter and Timing Analysis for clocks and data signals, with up to 99 simultaneous
measurements on 12 sources.

®  Jitter Guide/Serial Data wizard for easy configuration of popular measurement sets.

B One Touch Jitter wizard for quick jitter summaries.

m  Accurate jitter decomposition and TJ (BER) estimation using industry-accepted methods.
®  Comprehensive measurement statistics.

m Flexible measurement/statistic logging and export capabilities.

B Sophisticated graphical analysis tools such as Histograms, Time Trends, Eye Diagrams, Spectrums,
Bathtub Plots and Real-Time Eye® diagrams with transition and non-transition bit separation.

m  Tektronix patented Programmable PLL software clock recovery.
®  Standards-specific support for clock recovery and jitter separation methods.
B Capture and storage of worst-case waveforms for subsequent analysis.

®  Thorough remote programmability using oscilloscope-like syntax.

Five-Time Free Trial

You can refer to the Optional Applications Software on a Windows-Based Oscilloscope Installation
Manual for details on free trails which are available for all applications. The manual is available on the
Optional Applications Software on Windows-Based Oscilloscopes DVD, in the documents directory.

NOTE. Before evaluating an application, first check that your DSA/DPO series oscilloscope firmware version is

consistent with the version requirements mentioned in the application’s readme file. You can check the firmware
version number from the oscilloscope Help drop-down list (About TekScope). To check the application’s firmware
compatibility, refer to the System Requirements section of the readme.txt file.

If an application is introduced after you receive your oscilloscope, you can download the application as
described in the installation manual (Tektronix part number 071-1888-XX) to obtain the free trial. You can
download the manuals from www.tektronix.com/manuals and www.tektronix.com/software.

DPOIJET Jitter and Eye Diagram Analysis Tools 1
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Introduction to the Application

Related Documentation

Related Documentation

Tektronix manuals are available at: www.tektronix.com/manuals and www.tektronix.com/software. Use
the following table to determine the document that you need:

Table 1: List of reference documents

For information on:

Refer to:

®m  Operating the Oscilloscope

Oscilloscope user manual.
Oscilloscope user online help.

®m  Software warranty

®  List of available applications

®  Compatible oscilloscopes

B Relevant software and firmware version numbers
= Applying a new option key label

B |nstalling an application

®  Enabling an application

= Downloading updates from the Tektronix Web site

Optional Applications Software on Windows-Based
Oscilloscopes Installation Manual, which is provided on
the Optional Applications Software on Windows-Based
Oscilloscopes CD-ROM, in the Documents directory.
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Introduction to the Application Conventions

Conventions

Online Help uses the following conventions:

When steps require sequence of selections using the application interface, the “>" delimiter marks each
transition between a menu and an option. For example, Analyze > Wizard > One Touch Jitter.

The terms “DPOJET application” and “application” refer to DPOJET.
The term “oscilloscope” refers to any product on which this application runs.
The term “DUT” is an abbreviation for Device Under Test.

The term “select” is a generic term that applies to the methods of choosing an option: with a mouse or
with the touch screen.

User interface screen graphics are taken from a DPO7000 series oscilloscope.

You can find a PDF (portable document format) file for this document in the Documents directory on the
Optional Applications Software on Windows-Based Oscilloscopes DVD. The DVD booklet only contains
information on installing the application from the DVD and on how to apply a new label. You can also find
the PDF and the Online Help at Start > Programs >TekApplications > DPOJET.

Table 2: Icon descriptions

Icon Meaning
-| This icon identifies important information.
]
This icon identifies conditions or practices that could result
A in loss of data.
This icon identifies additional information that will help you
use the application more efficiently.

Technical Support

Tektronix welcomes your comments about products and services. Contact Tektronix through mail,
telephone, or the Web site. Click Contacting Tektronix for more information.

Tektronix also welcomes your feedback. Click Customer feedback for suggestions for providing feedback
to Tektronix.

DPOIJET Jitter and Eye Diagram Analysis Tools 3



Introduction to the Application Customer Feedback

Customer Feedback

Tektronix values your feedback on our products. To help us serve you better, please send us your
suggestions, ideas, or other comments you may have regarding the application or oscilloscope.

Direct your feedback via email to
techsupport@tektronix.com

Or FAX at (503) 627-5695, and include the following information:

General Information

B Oscilloscope model number (for example: DSA/DPO7000 or DSA/DPO70000 series) and hardware
options, if any.

m  Software version number.

B Probes used.

Application-specific Information

m  Description of the problem such that technical support can duplicate the problem.

m [fpossible, save the oscilloscope and application setup files as . set and associated .xm1 files.
m [f possible, save the waveform on which you are performing the measurement as a .wfm file.

Once you have gathered this information, you can contact technical support by phone or through e-mail.
In the subject field, please indicate “DPOJET Problem” and attach the . set, .xm1 and .wfm files to
your e-mail. If there is any query related to the actual measurement results, then you can generate a
.mht report and send it.

The following items are important, but optional:

B Your name

B Your company

B Your mailing address

®  Your phone number

B Your FAX number

Enter your suggestion. Please be as specific as possible.

Please indicate if you would like to be contacted by Tektronix regarding your suggestion or comments.

TIP. To copy the above information to your e-mail text editor, right-click the mouse and click Copy. The above
information will be copied to the clipboard where you can paste it to any text editor.
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To include screen shots of the oscilloscope waveform and DPOJET user interface, from your oscilloscope
menu bar, click File > Save As > Screen Capture. To include screenshots of the DPOJET plots, select the
floppy-disk icon from the plots toolbar. In either case, enter a file name in the Save As dialog box, select
an image file format (For Example:.bmp or .png or .jpeg), choose a save location and select Save. You can
then attach the file(s) to your e-mail (depending on the capabilities of your e-mail editor).

Product Description

DPOIJET is a jitter, timing, and eye diagram analysis tool for Tektronix Performance Digital Oscilloscopes
(DSA/DPO7000 and DSA/DPO70000 series). DPOJET enables you to achieve new levels of productivity,
efficiency, and measurement reliability on complex clock, digital, and serial data signals.

The application provides the following features:

One Touch Jitter Summary.

Measurement Setup Wizard.

Auto-detection of signal type (clock or data).

RJ/DJ decomposition on repeating and arbitrary data patterns.
Spectral plot with peak Hold, Averaging, and Nominal.

Eye diagrams with transition and non-transition bits separation.
High and Low Pass measurement filters.

Selectable PLL and line edge detection and clock recovery methods.

Automatic reference level autoset for eye diagrams, jitter and timing measurements.

Timing Analysis

Timing analysis is the measurement of period, setup, hold, skew and other edge-to-edge data timing
relationships.

Eye Diagram Analysis

Eye diagram analysis is the plotting and measurement of eye diagrams and masks.
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Jitter Analysis

Jitter Analysis is the measurement of Time Interval Error (TIE), advanced RJ/DJ decomposition, and
other clock to data edge relationships.

DPOJET Option Levels

The DPOJET application offers two different levels of features, depending on how it is configured. The
configurations are determined by the following order codes and option keys:

m DJE - Jitter and Eye Diagram Analysis Tools - Essentials (Option Key 75)
® DJA - Jitter and Eye Diagram Analysis Tools - Advanced (Option Key 76)

NOTE. The application name “Jitter and Eye Diagram Analysis Tools” is the same for DJE and DJA. However, Help >
About DPOJET indicates the configured option level. Save/Recall is be compatible between the option levels. If a
setup file saved in DJA is recalled in DJE, only the capabilities available in DJE will be recalled.

Jitter and Eye Diagram Analysis Tools - Essentials

You can use Essentials for basic timing and jitter analysis. Essentials offers:

B Period, Frequency and Time Interval Error analysis.

B Timing parametrics such as rise/fall times, pulse width and duty cycle.

®  Many graphical tools such as histograms, time trends, and spectrums.

m Configurable HTML report generation.

B Logging features for recording individual measurements, statistics, or worst-case waveforms.
m  Comprehensive remote control using oscilloscope-like GPIB syntax.

B A wizard interface to ease common setup tasks.

Jitter and Eye Diagram Analysis Tools-Advanced

The Advanced configuration offers all the features of Essentials, and adds the following:
m Jitter separation (RJ/DJ analysis).

B Eye measurements.

B Amplitude measurements.

B Measurement filters.

B Eye diagrams, bathtub plots or Mask Hits waveform plots.

B Pass/Fail limits capability.
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Getting Started Compatibility

Compatibility

For information on oscilloscope compatibility, refer to the Optional Application Software on Microsoft
Windows Based Oscilloscopes Installation Manual, Tektronix part number 071-1888-XX. The manual is
available as a PDF file.

Requirements and Restrictions

Microsoft .NET Framework version 2.0 or higher, MATLAB runtime is required to install and operate
DPOJET on your oscilloscope.
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Supported Probes

The application supports the following probes:

TAP1500
TAP2500
TAP3500
P5100
P6015
P6101A
P6139A
P6241
P6243
P6245
P6249
P6150
P6158
P7240
P7260
P7330
P7340A
P7350
P7350SMA
P7360A
P7380A
P7380SMA
P7313A
P7313SMA
P7513

Supported Probes
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Installing the Application

Refer to the Optional Applications Software on Windows-Based Oscilloscopes Installation Manual for the
following information:

Software warranty.

List of available applications, compatible oscilloscopes, and relevant software and firmware version
numbers.

Applying a new option installation key label.
Installing an application.
Enabling an application.

Downloading updates from the Tektronix Web site.

You can find a PDF (portable document format) file for this document in the Documents directory on the
Optional Applications Software on Windows-Based Oscilloscopes DVD. The DVD booklet contains
information on how to install the application from the DVD and on how to apply a new option installation
key label.

About DPOJET

Click Help > About DPOJET to view application details such as the software version number, application
name, copyright and US patents.
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Starting the Application

Starting the Application

On the oscilloscope menu bar, click Analyze > Jitter and Eye Analysis > Select to open the application.

Application Interface Menu Controls

10

Table 3: Application Menu Controls descriptions

Item Description

Tab Shortcut to a menu in the menu bar or a category of menu
options; most tabs are short cuts.

Area Visual frame with a set of related options.

Option button

Button that defines a particular command or task.

Field

Box that you can use to type in text, or to enter a value with
the Keypad or a Multipurpose knob.

Check Boxes

Use to select or clear preferences.

Scroll bar Vertical or horizontal bar at the side or bottom of a display
area that can be used for moving around in that area.
Browse Displays a window where you can look through a list of

directories and files.

Command button

Button that initiates an immediate action such as Run
command button i in the control panel.

Virtual Keypad icon

Click to use on-screen keypad to enter alphanumeric values.

MP knob references (a or b)

b)
@

Identifiers that show which Multi Purpose Knob (MPK) may
be used as an alternate means to control a parameter;
turn the knob on the oscilloscope front panel to adjust the
corresponding parameter Also, the value can be entered
directly on the MPK display component.
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Virtual Keypad

Select the . icon and use the virtual keypad to enter alphanumeric values, such as reference voltage
levels.
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Tips on DPOJET User Interface
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Here are some tips to help you with the application user interface:

Use the Serial Data/Jitter Guide to rapidly set up and initiate sets of commonly used measurements.
After running the Serial Data/Jitter Guide, you may modify the configuration parameters to meet
specific needs.

Select a measurement to create a measurement and add it to the current measurement table. New
measurements initially use the same source as the earlier measurement, or the most recently used

source. Click b to change the measurement source or adjust other source parameters such as the
reference levels.

Select any measurement multiple times to create multiple copies. This may be useful if you wish to
run the same measurement with different configuration options.

Use the Single button E to obtain a single set of measurements from a single new waveform
acquisition. Pushing the button again before processing has completed will interrupt the processing
cycle.

Use the Run button M to continuously acquire and accumulate measurements. Push the button
again to interrupt the current acquisition.

Use the Recalc button i to perform measurements on the waveform currently displayed on the
oscilloscope, that is without performing a new acquisition. This is useful if you wish to modify a
configuration parameter and re-run the measurements on the current waveform.

DPOIJET Jitter and Eye Diagram Analysis Tools
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Application Directories

Application Directories

The installation directory for DPOJET is C:\Program Files\TekApplications\DPOJET. During
installation, the application sets up directories for various functions such as to save setup files. The file

name extension is used to identify the file type.

Table 4: Application directories

Default directory

Used for

C:\TekApplications\DPOJET\Images

Exported plot files.

C:\TekApplications\DPOJET\Limits

Pass/fail limits files.

C:\TekApplications\DPOJET\Patterns

Bit patterns.

C:\TekAppTications\DPOJET\Logs

Log files. Consists of three subfolders:
B Statistics for statistics log files (.csv)
m  Measurements for measurement log files (.csv) and

= Waveforms for worst case waveforms (.wfm)

@]

:\TekApplications\DPOJET\Masks

Mask files for various serial data standards. For Example -
PCIE, FBDIMM, SATA.

@]

:\TekApplications\DPOJET\Reports

Report files (.mht ).

@]

:\TekApplications\DPOJET

Error log file, DPOJETErrors.log.

@]

:\TekApplications\DPOJET\Examples

Various tutorial and support files.

File Name Extensions

Table 5: File name extensions

File Extension

Description

.Ccsv Ascii file containing Comma Separated Values. This file
format may be read by any ascii text editor (such as
Notepad) or may be imported into spreadsheets such as
Excel.

.xm1 Ascii file containing measurement setup information, limits
or other data in Extensible Markup Language.

.set Binary file containing oscilloscope setup information in a
proprietary format.

.mht An HTML archive file, compatible with common Windows
applications; and contain the full report, including text and
graphics.

wfm Binary file containing an oscilloscope waveform record in a

recallable, proprietary format.

DPOIJET Jitter and Eye Diagram Analysis Tools
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Application Menu Shortcuts
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Application Menu Shortcuts

The DPOIJET application provides shortcuts for navigating the user interface. Use Alt+ A for the Analyze
menu and Alt+A+J for Jitter and Eye Analysis.

NOTE. Alt+A+J is common for all submenus except the Help menu.

Table 6: Application shortcuts

Menu Items SubMenu Shortcut
Wizard One Touch Jitter Alt +A+J+W+0
Serial Data/Jitter Guide Alt +A+J+W+J
Select Alt +A+J+S
Configure Alt +A+J+C
Results Alt +A+J+R
Plots Alt +A+J+P
Reports Alt +A+J+0
Export Data Snapshot Alt +A+J+E+D
Measurement Summary Alt +A+J+E+S
Data Logging Alt +A+J+L
Preferences Alt +A+J+F
Limits Alt +A+J+|
Measurement Summary Alt +A+J+M
Deskew Alt +A+J+K
Help
About DPOJET Alt +H+J
Help on Jitter and Eye Analysis Alt +H+T
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Returning to the Application

When you access oscilloscope functions, the DPOJET control windows may be replaced by the
oscilloscope control windows or by the oscilloscope graticule. You can access oscilloscope functions
in the following ways:

®  From the menu bar on the oscilloscope, choose Analyze > Jitter And Eye Analysis > Select.

B Alternatively, you can switch between recently used control panels using the forward or backward

arrows I on the right corner of the control panel.

Saving a Setup

The DPOJET application state is automatically saved along with the oscilloscope state. To save the
oscilloscope settings and application state, follow these steps:

1. Click File > Save As > Setup.
2. In the file browser, select the directory to save the setup file.

3. Select or enter a file name. The application appends *_DPOJET.xm1 to store DPOJET setup, and
* . set to store oscilloscope settings.

4. Click Save.

NOTE. After the oscilloscope application is started, DPOJET needs to be launched at least once before any saved
DPOJET configuration can be recalled.

Recalling a Saved Setup

To recall the default application setup and oscilloscope settings, do the following steps:
1. Click File > Recall.
2. Select the directory in the file browser from where you can recall the setup file.

3. Select a .set file and click Recall.

NOTE. Only .set files can be selected for recall; any corresponding _DPOJET.xml file in the same directory will be
recalled as well, if DPOJET has been launched at least once since the oscilloscope application was started. If
DPOJET has not been launched at least once, the oscilloscope settings will be recalled but the DPOJET configuration
will be ignored.
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Recalling the Default Setup

To recall the default application and oscilloscope settings, click File > Recall Default Setup.
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Setting Up the Application for Analysis

Setting Up the Application for Analysis

Refer to the following sections for more details on various measurements:

® Period and Frequency measurements

B Jitter measurements
B Time measurements
® Eye measurements

B Amplitude measurements

Table of Measurements-Period/Freq

Definitions of the period and frequency-related measurements are given in the following table:

Table 7: Period/Frequency measurements definitions

Measurement

Description

Period

For clock signals, the elapsed time between consecutive
crossings of the mid reference voltage level in the direction
specified; one measurement is recorded per crossing pair.
For data signals, the elapsed time between consecutive
crossings of the mid reference voltage in opposite directions
divided by the estimated number of unit intervals for that
pair of crossings; one measurement is recorded per unit
interval so N consecutive bits of the same polarity result in
N identical period measurements.

Frequency

The inverse of the period for each cycle or unit interval.

CC-Period

The cycle-to-cycle period; the difference in period
measurements from one cycle to the next, that is the first
difference of the Period measurement.

N-Period

The duration of N periods.

Pos Width

Amount of time the waveform remains above the mid
reference voltage level.

Neg Width

Amount of time the waveform remains below the mid
reference voltage level.

+Duty Cycle

The ratio of positive width to period, expressed in %.

-Duty Cycle

The ratio of negative width to period, expressed in %.

+CC-Duty

The difference between two consecutive positive widths.

—CC-Duty

The difference between two consecutive negative widths.

DPOIJET Jitter and Eye Diagram Analysis Tools
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Table of Measurements-Jitter

Definitions of the jitter-related measurements are given in the following table.

NOTE. Alljitter measurements except TIE are statistical measurements that require sufficient record length so that all
deterministic effects can be observed and the random jitter can be modeled.

Table 8: Jitter measurements definitions

Measurement Description

TIE Time Interval Error is the difference in time between an
edge in the source waveform and the corresponding edge in
a reference clock or explicitly by another source signal. The
reference clock is determined by a clock recovery process.

RJ Random Jitter is the statistics for all timing errors not
exhibiting deterministic behavior, based on the assumption
that they follow a Gaussian distribution. Random Jitter is
typically characterized by its standard deviation.

RJ-00 Random Jitter as defined above, but calculated based on a
simplified assumption that the histogram of all deterministic
jitter can modeled as a pair of equal-magnitude Dirac
functions (impulses known as delta-functions).

DJ Deterministic Jitter is the statistics for all timing errors that
follow deterministic behavior. Deterministic Jitter is typically
characterized by its peak-to-peak value.

DJ-00 Deterministic Jitter as defined above, but calculated on the
same simplified model as described under RJ-00.

PJ Periodic Jitter is the statistics for that portion of the
deterministic jitter which is periodic, but for which the period
is not correlated with any data in the waveform.

DDJ Data-Dependent Jitter is the statistics for that portion of the
deterministic jitter directly correlated with the data pattern
in the waveform.

DCD Duty Cycle Distortion is the statistics for that portion of the
deterministic jitter directly correlated with signal polarity, that
is the difference in the mean timing error on positive edges
versus that on negative edges.

TJ@BER Total Jitter at a specified Bit Error Rate (BER). This
combines the Random and Deterministic effects, and
predicts a peak-to-peak jitter that will only be exceeded with
a probability equal to the BER.
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Table 8: Jitter measurements definitions (cont.)

Measurement

Table of Measurements-Time

Description

Jitter Summary

This is not an individual measurement but a convenience
function. Pressing this button automatically adds a set of
eleven jitter-related measurements with a single action. The
measurements are: TIE, RJ, RJ-86, DJ, DJ-86, PJ, DDJ,
DCD, TI@BER, Width@BER , and Phase Noise .

Phase Noise

The RMS magnitude for all integrated timing jitter falling
between two specified frequency limits. This measurement
is only applicable for clock signals.

Table of Measurements-Time

Definitions of the time-related measurements are given in the following table:

Table 9: Time measurements definitions

Measurement

Description

Rise Time

Elapsed time between the Low reference level crossing and
the High reference level crossing on the rising edge of the
waveform.

Fall Time

Elapsed time between the High reference level crossing
and the Low reference level crossing on the falling edge
of the waveform.

High Time

Amount of time the waveform remains above the high
reference voltage level.

Low Time

Amount of time the waveform remains below the low
reference voltage level.

Setup

Elapsed time between the designated edge of a data
waveform and that of a clock waveform, based on their
respective mid reference level crossings.

Hold

Elapsed time between the designated edge of a clock
waveform and that of a data waveform, based on their
respective mid reference level crossings.

Skew

Time difference between two similar edges on two
waveforms assuming that every edge in one waveform has
a corresponding edge (either the same or opposite polarity)
in the other waveform; edge locations are determined by the
mid reference voltage level.

DPOIJET Jitter and Eye Diagram Analysis Tools
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Table of Measurements-Eye

20

Table of Measurements-Eye

Definitions of the eye-related measurements are given in the following table:

Table 10: Eye measurements definitions

Measurement

Description

Height

The measured clear vertical eye opening at the center of
the unit interval. Height = High(min) — Low(max)

Width

Measured clear horizontal eye opening at the middle
reference level.

Width = Ul(mean) — TIE(max) — TIE(min)

Width@BER

The horizontal eye opening projected to correspond to

a specified Bit Error Rate. This number is obtained by
measuring the jitter on the waveform performing RJ/DJ
separation analysis, creating a bathtub curve, and reporting
the bathtub width at the appropriate error rate. This eye
width may not match the observed eye width because

it is a statistical measure. The measurement requires a
sufficient record length so that all deterministic effects can
be observed and the random jitter can be modeled.

Width(BER) = Ul(mean) - TJ(BER)

Mask Hits

The number of unit intervals for which mask violations
occurred. A mask violation occurs when, during a unit
interval, the waveform passes through a segment of the
defined mask. Mask hits are separately tallied for Segment
1 (upper), Segment 2 (center-of-eye mask) and Segment 3
(lower), and the total for all three segments is also reported.
Thus, as many as three hits can be added to the total count
for each unit interval. The population for this measurement
gives the total number of unit intervals observed.
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Table of Measurements-Amplitude

Table of Measurements-Amplitude

Definitions of the amplitude-related measurements are given in the following table:

Table 11: Amplitude measurements definitions

Measurement

Description

High

Vertical value in the central portion of the unit interval (Ul)
for high data bits. The percent of the Ul over which the
waveform is evaluated is adjustable, as is the method

by which a single value is derived from this span. The
measurement may optionally be limited to transition or
non-transition bits only.

Low

Vertical value in the central portion of the unit interval (Ul)
for low data bits, with configuration options matching those
of the High measurement.

High-Low

Difference between the mean value of the High

measurement and the mean value of the Low measurement.

Common Mode

Common-mode voltage for the two

o 1+ 5 2
o] 227CE . nree ]

sources.

T/nT-Ratio

Ratio of the transition eye-voltage to the nearest subsequent

non-transition eye voltage, expressed in decibels.

V-Diff —Xovr

Voltage level at the crossover voltage of a differential signal

pair.

One Touch Jitter

One Touch Jitter is a process for automatically performing complex jitter analysis with a single menu
selection. The process selects a waveform source, sets the horizontal and vertical scales, chooses
measurements, generates statistical results and creates plot summary (Histogram, Spectrum, Bathtub and

Eye Diagram). To run this process, select Analyze > Jitter and Eye Analysis > Wizard > One Touch

Jitter.

By default, the DPOJET application chooses an appropriate source for the jitter measurements from the

available active source(s) (amplitude >50 mV) before generating the jitter summary.

DPOIJET Jitter and Eye Diagram Analysis Tools
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NOTE. If the source amplitude is not greater than 50 mV, the application displays a message “Signal amplitude
is extremely low for the selected source”.

The following logic is used if none or many sources are active:

® None of the sources are active

B Only one source is active

® Two sources are active

Three sources are active

B Four or more sources are active

Case 1: None of the sources are active

If none of the sources are active, you are prompted to select any one of the Ch, Ref or Math sources.
The selected source is validated to have amplitude >50 mV. When the amplitude of the selected source
is >50 mV, then autoset is performed to increase vertical and horizontal resolution of the signal. The
selected source is assigned for all single source jitter measurements. The results and plots are generated
for a single sequence.

Case 2: Only one source is active

The application checks if the active source has amplitude >50 mV. The selected source is assigned for all
single jitter measurements. The results and plots are generated for a single sequence.

Case 3: Two sources are active

The application checks whether the active sources are a differential pair. Creates a Math waveform taking
the difference of the other two (Example: Math1=Refl-Ref2). The lowest numbered Math waveform

is considered as the source for all single jitter measurements. The results and plots are generated for a
single sequence.
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If the active sources are not a differential pair, the application checks if one of the source is a clock with a
period that divides the other sources. An explicit clock recovery method derives the clock from the clock
source. The application creates explicit-clock measurements TIE, Height, TI@BER, RJ-33, DJ-66 and
Width@BER for the source. The results and plots are generated for a single sequence.

If one of the active sources is not a clock, the application selects a single source from the active sources
using the following priority:

m st Lowest numbered Math
B 2nd- [ owest numbered Channel
® 3rd- Lowest numbered Ref

The results and plots are generated for a single sequence.

Case 4 : Three sources are active

The application checks whether one of the active sources is a Math, which is defined as difference of two
sources (Example: Math1=Ref1-Ref2 ). The application selects the Math waveform as the source for all
single source jitter measurements. The results and plots are generated for a single sequence.

If one of the active sources is not a Math, the application selects a single source from the active sources
using the following priority:

B st owest numbered Math
m 2nd-T owest numbered Channel
m 3rd-[ owest numbered Ref

The application creates single source jitter measurements. The results and plots are generated for a single
sequence.

Case 5: Four or more sources are active

If four or more sources are active, the application selects a single source from the active sources using
the following priority:

B st owest numbered Math
m 2nd_T owest numbered Channel
m 3rd-[ owest numbered Ref

The application creates single source jitter measurements for the selected source. The results and plots
are generated for a single sequence. The following figure shows the summary plot after One Touch
Jitter is performed.
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About Serial Data/Jitter Guide

The Serial Data/Jitter Guide allows you to set up, configure and run a measurement without intimate
knowledge about the control menus.

Select Analyze > Jitter and Eye Analysis > Wizard > Serial Data/Jitter Guide to launch the Serial
Data/ Jitter Guide.

The Serial Data/ Jitter Wizard includes the following steps:
B Select Measurement

E Configure Measurement

®  Select Source(s)

B Configure Autoset Options

= Select Plots

NOTE. You can exit the Serial Data/Jitter Wizard without affecting any settings in the DPOJET application by clicking
Cancel anytime before clicking the Finish button.
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Select Measurement

In this step, you can select any of the listed measurements:

Which measurement would you like to make
{+ Period and Frequency

) Skew

{_ Time Interval Error (TIE)

@ Select Measurement

| ditter Summary
- Total (TJ@BER)
- RJ, DJ, P, DD, TIE, DCD

o Eve Summary
- Height S
- Width, Width@BER
- Unit Interval

Period and Frequency
Skew
Time Interval Error (TIE)

Jitter Summary includes Total Jitter (TJ@BER), RJ, DJ, PJ, DDJ, TIE, and DCD measurements and
plots

Eye Summary includes Height, Width, Width@BER, and Unit Interval measurements and plots

By default, the Period and Frequency measurement is selected. Click Next to accept the measurement

and proceed to Configure Measurement. The transition to next step is represented by on the left
along with selections or default values.
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About Configuring Measurement

By default, the configuration parameters are displayed for Period and Frequency, TIE and Eye
measurements. The Configure Measurement option is available only for Skew and Jitter Summary. The

selection in the previous step is displayed on the left.
B Configure Skew Measurement

B Configure Jitter Summary Measurement

Configure Measurement-Skew

If you select Skew in the previous step, you can configure edges by selecting the From and To edges and
set the measurement limits.

Click Next to select the measurement sources.

Select Edges

From Edge: To Edge:

[+ Rise {+) Same as From
(_Fall (| Opposite as From

() Both

Meas Range Limits

Max Value Min Value
10ns -10ns

Related Topics
B Configure Edges for Skew Measurement
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Configure Measurement-Jitter Summary

If you select Jitter Summary measurement in the previous step, you can set the pattern length by selecting
Repeating pattern and then entering the pattern length in the text box. If you have a non-repeating
waveform pattern or if the pattern length is unknown, select Arbitrary.

NOTE. The measurements that you select also determine the plot types.

Click Next to select the measurement sources.

Serial Dgiﬁ/Ji‘rter Wiz

Analysis Method

@ Configure Measurement O Arbitrary Pattern

{+) Repeating Pattern

| Pattern Length

2u

Related Topics
m RJ/DJ Analysis Parameters
= RJ/DJ
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Select Sources

In this step, you can select the measurement source(s). The source selection depends on the measurement
type. By default, Sourcel is displayed automatically for all the measurements depending on the waveform
last used. If Chl/Refl/Mathl is displayed for Sourcel, Source2 is Ch2/Ref2/Math2 else Ch1/Math1/Ref1

will be selected as Source2.

Serial Daﬁ/\Jitter Wizare!

Source 1

(=]

- O G

n@ @
@ Select Source(s)

The Source2 option is displayed only for two source measurements such as Skew.
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Select Sources

Select Source(s)

Click Next to configure autoset.

DPOJET litter and Eye Diagram Analysis Tools
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Configure Autoset Options

In this step, you can choose to automatically adjust the oscilloscope settings or the reference levels before
the measurement. The default of Yes is recommended. By selecting No, you will retain the current
oscilloscope settings and/or ref levels.

Click Next to select plots.

Wiould you like the horizontal and vertical
settings optimized based on the signal?

[+ Yes (Recommended)

|| No, please retain the current settings

Would vou like the reference levels
Configure Autoset Options automatically chosen based on the signal?

|+ Yes (Recommended)

O Mo, please retain the current ref levels

Select Plots

30

In this step, you can select the plots that you want to display. The measurements that you selected earlier
also determine which plot types will be available in this step. The following table lists the available
plots for measurements:

Table 12: Measurements and available plots

Measurement Plots

Period and Frequency Period Trend, Period Spectrum, Period Histogram.
Skew Skew Trend, Skew Spectrum.

TIE TIE Trend, TIE Spectrum, TIE Histogram.

DPOJET litter and Eye Diagram Analysis Tools



Operating Basics Select Plots

Table 12: Measurements and available plots (cont.)

Measurement Plots

Jitter Summary TIE Trend, TIE Spectrum, TIE Histogram, and Bathtub
Curve.

Eye Summary Eye Diagram (Transition Bit), Eye Diagram (Non Transition

Bit) Unit Interval Histogram, and Eye Width@BER.

In this example, the selections shown are for a Period and Frequency measurement.

Serial Datadlitter Wizaret—

‘What plots would you like to see 7

|/ Time Trend [Period]

|+ Histogram [Period]

Click Finish to start the acquisition sequence using the selected settings. The Serial Data/Jitter Guide
window closes and the results screen is displayed.
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-} DPOET Plots
RS ELETR

Time Period1: Time Trend

About Jitter And Eye Diagram Analysis Options

| A EFeD MER e e

Period1: Spectrum H: ¥ Hi Period1: Histogram H:Time

4MHz EMHz 8MHz  10MHz

Population Max-cc Min-cc

NOTE. None of the user specified settings are retained if you click Cancel before clicking Finish.

About Jitter And Eye Diagram Analysis Options
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Click Analyze > Jitter And Eye Analysis to view the following options:

m Export Data Snapshot

®  Export Measurement Summary

B Data Logging
m Preferences

B Limits

B Measurement Summary

DPOIJET Jitter and Eye Diagram Analysis Tools



Operating Basics Deskew

m Deskew

Deskew

To ensure accurate results for two-channel measurements and differential signals acquired on two channels,
it is important to first deskew the probes and oscilloscope channels before you take measurements of
your DUT.

The application includes an automated deskew utility that you can use to deskew any pair of oscilloscope
channels.

NOTE. To produce the best deskew results, you should connect the probes to the fastest slew rate signals from
your DUT.

Connecting to a Device Under Test (DUT)

You can use any compatible probes or cable interface to connect between your DUT and oscilloscope.

c WARNING. To avoid electric shock, remove power from the DUT before attaching probes. Do not touch exposed
conductors except with the properly rated probe tips. Refer to the probe manual for proper use. Failure to do so
may cause injury or death.

Refer to the General Safety Summary in your oscilloscope manual.

Deskewing on Oscilloscopes with Bandwidth Extension

Some Tektronix oscilloscopes feature software-based bandwidth extension. The bandwidth extension
may be enabled on a per-channel basis.

Enabling or disabling bandwidth extension on any channel affects the skew on that channel. Thus, you
should deskew probes and channels after you make such configuration changes. Bandwidth Extension
provides improved timing accuracy, phase matching, and amplitude accuracy. It also will provide noise
reduction. We recommend Bandwidth Extension be used at all times.

Steps to Deskew Probes and Channels

To deskew probes and oscilloscope channels, follow these steps:

1. Refer to Connecting to a Device Under Test before starting the procedure.
2. Connect both probes to the fastest signal in your DUT.

Set up the oscilloscope as follows:
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1. Use the Horizontal Scale knob to set the oscilloscope to an acquisition rate so that there is a minimum
of two, preferably five, samples per edge or more samples on the deskew edge.

2. Use the Vertical Scale and Position knobs to adjust the signals to fill the display without missing
any part of the signals.

3. Set the Record Length so that there are more than 100 edges in the acquisition.
4. Launch the DPOJET application.
5. Click Analyze > Jitter And Eye Analysis > Deskew.

X
—Deskew Setup

Ch2

Ch1

—
= T

6. Set the Reference channel source to Chl. The source waveform is the reference point used to deskew
the remaining channels.

7. Set the Channel to be Deskewed source as Ch2.
8. To start the process, click Perform Deskew.
9. Repeat steps 7 and 8 for other Ch waveforms.

10.Select Summary to view the deskew values.
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Deskew Summary

The Deskew Summary dialog lists the channel source and its deskew values.

Source  Deskew Value

Ch1
Ch2

Ch3
Ch4

DPOJET litter and Eye Diagram Analysis Tools
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0.0s
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Export Data Snapshot-Statistics
You can save a snapshot of the current statistics in .csv format. The default location is
C:\TekApplications\DPOJET\Logs\Statistics.

Click Analyze > Jitter and Eye Analysis > Export > Data Snapshot > Statistics to view the following:

Data Snapshot

Select Target Measurements

e
Statistics
Measurement

v Neg Width1

File Name

|C:\Tekﬁppllcat|on5\D POJET \Logs\Statistics\070903_124158 @

Table 13: Data Snapshot- Statistics options

Item Description

Select Target Measurements Displays the measurement list. Click a row to select the
measurement. By default, all measurements are selected.

Select All Selects all the measurements in the list for saving statistics.

Clear All Deselects all the measurements from the list.

Save Statistics

Save Saves the current statistics of selected target measurements
to a log file.

File Name

Browse Saves the .csv file in the specified directory. The file format

is YYMMDD_HHMMSS_Stats.csv. The default directory is
C:\TekAppTications\DPOJET\Logs.

Close Accepts the changes and closes the window.
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NOTE. The default location for saving log files can be changed in the Preferences dialog box.

Related Topics

m  Export Data Snapshot-Measurement

Export Data Snapshot-Measurement

You can save a snapshot of the data points in .csv format. The default location is
C:\TekApplications\DPOJET\Logs\Measurements.

Click Analyze > Jitter and Eye Analysis > Export > Data Snapshot > Measurement to view the
following:

Statistics
Measurement
| [~ Pos Width1

|| Meg Width1

Folder

IC:\TekﬂppIications\D POJET"Logs"Measurements
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Table 14: Data Snapshot- Measurement options

Item

Export Data Snapshot-Measurement

Description

Select Target Measurements

Displays the measurement list. Click a row to select the
measurement. By default, all measurements are selected.

Select All

Selects all the measurements in the list for saving statistics.

Clear All

Deselects all the measurements from the list.

Save Measurements

Save Saves the data points for current acquisition of selected
target measurements in a log file.

Folder

Browse Saves the .csv file in the specified directory. The
default directory is C:\TekApp1ications\DPO-
JET\Logs\Measurements.

File Names

View Displays View Log File Names dialog box which lists the
measurements and their source(s) with corresponding
log file name inYYMMDD_HHMMSS_<Measurement
Name>-<SourceName> . csv format.

Close Accepts the changes and closes the window.

View Log File Names

The View Log File Names dialog box lists the measurements and their source(s) with corresponding
log file name in YYMMDD_HHMMSS_<Measurement Name>-<SourceName>.csv format. Click Close

to close the dialog box.

38
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30245 Period1-Chil.csv
070903_130245_Pos Width1-Ch1.csv
070903_130245_Neg Width1-Ch1.csv

Related Topics
B Export Data Snapshot
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Export Measurement Summary

Export Measurement Summary

Click Analyze > Jitter and Eye Analysis > Export > Measurement Summary to save the generated
report in C:\TekAppTications\DPOJET\Reports.The exported measurement summary contains
information only about application setup and configuration.

Save As

3

iy Recent
Documents

=
[
Desktop

iy Documents
tdy Computer

dy Metwork,
Places

? )X

Save jr: | =) Reports

=l E cF E-

File: narne:

Save az type:

| teazRepart.mhl

|F|ep|:|rt files [".mht)

j Save
=

Cancel

i

Data Logging-Statistics
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The application can continuously log (save to file) the calculated statistics. You can save the statistics to a
“comma separated value” (.csv) file to import into a text editor, a spreadsheet, or an analysis tool.

By default, all measurements are selected. You can select individual measurements by selecting the

row in the table on the left.

The steps for logging statistics are:

1. Click Analyze > Jitter and Eye Analysis > Data Logging > Statistics to view the Logging Statistics

screen.
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Select Target Measurements

Measurement
|v|] Pos Width1

[v] Meg Width1

File Name

Data Logging-Statistics

Log Statistics

& @

|C:\Tekﬁpplication5\D POJET \Logs"Statistics\070903_123525 a

2. Select the measurements which you want to log in the Select Target Measurements table on the left.
Click Select All to select all the measurements for logging or click Clear All to deselect the current

measurements list.

3. Click On/Off to enable/disable automatic logging statistics for all selected measurements.

4. Click Browse to select a directory.

The default directory is C:\TekApplications\DPOJET\Logs\Statistics.

Table 15: Log-Statistics options

Item

Description

Select Target Measurements

Displays the measurement list. Select the check box to
select the measurement. By default, all measurements are
selected.

Select Al Selects all the measurements in the list.

Clear All Deselects all the measurements in the list.

Log Statistics

Off Disables automatic logging for all selected measurements.
On Enables automatic logging for all selected measurements.
File Name

Browse Saves the .csv file in the specified directory. The file format

is YYMMDD_HHMMSS_Stats.csv. The default directory is
C:\TekAppTications\DPOJET\Logs\Statis-
tics.

DPOJET litter and Eye Diagram Analysis Tools
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NOTE. Microsoft Excel has a limitation where you cannot increase the number of rows (65,536) or columns
(256) beyond the maximum row and column limits. Opening log files in Wordpad or another analysis package is
recommended. An error message “File not loaded completely” is displayed, if you try to open a log file with data
exceeding the aforesaid row and column limits.

Related Topics
m Data Logging-Measurement

® Data Logging-Worst Case

Data Logging-Measurement

You can log the actual individual measurement data values as measurement files.

1. Click Analyze > Jitter and Eye Analysis > Data Logging > Measurement to view the Logging screen.

Statistics

|»| Pos Width1
Worst Case ¥ Meg Width1

Folder

IC:\Tequ)pIications\D POJET"Logs\Measurements @ i

2. Select the measurements that you want to log in the Select Target Measurements table on the left.
Click Select All to select all the measurements for logging or click Clear All to deselect the current
measurements list.

3. Click On/Off to enable/disable logging for all selected measurements.
4. Click Browse to select a directory.

The default directory is C:\TekApplications\DPOJET\Logs\Measurements.
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Table 16: Log-Measurements options

Item

Data Logging-Measurement

Description

Select Target Measurements

Displays the measurement list. Select the check box to
select the measurement. By default, all measurements are
selected.

Select Al Selects all the measurements in the list.
Clear All Deselects all the measurements from the list.
Log Measurements
Off Disables automatic logging for all selected measurements.
On Enables automatic logging for all selected measurements.
Folder
Browse Saves the .csv file in the specified directory.
The default directory is C: \TekApp1ications\DPO-
JET\Logs\Measurements.
File Names
View Displays View Log File Names dialog box which

lists the selected measurements with source(s)
and their corresponding log file names in
YYMMDD_HHMMSS_<MeasurementName>-
<SourceName>.csv format.

View Log File Names

The View Log File Names dialog box lists the selected measurements with source(s) and their
corresponding log file names in YYMMDD HHMMSS <MeasurementName>-<SourceName>.csv

format. Click Close to close the dialog box.

DPOIJET Jitter and Eye Diagram Analysis Tools
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070903_130245_Perniod1-Ch1.csv
070903_130245_Pos Width1-Ch1.csv
070903_130245_Neg Width1-Ch1.csv

Related Topics
®m Data Logging-Statistics

® Data Logging-Worst Case
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Data Logging-Worst Case

Data Logging-Worst Case

1. Click Analyze > Jitter and Eye Analysis > Data Logging > Worst Case to view the Worst Case

Logging screen.

Data Logging

Select Target Measurements

SRS Measurement  Source(s)
Measurement B | periodt

[»] Pos Width1
Worst Case v Neg Width1

Cht
Cht

Folder

IC:\TekAppIicaﬁons\DF‘OJ ET'\Logs"Waveforms

Log Worst Case Waveforms

& @

e

2. Select the measurements which you want to log in the Select Target Measurements table on the left.
Click Select All to select all the measurements for logging or click Clear All to deselect the current

measurements list.

3. Click On/Off to enable/disable worst case logging for all selected measurements.

4. Click Browse to select a directory.

The default directory is C:\TekApplications\DPOJET\Logs\waveforms.

Table 17: Log-Worst Case options

Item

Description

Select Target Measurements

Displays the measurement list. Select the check box to
select the measurement. By default, all measurements are
selected.

Select Al Selects all the measurements in the list.

Clear All Deselects all the measurements in the list.

Log Worst Case Waveforms

Off Disables the application to save worst case waveforms for
all selected measurements.

On Enables the application to save worst case waveforms for

all selected measurements.

DPOJET litter and Eye Diagram Analysis Tools
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Table 17: Log-Worst Case options (cont.)

Data Logging-Worst Case

Item Description

Folder

Browse Saves the .csv file in the specified directory.
The default directory is C: \TekApp1ications\DPO-
JET\Logs\waveforms.

File Names

View Displays View Log File Names dialog box which

lists the selected measurements with source(s)

and their corresponding log file names in
YYMMDD_HHMMSS_<MeasurementName>-
<Source(s)>_Max<Source Number>.wfm and
<MeasurementName>-<Source(s)>_Min<Source
Number .wfmt format.

t For example, if the selected measurement is Skew1 with Ref1 and Ref3 as sources, then the file names will be Skew1-Ref1,Ref3_Max1.wfm,
Skew1-Ref1,Ref3_Min1.wfm, Skew1-Ref1,Ref3_Max2.wfm, and Skew1-Ref1,Ref3_Min2.wfm.

View Log File Names

The View Log File Names dialog box lists the selected measurements with source(s) and their
corresponding log file names in YYMMDD_HHMMSS_<MeasurementName>-<Source(s)>_Max<Source
Number>.wfm and <MeasurementName>-<Source(s)>_Min<source Number>.wfm format. Click

Close to close the dialog box.

View L File Names

Period1-Ch1_Max1.wfm
Period1-Ch1_Min1.wfm
Pos Width1-Ch1_Max1.wfm
Pos Width1-Ch1_Min1.wfm
Neg Width1-Ch1_Max1.wfm
Neg Width1-Ch1_Min1.wfm
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Related Topics
® Data Logging-Statistics

® Data Logging-Measurement

Measurement Configuration Summary-Measurement

Click Analyze > Jitter and Eye Analysis > Measurement Configuration Summary > Measurement to
view measurement, source and the configuration parameters of each measurement.

M it
iyt endit b Edge: Signal Type: Auto, Clock Edge: Rise | Filters

==» F1: Spec: No Filter, F2: Spec: No Filter | General ==
Ref Levels Measurement Range Limits: Off, Max: 1ms, Min: 0s,
Custom Name: —

Filters == F1: Spec: No Filter, F2: Spec: No Filter |
General => Measurement Range Limits: Off, Max:
10ns, Min: 1ns, Custom Name: —

Filters == F1: Spec: No Filter, F2: Spec: No Filter |

General => Measurement Range Limits: Off, Max:
10ns, Min: 1ns, Custom Name:
Eclges == Signal Type: Auto, Clock Edge: Rise | Filters
=» F1: Spec: No Filter, F2: Spec: No Filter | General ==
Measurement Range Limits: Off, Max: 10GHz, Min:
1MHz, Custom Name: -
Edges == Signal Type: Auto, Clock Edge: Rise | General
== Measurement Range Limits: Off, Max: 1ms, Min: 0s, a

Custam Mamea:

Table 18: Measurement configuration information

Item Description

Measurement Displays the measurement name.

Source Displays the selected source.

Others Displays the other configuration information related to the
selected measurement.

OK Closes the window.
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Related Topics
B Measurement Summary-Ref Levels

B Measurement Summary-Misc

Measurement Summary-Ref Levels

Click Analyze > Jitter and Eye Analysis > Measurement Configuration Summary > Ref Levels to
view the ref level tab. This tab provides information about ref level configuration per source. Displays the
reference voltage levels for the high, mid, and low thresholds for the rising edge and for the falling edge of
each active source, and the hysteresis.

 Measurement Configuration Summary -

Measurement

Ref Levels

Table 19: Ref Level configuration information

Item Description

Source Displays the selected source.

Rise High Displays the high threshold level for the rising edge of the
source.

Rise Mid Displays the middle threshold level for the rising edge of
the source.

Rise Low Displays the low threshold level for the rising edge of the
source.
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Table 19: Ref Level configuration information (cont.)

Measurement Summary-Ref Levels

Item Description

Hysteresis Displays the threshold margin to the reference level which
the voltage must cross to be recognized as changing; the
margin is the relative reference level plus or minus half the
hysteresis; use to filter out spurious events.

Fall High Displays the high threshold level for the falling edge of the
source.

Fall Mid Displays the middle threshold level for the falling edge of
the source.

Fall Low Displays the low threshold level for the falling edge of the
source.

OK Closes the window.

Related Topics

B Measurement Configuration Summary-Measurement

®  Measurement Summary-Misc

DPOIJET Jitter and Eye Diagram Analysis Tools
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Measurement Summary-Misc

Click Analyze > Jitter and Eye Analysis > Measurement Configuration Summary > Misc tab to
view various configuration parameters. The Miscellaneous tab shows whether the Gating, Qualify, and
Stat Pop Limit functions are enabled; if enabled, it also shows the source for qualification, the size for
population, and various other configuration choices.

Measurement Configuration

Measurement

Ref Levels

Table 20: Miscellaneous configuration information

Item Description

State Displays On when Gating, Qualify and Population are
enabled and Off when they are disabled.

Source Displays the selected source for qualify.

Size Specifies the maximum population which can be obtained
for each active measurement.

OK Closes the window.

Related Topics

B Measurement Configuration Summary-Measurement

B Measurement Summary-Ref Levels
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About Preferences Setup

The applications provides Preferences Setup, where you can set options. These options remain unchanged
until you reset them. Click Analyze > Jitter and Eye Analysis > Preferences to view the Preferences
screen. To use the application more efficiently, you can set the options in the following tabs:

B Preferences-General
® Preferences-Measurement

m Preferences-Path Defaults

Preferences-General

Click Analyze > Jitter and Eye Analysis > Preferences > General to view the following:
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Preferences-Measurement

52

Table 21: Preferences-General options

Preferences-Measurement

Item Description

View Log Displays the error/warning log file in a notepad window
when the button is pushed.

Clear Log Clears the error/warning log file when the button is pushed.

Display Units Selects the display units for time measurements, between

seconds or Unit Intervals.

Default Image Type

Selects the default image format (JPEG, PNG or BMP) that
will be used by those functions that save images.

Notifier Duration

Determines how long the Warning notifier will remain on
the screen before disappearing. (The notifier may also be
dismissed manually).

Cancel Discards all changes and closes the Preferences window.
OK Accepts all changes and closes Preferences window.
Related Topics

B Preferences-Measurement

B Preferences-Path Defaults

Click Analyze > Jitter and Eye Analysis > Preferences > Measurement to view the following:

Preferences Setup

I- Limit Rise/Fall measurements to transition bits onhy

General

{\Z] Enable high-performance eye rendering

Path Defaults
Dual Dirac Model

PCIFB-DIMM | ¥ |
Waveform Interpolation Type n

The Measurement tab allows you to limit Rise and Fall measurements to transition bits only, or allow these
measurements for all bits. Here, the transition bits refer to edge transitions for which the preceding
transition was only one unit interval away. This may be important for signals with pre-emphasis, since
the transition following a string of two or more like bits has an intentionally low swing that you may

not want to measure.
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You can enable or disable high-performance eye rendering from this tab. This provides a trade-off between
greater fidelity or greater rendering speed. You can also select the Dual Dirac model and the waveform
interpolation type.

Table 22: Preferences-Measurement options

Item Description

Limit Rise/Fall measurements to transition bits only When selected, determines whether Rise Time and Fall
Time measurements are performed on all bit or only on
transition bits.

Enable high-performance eye rendering When enabled, determines whether eye diagrams are
optimized for speed or fidelity. When disabled, all unit
intervals (Ul) in the waveform(s) are included in the
rendered eye. This gives the highest fidelity eye rendering,
but can take considerable amount of time for long records.
When this option is checked, a statistically representative
subset of the Ul is rendered, so that eye diagrams for long
waveforms can be displayed in a shorter time. The rules
for high-performance rendering are as follows: 1) If the
waveform contains 15,000 or fewer Ul, all the Uls in the
waveform are rendered. 2) If the waveform includes more
than 15,000 Ul, it is subdivided into segments of 2000 Ul
each. The entire waveform is scanned to find the specific
Ul, that are the worst-case violators for six different points
around the eye. For each of these worst case violators,
the entire segment of 2000 Ul in which it lies is rendered.
Depending on whether multiple worst-case violators lie in
the same segment or not, as few as 2000 Ul but typically
from 8000 to 12,000 Ul will be rendered in the final eye.

Dual Dirac Model When selected, determines which parameter-extraction
method is used when RJ/DJ separation is done under
the Dual-Dirac model. This affects results for the RJ-08
and DJ-58 measurements only. When Fibre Channel is
selected, RJ and DJ parameters are extracted according
to guidelines given in ANSI/INCITS Technical Report
TR-35-2004 “Methodologies for Jitter and Signal Quality
Specification”. RJ and DJ values are selected that cause an
exact match between the bathtub curves from the dual-dirac
and the full analytical models at two prescribed BER levels.
When PCI/FB-DIMM is selected, RJ and DJ parameters
are determined using the methodology defined in the
PCl-Express Gen 2 and Fully-Buffered DIMM specifications.
In this technique, the bathtub curves are plotted on a
Q-scale that linearizes the tails of the bathtub, and the RJ
and DJ values are derived from where the asymptotes to
the curves intersect the BER=0 line.
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Table 22: Preferences-Measurement options (cont.)

Item Description

Waveform Interpolation Type Select the type of interpolation that is used between sample
points, to determine the exact time when a waveform
crosses a reference voltage level. Linear interpolation is
faster but introduces distortion that raises the jitter noise
floor slightly. Sin(x)/x Interpolation, also known as Sinc
Interpolation, approaches theoretically perfect waveform
reconstruction but is computationally expensive.

Cancel Discards the changes and closes the window.
OK Accepts the changes and closes the window.
Related Topics

B Preferences-General

B Preferences-Path Defaults
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Preferences-Path Defaults

Click Analyze > Jitter and Eye Analysis > Preferences > Path Defaults to view the following:

Dedault image export drectony

|EAT ekappheslions\DPOUE T Umages
Dedault logging export directory
|EAT ekfippication:\DPOLUE T\ Logs

Default report output directany

||::'~.Tek-!|.ppkalims'lDPClJET'-lels

The Path Defaults allows you to set the path for images, reports and log files. Click Browse to modify the
default directory path.

Table 23: Preferences-Path Defaults options

Item Description

Default image export directory Selects the directory to which images will be saved, unless
overridden at the time of the export.

Default logging export directory Selects the directory to which logs will be saved, unless
overridden at the time of the export.

Default report export directory Selects the directory to which reports will be saved, unless
overridden at the time of the export.

Cancel Discards the changes and closes the window.

OK Accepts the changes and closes the window.

Related Topics

® Preferences-General

® Preferences-Measurement
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Limits

56

Limits file allows you to determine Pass or Fail status for tests. Each serial data application provides limits
file that includes combinations of all measurements and statistical characteristics, and an appropriate
range of values for each combination.

The application does not provide any limits file. You can create one by specifying limits for any of

the result parameters such as Mean, Std Dev, Max, Min, peak-to-peak, population, MaxPosDelta and
MinPosDelta. For each of these result parameters, you can specify Upper Limit (UL), Lower Limit (LL),
or Both. The measurement names in the limits file must be entered as mentioned in

Setting Up the Application for Analysis.

NOTE. The limits file supports only absolute values.

To include Pass/Fail status in the result statistics, you can create a limits file using an XML editor or any
other editor in the following format. If the file is created in any other editor such as notepad, it should
be saved in Unicode format.

<?xml version="1.0" encoding="utf-16" 7>
<Main>

<Measurement>
<NAME>Period</NAME>

<STATS>
<STATS_NAME>Mean</STATS_NAME>
<LIMIT>UL</LIMIT>

<UL>1</UL>

<LL>0</LL>

</STATS>

<STATS>
<STATS_NAME>StdDev</STATS_NAME>
<LIMIT>LL</LIMIT>

<UL>1121</UL>

<LL>0121</LL>

</STATS>

<STATS>

<STATS_NAME>Max</STATS_NAME>
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<LIMIT>BOTH</LIMIT>

<UL>1</UL>

<LL>0</LL>

</STATS>

<STATS>
<STATS_NAME>Min</STATS_NAME>
<LIMIT>UL</LIMIT>

<UL>0</UL>

<LL>1</LL>

</STATS>

<STATS>
<STATS_NAME>PeakToPeak</STATS_NAME>
<LIMIT>UL</LIMIT>

<UL>1</UL>

<LL>1</LL>

</STATS>

<STATS>
<STATS_NAME>MaxPosDelta</STATS_NAME>
<LIMIT>UL</LIMIT>

<UL>1121</UL>

<LL>1121</LL>

</STATS>

<STATS>
<STATS_NAME>M1inNegDelta</STATS_NAME>
<LIMIT>UL</LIMIT>

<UL>0</UL>

<LL>0</LL>

</STATS>

<STATS>
<STATS_NAME>Population</STATS_NAME>

<LIMIT>UL</LIMIT>
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<UL>0</UL>
<LL>0</LL>
</STATS>
</Measurement>

</Main>

X
_F"ass.fFaiI Limits &

C:ATekApphcations DPOJE T Limitz' .

Table 24: Limits options

Item Description

Pass/Fail Test

Off/On Enables (On) or Disables (Off) the display of limit information
in results. Select On to choose a limits file for the selected
measurement.

Select Limits File
Browse To select an existing limits file or locate the directory.
Close Accepts the changes and closes the window.

About Taking a New Measurement

If you want to change the trigger settings or localize the measurements, you should do so before you
take any measurements.
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Selecting a Measurement

NOTE. When you run any measurement, Sampling mode in the oscilloscope should be set to “Real Time”. You need

to do this setting in the oscilloscope to take DPOJET measurements.

Selecting a Measurement

To take a measurement, click Analyze > Jitter And Eye Analysis > Select.

Jitter and Eye Diagram Analysis Tools

The application provides you different methods to set up the application:

B Wizard

B Measurement Setup sequence

The measurement categories are Period/Freq, Jitter, Time, Eye, and Amplitude as shown in the following

table:

Table 25: Measurement selections

Category Measurements

Period/Freq Period Pos Width Neg Width Freq
N-Period +Duty Cycle —Duty Cycle
CC-Period +CC-Duty —-CC-Duty

Jitter TIE RJ RJ-00 Jitter Summary
TI@BER DJ DJ-060 Phase Noise
PJ DDJ DCD

Time Rise Time Fall Time Skew *
High Time Low Time
Setup” Hold "

Eye Width Width@BER
Height
Mask Hits

DPOJET litter and Eye Diagram Analysis Tools

59



Operating Basics Selecting a Measurement

60

Table 25: Measurement selections (cont.)

Category Measurements

Ampl High Common Mode
Low T/nT-Ratio
High-Low V-Diff —Xovr *

*

Two Source Measurements

Wizard

The Serial Data/ Jitter Guide allows you to set up, configure, and run the selected set of measurements
without requiring any knowledge of the control menus. However, it does not provide access to
many of the advanced features.

Measurement Setup Sequence

The Measurement Setup Sequence buttons in the left navigation panel shows the logical order you
would follow to set up the application if you do not use the Wizard.
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Warning Log Notifiers

Warning Log Notifiers display error messages or warnings. Warnings ( _I.‘l ) or Error ( e) messages are
also shown in the results tab. You can click View Log to view the error log information in a text editor.
Click OK to discard the displayed error message.

1054: R

® Errar in 3 ] evels far Chi

You can set the duration for which the warning notification should appear on the screen in the Preferences
dialog box or click OK to discard the warning information.

053: Ref Le ozel: o
o Signal amplitu el lawve for  kdathl

NOTE. The error or warning log is saved as DPOJETErrors.log in C: \ TekApp 77 cations\DPOJET subfolder.
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Navigation Panel

The Navigation Panel appears on the left of the application window. It consists of the following tabs:
Select, Configure, Results, Plots and Reports.

Table 26: Navigation panel functions

Tab Description

Select Displays the various measurements available for selection.
By default, this tab is highlighted. You can click any
measurement categorized with Period/Freq, Jitter, Time,
Eye and Amplitude tabs.

Configure Displays the configuration for the selected measurement.
Results Displays the result for the selected measurement.
Plots Displays the result as a two-dimensional plot for additional

measurement analysis. You can select and configure plots
for selected measurements.

Reports Displays the configuration for generating reports in .mht
format. Allows you to select results, plots and details.

Control Panel

The Control Panel appears on the right of the application window. Using this panel, you can start or stop the
sequence of processes for the application and the oscilloscope to acquire information from the waveform.
The controls are Clear, Recalc, Single and Run. The following table describes each of these controls:
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Table 27: Control panel selections

Control Panel

Item Description

Clear Clears the current result display and resets any statistical
results and autoset ref levels.

Recalc Runs the selected measurements on the current acquisition.

Single Initiates a new acquisition and runs the selected
measurements.

Run Initiates a new acquisition and runs the selected
measurements repeatedly until Stop is clicked. Used only
for live sources.

Show Plots Displays the plot summary window when clicked. This

button appears in the control panel only when a plot is
selected.

The control panel with Show Plots is as shown:

DPOJET Jitter and Eye Diagram Analysis Tools
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Sources Setup

64

The application takes measurements from waveforms specified as input sources. You can select an
oscilloscope channel input (live), a reference or a math waveform as the source. You can configure
sources using any of the following options:

L&y . .
B Click icon in the table which lists the selected measurements.
B Double-click anywhere on row in the table which lists the selected measurements.

The source selections depend on the selected measurement. For differential input sources, you need
to use only math waveforms.

NOTE. Setup, Hold, V-DIff=Xovr, Common Mode and Skew are two source measurements. The Source2 option is
displayed only for two source measurements.

When more than one single source measurement is selected, Apply to all single source measurements
option is enabled in the source configuration screen.

Source Configuration

porogt 1|

References

When more than one two source measurement is selected, Apply to all two source measurements
option is enabled in the source configuration screen.
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Source Configuration

I

(™ Tl G @

Related Topics
® Source Autoset

m Ref Levels

Source Autoset

The Source Autoset allows you to automatically adjust the oscilloscope’s vertical and/or horizontal settings
for live sources (Ch1-Ch4) to improve measurement accuracy.

The Vertical Scale option automatically checks the peak-to-peak level of live sources. The vertical scale

and offset of all signals with a peak-to-peak value less than six divisions are adjusted so the peak-to-peak
will be eight divisions. If the maximum or minimum value of a signal is “clipped”, the vertical scale and
offset are adjusted so that the peak-to-peak value will be eight divisions.

The Horizontal Resolution option automatically checks the number of samples/edge on the rising and
falling transitions (Rise Time/Resolution and Fall Time/Resolution) of all live channels. The oscilloscope
horizontal resolution is set to the largest value that does not cause the samples/edge of the fastest edge to
fall below the specified target. The target is five samples per edge. The Horizontal Resolution sets the
acquisition sampling mode to Real Time for signals with very high edge speeds. The default record
length is 500 k points.

To automatically define both the vertical and horizontal settings for all channel sources, select the Vert
and Horiz button. The Vert and Horiz option also applies an oscilloscope autoset on each channel before
performing the vertical scale and horizontal resolution autoset.

Follow these steps to automatically define the vertical or horizontal settings for active sources:

1. Ensure that any channel waveform that you want to autoset is visible on the oscilloscope.

DPOJET litter and Eye Diagram Analysis Tools 65



Operating Basics Source Autoset

2. For Vert & Horiz and Horizontal resolution, the edge resolution is configured for five samples per edge
or more for better edge timing and measurement accuracy.

3. Select one of the following options:

= Vert & Horiz to autoset both vertical and horizontal setting.

Vert Scale button to autoset oscilloscope vertical settings only.

Horiz Res to autoset oscilloscope horizontal settings only.

Undo to return the oscilloscope to its state before autoset.

_Sourc:e Configuration

porogt 1]

Table 28: Autoset configuration options

Item Description

Vertical Scale If a channel waveform does not exceed six vertical divisions,
decreases the scale so that the waveform occupies about
eight divisions.

Horiz Res Sets the horizontal resolution so that the number of samples
on the fastest transition (edge) exceeds a specified target.

Vert & Horiz Performs a sequence: Oscilloscope Autoset, Vertical scale
and Horizontal resolution.
Undo Returns to the settings present before an Autoset was

performed; disabled after measurements are taken until you
perform another source autoset.

Ref Level - Click Ref Levels Setup in the Source Configuration screen
ef Levels Setup to hide/unhide the Ref Levels Setup.
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Ref Levels

Timing measurements are based on state transition times. By definition, edges occur when a waveform
crosses specified reference voltage levels. Reference voltage levels must be set so that the application
can identify state transitions on a waveform. By default, the application automatically chooses reference
voltage levels when necessary.

Source Configuration

BT

The DPOJET application uses three basic reference levels: High, Mid and Low. In addition, a hysteresis
value defines a voltage band that prevents a noisy waveform from producing spurious edges. The reference
levels and hysteresis are independently set for each source waveform, and are specified separately for rising
versus falling transitions. There are two ways to set the reference voltage levels: automatic and manual.

High, Mid, and Low Reference Voltage Levels
The application uses three reference voltage levels: High, Mid, and Low.

®  For most measurements, the application only uses the Mid reference voltage level. The Mid reference
level defines when the waveform state transition occurs at a given threshold.

B For Rise Time and Fall Time measurements, the High and Low reference voltage levels define when
the waveform is fully high or fully low.
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Rising Versus Falling Thresholds

You can specify thresholds for each of the reference voltage levels: High, Mid, and Low. The application
uses the thresholds to determine the following events:

B A Low/Mid/High rising event, which occurs when the waveform passes through the corresponding
Rise threshold in the positive direction.

B A Low/Mid/High falling event, which occurs when the waveform passes through the corresponding
Fall threshold in the negative direction.

For a given logical reference level (such as Low, Mid, or High), rising and falling events alternate as
time progresses.

NOTE. In many cases, the rising and falling thresholds for a given reference voltage level are set to the same value.
In those cases, a hysteresis value helps prevent spurious edges produced by small amounts of noise in a waveform.

Using the Hysteresis Option

The hysteresis option can prevent small amounts of noise in a waveform from producing multiple threshold
crossings. You can use a hysteresis when the rising and falling thresholds for a given reference voltage
level are set to the same value.

The reference voltage level = the hysteresis value defines a voltage range that must be fully crossed by
the waveform for an edge event to occur. If the decision threshold is crossed more than once before the
waveform exits the hysteresis band, the mean value of the first and last crossing are used as the edge
event time.

For example, if the waveform rises through the Threshold — Hysteresis, then rises through the Threshold,
then falls through the Threshold, then rises through both the Threshold and the Threshold + Hysteresis, a
single edge event occurs at the mean value of the two rising crossings.
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Example of Hysteresis on a Noisy Waveform

Threshold + Hysteresis - - —————3'—— — — -

Threshold — — — — - — —
Threshold - Hysteresis — — — —# - — — — — — -

— -~ Hysteresis

Ref Levels

Edge evert time

High —————
Mid ——— —} Hysteresis
Loy —————p Hysteresis

Automatic Versus Manual Reference Voltage Levels

Each measurement source may be configured to automatically choose voltage reference levels (default), or
to lock the reference voltages to levels of your choosing.

In the Ref Levels Setup panel, a table at the left edge contains all of the currently active measurement
sources. An Autoset check box appears beside each source. To enable or disable Autoset for a given
source, choose the source in the left column and select the corresponding check box to toggle its state.

For more details, refer to Understanding When Ref Level Autoset will Occur and Understanding How

Ref Level Autoset Chooses Voltages.

Table 29: Configure sources ref levels autoset configuration

Item Description

Autoset” Calculates and displays the reference voltage levels for all
sources where the autoset option is set according to the
Autoset Ref Level Setup.

Setup Specifies the Base-Top method and relative percent to be
used for all reference voltage levels when autoset occurs.

Status Specifies Armed/Disarmed status indicating whether

the ref level voltages will be recalculated/retained for a
measurement.

*

to take measurements.

DPOIJET Jitter and Eye Diagram Analysis Tools
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Understanding When Ref Level Autoset will Occur

When Autoset is enabled for a given source, the individual reference levels are displayed but you may
not manually adjust them. Instead, the reference levels are automatically recalculated whenever one of
the following events occur:

B A measurement sequence is initiated for the first time after a source has become active.
B A measurement sequence is initiated for the first time after all results have been cleared.
B The Autoset button at the right edge of the panel is pressed.

The Autoset button is provided as a convenience, but it is never required. Autoset will always be run (if
enabled) before an uninitialized source is used for a measurement.

An Armed indicator appears in the upper right corner of the panel whenever a new source has been added
or deleted or measurement results have been cleared. This lets you know that the reference levels will be
recalculated the next time either the Single or the Run button is selected.

If DisArmed indicator appears, the displayed reference levels will be retained if a measurement sequence
is performed with no further configuration changes. Of course, you can cause the reference levels to be
recalculated at any time by selecting the Autoset button.

Understanding How Ref Level Autoset Chooses Voltages

Once triggered, the Reference Level Autoset function uses the following logic to determine actual voltage
levels.

For each applicable source, the Top (high logic level) and Base (low logic level) are first determined. Then,
the High, Mid and Low levels are calculated as percentages of the Top-Base difference. For example,

if the Top and Base are 2.8 volts and 0.4 volts respectively and the High percentage level is 90%, this
threshold would be calculated as:

HighThres= Base+ High Percent (Top-Base)= 0.4+0.9 (2.8-0.4)= 2.56

Click Setup to select a method used to calculate the Top and Base of the waveform and also the
percentages used for the High, Mid and Low thresholds for each source. The Autoset Ref Levels appears.

Manually Adjusting the Reference Voltage Levels

Whether or not you use the application to automatically calculate the initial reference voltage levels, you
may need to manually change the values. To set the reference levels manually, follow these steps:

1. Click ki icon in the table which lists the selected measurements to view the source configuration
screen.

2. Select the desired source from the Source list.

NOTE. You cannot select inactive sources.

3. Clear the Autoset option for the sources you wish to set manually.
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4. Select the reference levels or hysteresis options and manually adjust the values. The values will not
change when you select Autoset or take measurements.

NOTE. A source will become inactive if all measurements on that source are removed. If a new measurement is then
added on that source, the source once again becomes active, and defaults to Autoset. If you clear all measurement
on a source that was set to Manual, you must reselect the Manual state (if desired) when the source is again added.

Table 30: Configure sources ref levels configuration

Item Description

Autoset* Calculates and displays the reference voltage levels for all
sources where the autoset option is set according to the
Autoset Ref Level Setup.

Setup Specifies the Base-Top method and relative percent to be
used for all reference voltage levels when autoset occurs.

Ref Levels Setup (one level per source) t

Rise High Sets the high threshold level for the rising edge of the
source.

Rise Mid Sets the middle threshold level for the rising edge of the
source.

Rise Low Sets the low threshold level for the rising edge of the source.

Fall High Sets the high threshold level for the falling edge of the
source.

Fall Mid Sets the middle threshold level for the falling edge of the
source.

Fall Low Sets the low threshold level for the falling edge of the
source.

Hysteresis Sets the threshold margin to the reference level which

the voltage must cross to be recognized as changing; the
margin is the relative reference level plus or minus half the
hysteresis; use to filter out spurious events.

Close Accepts the changes and closes the window.

Status Specifies Armed/Disarmed status indicating whether
the ref level voltages will be recalculated/retained for a
measurement.

* If you do not update ref levels by clicking Autoset, the application updates the reference levels (if required) when you select the Single or Run
to take measurements.

T Default setting are 90% (High), 50% (Mid), 10% (Low), and 3% (Hysteresis).

Autoset Ref Levels

Click Setup in the Ref Level Setup screen to select a method used for calculating Top and Base of the
waveform and also the percentages used for the High, Mid and Low thresholds for each source. The
Autoset Ref Levels screen appears.
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Table 31: Autoset ref level configuration

Item Description
Base Top Method
Min-Max Uses the minimum and maximum values in the waveform

to determine the base and top amplitude. Useful on a
waveform with low noise and free from excessive overshoot.

Low-High Histogram (Full Waveform) Uses a histogram approach to determine the base top
amplitude. Creates a histogram of the amplitudes of the
entire waveform; the histogram should have a peak at the
nominal high level, and another peak at the nominal low
level.

Low-High Histogram (Center of Eye) Uses a histogram approach to determine the base top
amplitude. Creates a histogram of the amplitudes in the
center of each bit (unit interval) while ignoring the waveform
during bit transitions. The histogram should have a peak
at the nominal high level and another peak at the nominal

low level.

Auto Automatically determines the best Base Top method to use.

Set Ref Level % Relative to Base Top *

Rise High Sets the high threshold level for the rising edge of the
source.

Rise Mid Sets the middle threshold level for the rising edge of the
source.

Rise Low Sets the low threshold level for the rising edge of the source.

Fall High Sets the high threshold level for the falling edge of the
source.
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Table 31: Autoset ref level configuration (cont.)

Item Description

Fall Mid Sets the middle threshold level for the falling edge of the
source.

Fall Low Sets the low threshold level for the falling edge of the
source.

Hysteresis Sets the threshold margin to the reference level which

the voltage must cross to be recognized as changing; the
margin is the relative reference level plus or minus half the
hysteresis; use to filter out spurious events.

OK Accepts the changes and closes the window.

*  Default setting are 90%(High), 50% (Mid), 10% (Low), and 3% (Hysteresis).

About Configuring a Measurement

You can configure various measurements listed under the following categories:
m Period/Freq

= Jitter

B Time

m Eye

= Amplitude

NOTE. Configure tabs are displayed only when you select a measurement.

The following tables lists the configure tabs displayed for each measurement.

Table 32: Period/Freq measurements

Mea- Clock
sure- Bit Recov-
Ul Name ments Edges Config ery RJDJ Filters General Global
Period Clock - e [ -
Period
Data I P -
Period
Freq Clock b b P b
Fre-
quency
Data - > e
Fre-
quency
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Table 32: Period/Freq measurements (cont.)

About Configuring a Measurement

Mea- Clock
sure- Bit Recov-
Ul Name ments Edges Config ery RJDJ Filters General Global
Pos Pos > o e
Width Width
Neg Neg - b -
Width Width
N-Pe- N-Pe- g - -
riod riod
+Duty +Duty L > - e
Cycle Cycle
-Duty -Duty b - b b
Cycle Cycle
CC-Pe- CC-Pe- s e b s
riod riod
+CC- +CC- - - -
Duty Duty
-CC- -CC- - e e
Duty Duty
Table 33: Jitter measurements
Mea- Clock
sure- Bit Recov:
Ul Name ments Config Edges ery RJDJ Filters General Global
TIE Clock b b 5 e L
TIE
Data TIE - > o o
TI@BER  Clock TJ b b b s b b
Data TJ o o > I e
DCD Clock b b b s b b
DCD
Data - - > I I
DCD
RJ Clock RJ b b - 5 e L
Data RJ - - > e I
DJ Clock DJ b b - 5 e -
Data DJ - - - - e
DDJ DDJ e I I > % >
RJ-56 Clock b b b s b b
RJ-36
Data - o > I e
RJ-306
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Table 33: Jitter measurements (cont.)

About Configuring a Measurement

Mea- Clock
sure- Bit Recov-
Ul Name ments Config Edges ery RJDJ Filters General Global
DJ-00 Clock - - - I b e
DJ-50
Data b b - 4 1
DJ-35
PJ Clock PJ > b 5 1 L >
Data PJ - b b - o
Jitter
Sum-
mary !
Phase e b - b
Noise

1 Jitter Summary is not an individual measurement but a convenience function. Pressing this button automatically adds a set of eleven
jitter-related measurements with a single action. The measurements are: TIE, RJ, RJ-33, DJ, DJ-63, PJ, DDJ, DCD, TJ@BER,

Width@BER , and Phase Noise.

Table 34: Timing measurements

Measure- Clock

ments Bit Config Edges Recovery RJDJ Filters General Global
Rise Time b P

Fall Time - - - b
Skew > | | 2
High Time - - [
Low Time > > I
Setup - - % -
Hold 1 4 - 1~
Table 35: Eye measurements

Measure- Clock

ments Bit Config Edges Recovery RJDJ Filters General Global
Width - 5 e
Width@BER - - - - - e
Height b b - b
Mask Hits - - b [
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Table 36: Amplitude measurements

Measure- Clock
ments Bit Config Edges Recovery RJDJ

Filters General

About Global

Global

High v v

- 1

F

Common
Mode

A

1“

1“

Low %

T/nT Ratio

AR

High-Low -

5

V-Diff-Xovr -~

MR TRIR
MATATA

MATATR

Related Topics

Bit Config
Edges

Clock Recovery
RIDJ

Filters

General

Global

About Global
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This configuration tab is common for all measurements. You can limit the waveform data analysis by
Gating, Qualifying and Populating the waveform data.

Jitter and Eye Diagram Analysis Tools

y | Measurement Source{s) "
Period1 T Math1 | Edges
|

Population

o-»
()
Contge
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Gating
Gating allows you to focus the analysis on a specific area of the waveform bounded by a gated region,
which is a way to filter unnecessary information.
You can set up a gated region in one of the following ways:
B Zoom

®  Cursors

Jitter and Eye Diagram Analysis Tools

Population

o»
)
contae

Table 37: Global-Gating options

Item Description

Off No gating occurs; application takes measurements over
the entire waveform.

Zoom Zooms the specified region of the source waveform to take
measurements within the selected area. The region of
waveform within the zoom is analyzed.

Cursors Gates the waveform with Vertical cursors. The region of
waveform within the cursors is analyzed.
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Qualify
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Qualify

Qualifiers allows you to limit the application to more narrowly defined conditions before taking
measurements. All sources for the measurements and Qualify input must have the same Horizontal Sample
Rate, Record Length, and Position to ensure that measurements function properly. For measurements
which require clock recovery such as TIE or eye measurements, only the first qualified region will be
measured even if multiple qualified regions are present. For all other measurements, the entire waveform

is processed.

Jitter and Eye Diagram Analysis Tools

) ii Measurement iSource(s) H'

| Filters

| General

Table 38: Global-Qualify options

Qualify Population

& @&
@
e Conire

Item Description

Off Disables the application from using the defined conditions
while taking measurements.

On Enables the application to use the defined conditions while
taking measurements.

Configure Displays the Qualify with Logic dialog box.

DPOJET litter and Eye Diagram Analysis Tools



Operating Basics

Configuring Qualify with Logic

Table 39: Qualify-Configure options

)

——

Configuring Qualify with Logic

Item Description

Source* Selects a waveform to qualify the signal or clock source
used for the measurement. The input source waveforms or
files are Ch, Ref, and Math.

Mid Shows the vertical reference level of the qualifier waveform.

Hysteresis Shows the vertical reference margin of the qualifier
waveform. Hysteresis prevents small amounts of noise in a
waveform from producing multiple threshold crossings. You
can use a hysteresis when the rising and falling thresholds
are set to the same value for a given reference voltage level.

Active

Hight Enables measurements in regions t where the qualifier
waveform exceeds the mid reference level.

Low T Enables measurements in regions t where the qualifier
waveform falls below the mid reference level.

OK Accepts the changes and closes the window.

*

function properly.

Measurement and Qualify sources must have the same Horizontal Sample Rate, Record Length, and Position to ensure that measurements

f For TIE measurements, only the first qualified region will be measured even if multiple qualified regions are present.
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Population

The Population control allows you to limit the amount of waveform data that is analyzed. This is often
done in industry standards to make sure that there is consistency between measurement techniques.

Jitter and Eye Diagram Analysis Tools

y | Measurement | Source(s) | -
Edges
1 Population

&
W,
Confwe

Table 40: Global-Population options

Item Description

Off Disables the application from using a Population limit while
taking measurements.

On Enables the application to use a Population limit while
taking measurements.

Configure Displays the Population Limit dialog box wherein you can
set a limit on @ maximum population to obtain, for selected
measurements.
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Configuring Population Limit

Pﬂ_:_u!_lﬂm Limit

Table 41: Population-Configure options

Item Description
Limit By
Population The limit determines the population of measurement

observations that will be accumulated. Some measurements
may accumulate observations more quickly than others.

Acquisitions The limit determines the number of acquisition cycles that
will be performed.

Stop Conditions

Each Measurement Each measurement stops accumulating as soon as it
reaches the specified limit. Sequencing does not stop until
all measurements have reached the limit, at which time
every measurement will have exactly the limit.

Last Measurement Sequencing continues and all measurements continue
accumulating until the last (slowest accumulating)
measurement reaches the limit, at which time they all stop.
When sequencing stops, all measurements except one may
have higher population than the limit.

Limit Specifies the number of acquisitions or measurements the
application takes before sequencing stops.

OK Accepts the changes and closes the window.
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General

This configuration tab allows you to customize the measurement name and qualify the measurement within
a selected result range. The General tab looks the same for all the measurements but is not common. The
values are different for different measurements. You can set the custom name per measurement here.

Jitter and Eye Diagram Analysis Tools

Maeasuramaent Range Limits

Maz Walug: o Valus
[ 1ms |

Table 42: General options

Item Description

Off Disables the application from using the specified
measurement limits.

On Enables the application to use the specified measurement
limits.

Max or Min value Specify the maximum and minimum range of valid

measurement values measurements. The default values
for the Measurement Range Limits options vary by
measurement.

Custom Measurement Name Option to modify the measurement name. Allows adding a
user-specified name to any measurement. This is useful for
aligning DPOJET measurements with a user measurement
list or standard.

NOTE. If a max value smaller than the min value is entered, it is accepted and the min value is also silently reduced
to the same value. Likewise, if a min value larger than the max is entered, both are set to that value.

Filters

This configuration tab allows you to modify the measurement data by applying a High Pass filter to block
out low frequency band components or a Low Pass filter to block out high frequency band components.
For Example: Selecting a 1 MHz high pass filter can reduce the effect of SSC on results.
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For some measurements (Period, Frequency, TIE, +Duty Cycle, —Duty Cycle, +CC Duty , — CC Duty ,
CC—Period, Positive Width, Negative Width, N-Period, Rise Time, Fall Time, Low Time, High Time,
Common ModeV, High—Low, High, Low and T/nT Ratio), the measurements versus time waveform
(time trend) that is derived from the original oscilloscope waveform can be filtered before it is passed to
the statistics and plotting subsystems.

F1 cutoff freq- 3 de
|
: L High Pass
Magnitude |
Frequency
3 dE-{ __________ I--l—___—FE cutoff freq.
|
Low Pass —a I
Magnitude |
3dB{
1 Order
ES:Drder
Magnitude 3" Order

Frequency

Band Pass Filtering

You can create a band pass filter by enabling both the High Pass and the Low Pass filters on a measurement.
The cut-off frequency for the Low Pass filter must be greater than or equal to the cut-off frequency for the
High Pass filter.

You should be aware that setting the cut-off frequencies close to each other may effectively filter out all
of the measurement data, or all but a small amount of timing noise. This diagram shows the spectrum
of the measurement data passed to the statistics and plotting subsystems when you use both the High
Pass and the Low Pass filters.

Band Pass

3de ____%_l_%____
F1 High Pass | | F2 Low Pass

cutoff freq. ™| _/" ! T_ cukoff freq.

Magnitude
Frequency

High Pass filters attenuate low frequencies, and filter out DC values entirely. When a high pass filter is
added to a period or frequency measurement, the mean value of the filtered measurement goes to zero.

DPOIJET Jitter and Eye Diagram Analysis Tools 83



Operating Basics

Advanced Filter Configuration
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Advanced Filter Configuration

This can be seen by creating a Time Trend plot of a high-pass-filtered period or frequency measurement.
Although this is the correct theoretical behavior for the filtered measurement, it is not very useful if the
Results panel reports that the mean period or frequency is zero. For this reason, the mean values that
appear in the results panels for Period and Frequency measurements are the values before the filter.

Jitber and Eye Diagram Analysis Tools
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Table 43: Filter options

Freq

Low Pass (F2)

Filter Spac
Mo Filler L |

T (F.2)

Item Description

High Pass

Filter Spec When enabled, blocks the low frequency band and passes
only the high frequency band of the waveform; defined as
1st order, 2nd order, 31 order Butterworth and No filter, being
the default.

Freq (F1)" High Pass filter cut off frequency at which the filter
magnitude falls by 3 dB.

Low Pass

Filter Spec When enabled, blocks the high frequency band and passes
only the low frequency band of the waveform; defined as 1st
order, 2nd order, 31 order Butterworth, and No filter, being
the default.

Freq (F2)* Low Pass filter cut off frequency at which the filter magnitude
falls by 3 dB.

Advanced Displays the Advanced Filter Configuration dialog box.

*

Includes a 3 dB cut-off frequency.

The measurement filters are implemented using infinite impulse response (IIR) designs. As with any
causal filter, a transient may occur at the filter’s output in response to the arrival of the input signal. It is
usually desirable to exclude this transient from the measurement results.

In the DPOJET application, the filter transient is managed in two ways. First, the input to the filter is
gently “ramped up” from zero to its full value over some ramp time t,. Second, the output of the ramp
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Advanced Filter Configuration

is “blanked” over some duration t,, so that the remaining effects of any transient are omitted from
measurement results, statistics and plots. The sequence of operations is depicted here:

Unfiltered
Measurement

—p

Ramp

fty)

—

Filter

_’

Blanking
{th}

Filtered
Measurement

The ramp function has a raised-cosine profile and is defined in the time domain as:
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Raised Cosine Ramp Function

You may adjust the ramp time t, by means of the Advanced control panel. If you wish to turn off the
ramp function, set the ramp time to 0.

Similarly, you may adjust the blanking duration t, by means of the Advanced control panel. Setting the
blanking duration to 0 will allow you to see the entire filtered measurement, including any transients.

Both, the ramp time t, and the blanking duration t,, are set relative to the reciprocal of the lowest filter
frequency F.. By default, both of these parameters are set to 1/F.. Since they are normalized to the filter
frequency, they will automatically adjust if you change the filter cut-off frequency.

The complete set of signal processing options, together with representative waveforms that suggest how
the options affect the measurement vector, are shown here:
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Table 44: Advanced filter configuration options

Item Description

Ramp Time Duration of the raised-cosine smoothing function applied to
the measurement vector before the vector is filtered.

Blanking Time Duration of the filter's output that is suppressed. The

blanked portion of the output is not included in the
measurement statistics, or in any plots.

OK Accepts changes and closes.

About Clock Recovery

Clock recovery refers to the process of establishing a reference clock, the edges of which can be used
as a basis for timing comparisons. The Clock Recovery configuration tab allows you to select one of
the following clock recovery methods:

m Constant Clock - Mean

®  Constant Clock - Median

B Constant Clock - Fixed

m Phase Locked Loop Standard BandWidth
® Phase Locked Loop Custom BandWidth
m  Explicit Clock - Edge

m  Explicit Clock - PLL

The first four methods derive the reference clock from the same channel upon which the measurement
is defined. This is the conventional method of clock recovery for serial data communications, where no
separate clock is available. The last two methods (Explicit Clock) derive the reference clock from a
channel other than the one upon which the measurement is defined.

About Constant Clock Recovery

In Constant Clock Recovery, the clock is assumed to be of the form A*sin (211 ft +®), where the frequency
(f) and phase (®) are treated as unknown constants. Once a source waveform has been acquired and the
edges extracted, one or both of these constants are determined using linear regression, so that the recovered
clock minimizes the mean squared sum of the Time Interval Error (TIE) for that waveform.

If Constant Clock - Mean is selected as the clock recovery method, both the frequency and the phase
are chosen to minimize the mean squared error.

If Constant Clock - Fixed is selected as the clock recovery method, the precise frequency specified is
used but the phase is chosen so that the median error between the recovered and measured edges is zero.
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If Constant Clock - Median is selected as the clock recovery method, the phase is chosen so that the
median error between the recovered and measured edges is zero.
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Constant Clock - Mean

This method provides the following options that control how the clock recovery is performed:
®  Auto Calc First Acq
m  Auto Calc Every Acq

Selecting Autocalc First Acq will allow the clock-recovery algorithm to choose a new best-fit clock
frequency and phase only on the first acquisition. Subsequent acquisitions will choose a best fit on clock
phase but retain the clock frequency found on the first acquisition.

Selecting Autocalc Every Acq will allow the clock-recovery algorithm to choose a new best-fit clock
frequency and phase for each new oscilloscope acquisition.

Clearing the measurement results by choosing Clear on the sequencing panel will reset the clock recovery
so that both frequency and phase are optimized on the subsequent acquisition.
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Table 45: Constant Clock - Mean options

Item Description

Auto Calc First Acq Calculates the best fit of the initial acquisition or the first
acquisition after clearing results, and then uses the value
until you clear the results.

Auto Calc Every Acq Calculates the best fit for each acquisition (default).
Apply to All
Apply Applies the current clock recovery configuration to all

selected measurement(s) PLL-Standard clock recovery
options that have Clock Recovery as configuration tab.

Advanced Displays the Clock Recovery Advanced Setup dialog box.
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Constant Clock - Median

This method provides the following options that control how the clock recovery is performed:
B Auto Calc First Acq
m  Auto Calc Every Acq

Selecting Autocalc First Acq will allow the clock-recovery algorithm to choose a new best-fit clock
frequency and phase only on the first acquisition. Subsequent acquisitions will choose a best fit on clock
phase but retain the clock frequency found on the first acquisition.

Selecting Autocalc Every Acq will allow the clock-recovery algorithm to choose a new best-fit clock
frequency and phase for each new oscilloscope acquisition.

Clearing the measurement results by choosing Clear on the sequencing panel will reset the clock recovery
so that both frequency and phase are optimized on the subsequent acquisition.
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Table 46: Constant Clock - Median options

Item Description

Auto Calc First Acq Calculates the best fit of the initial acquisition or the first
acquisition after clearing results, and then uses the value
until you clear the results.

Auto Calc Every Acq Calculates the best fit for each acquisition (default).
Apply to All
Apply Applies the current clock recovery configuration to all

selected measurement(s) that have Clock Recovery as
configuration tab.

Advanced Displays the Clock Recovery Advanced Setup dialog box.
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Constant Clock - Fixed

This method provides a single option that controls how the clock recovery is performed: the Clock
Frequency. With Fixed Constant Clock recovery, no attempt is made to derive information about the
actual data rate from the signal under test. Instead, the precise frequency that you specify will be used.
(However, the clock phase will be chosen so that the median difference between the recovered and
measured edges is zero.)
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NOTE. Click Apply to All to apply the clock recovery configuration to all selected measurement(s) that have Clock
Recovery as configuration tab.

Clock Recovery Advanced Setup

The Advanced Clock Recovery methods are used when unusually high noise defeats normal clock recovery
methods. Under most normal operating conditions, these methods are not required nor recommended.
Nominal Data Rate and Known Data Pattern are the two advanced clock recovery methods.

In Nominal Data Rate, you can provide the nominal data rate to the clock recovery algorithm. Normally,
the application analyzes your data and determines the nominal data rate automatically. Using Nominal
provides a starting point or hint to the clock recovery algorithm from which it analyzes data.

In Known Data Pattern, the pattern is specified by using an ASCII text file containing the characters 1

and 0. The file may contain other characters, spaces and tabs for formatting purposes, but they will be
ignored. Several files for commonly used patterns are included with the application, and you may use these
as examples if you wish to create your own pattern files. Click Browse to modify the default location

for pattern files.
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Clock Recovery Advanced Setup
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Table 47: Advanced clock recovery options

Item

Description

Nominal Data Rate

Off, On Enables (On) or disables (Off) the advanced clock recovery
through data rate guidance.
Bit Rate Defines the nominal data rate in bits per second (b/s). Use

the pop-up keypad to set the data rate.

Known Data Pattern

Off, On

Enables (On) or disables (Off) advanced clock recovery
through a known data pattern.

Pattern File Name

Browse

Selects a file to use for the data pattern.

OK

Accepts changes and closes.
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About PLL Clock Recovery Setup

When PLL-based clock recovery is selected, the application simulates the behavior of the hardware Phase
Locked Loop clock recovery circuit. This is a feedback loop in which the Voltage-Controlled Oscillator
(VCO) is used to track or follow slow variations in the bit rate of the input waveform. Such loops are
frequently used to recover the clock in communication links that do not transmit the clock as a separate
signal. The PLL parameters in the application may be adjusted to simulate with the behavior of a receiver
in such a link, within certain guidelines.

NOTE. The effective transfer function of a PLL loop is not equal to the PLL Loop BW setting. The Transfer function
depends on the factors such as damping, transition density and type.

DPLL
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PLL Standard BW

The PLL control area provides control over the phase-locked loop used for clock recovery. You can choose
the loop bandwidth and the loop order, and if a Type II loop is chosen, you can specify the damping factor.

To set the loop bandwidth automatically, based on a serial standard, select PLL: Standard BW as the clock
recovery method. From the Standard: b/s list box, select the standard that matches your data link. For
example, choose “PCI-E: 2.5 to test a 2.5 Gbit/second PCI-Express link. In this case, the PLL bandwidth
will be set to 1.5 MHz, which is 1/1667 of the baud rate as specified in PCI-Express standard.

You can use the PLL Model list box to choose between Type I and Type Il loop. A Type I loop has a
transfer function that approaches zero frequency with a slope of 1/s and a Type II loop approaches zero
frequency with a 1/s2 slope (In much of the PLL literature, these terms are used interchangeably with
First-Order and Second-Order loops. For a thorough discussion of loop type versus order, see Frequency
Synthesis by Phase Lock, by William Egan).
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NOTE. Although it is possible to configure a Type Il PLL with a bandwidth up to 1/10 of the baud rate, such a loop
will have poor dynamic performance. This is because Type Il loops have less phase margin than Type | loops. A
preferred alternative to using a Type Il PLL with a bandwidth close to its baud rate is to use a 2nd order high-pass
measurement filter to emulate the effects of the PLL.
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Table 48: PLL-Standard clock recovery options

Item Description

PLL Model Selects between a Type | or Type Il phase-locked loop.

Damping Use the keypad to specify the damping ratio of the PLL. Itis
enabled only for Type Il phase-locked loop.

Loop BW Displays the bandwidth that has been selected based on
the current standard.

Standard: b/s Implicitly sets the loop bandwidth of the clock recovery PLL,
based on selection of the industry standard and data rate in
bits/second.

Apply to All

Apply Applies the current clock recovery configuration to all

selected measurement(s) that have clock recovery as
configuration tab.

Advanced Displays the Clock Recovery Advanced Setup. For more
details, refer to the Clock Recovery Advanced Setup.

PLL Custom BW

94

The PLL control area provides control over the phase-locked loop used for clock recovery. You can choose
the loop bandwidth and the loop order, and if a Type II loop is chosen, you can specify the damping factor.

To manually control the loop bandwidth, select PLL: Custom BW as the clock recovery method and use
the User BW control to select the 3 dB bandwidth of the loop, in Hz.
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You can use the PLL Model list box to choose between a Type I and Type II loop. A Type I loop has a
transfer function that approaches zero frequency with a slope of 1/s and a Type II loop approaches zero
frequency with a 1/s2 slope. (In much of the PLL literature, these terms are used interchangeably with
First-Order and Second-Order loops. For a thorough discussion of loop type versus order, see Frequency
Synthesis by Phase Lock, by William Egan).

NOTE. Although it is possible to configure a Type Il PLL with a bandwidth up to 1/10 of the baud rate, such a loop
will have poor dynamic performance. This is because Type Il loops have less phase margin than Type | loops. A
preferred alternative to using a Type Il PLL with a high bandwidth is to use a 2nd order high-pass measurement filter to
emulate the effects of the PLL.
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Table 49: PLL-Custom clock recovery options

Item Description

PLL Model Selects between Type | or Type Il phase-locked loop.

Damping Use the keypad to specify the damping ratio of the PLL. It is
enabled only for Type Il phase-locked loop.

Loop BW Explicitly sets the loop bandwidth of the clock recovery PLL.

Apply to All

Apply Applies the current clock recovery configuration to all

selected measurement(s) that have Clock Recovery as
configuration tab.

Advanced Displays the Clock Recovery Advanced Setup. For more
details, refer to the Clock Recovery Advanced Setup.
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About Explicit Clock Recovery

96

In Explicit Clock Recovery, the reference clock is not derived from the measurement’s target source at all,
but is instead taken from a separately-identified source. Since the source used for the measurement now
differs from the source used to derive the reference clock, selecting this type of clock recovery converts
the measurement from a single-source measurement to a dual-source measurement. The reference clock
source is always shown on the right when the two sources appear in a measurement table. Changing the
clock-recovery method back to a non-explicit clock method will change the measurement back to a
single-source measurement.
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Explicit Clock-Edge

Select Explicit Clock-Edge method if you want to use the edges found in the selected clock source
(possibly multiplied up by an integral number). If the Clock Multiplier is set to 1 (the default), only these
edges will be used. If the Clock Multiplier is set to a number N other than 1, linear interpolation will be
used between each pair of actual edges to create N-1 additional reference edges. The interpolated edge
times, combined with the actual edges, give a total of N reference edge times per actual edge.
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Table 50: Explicit-Clock edge options

Item

Method
Explici Clock _ Edge_

Description

Clock Source

Select Ch1 to Ch4, Ref1 to Ref4, or Math1 to Math4 as
reference source for clock recovery.

Clock Edge

Specify whether the rising, falling or both edges of selected
source should be considered.

Clock Multiplier

Specify the number of edges to be used.

Apply to All

Apply Applies the current clock recovery configuration to all
selected measurement(s) that have Clock Recovery as
configuration tab.

Advanced Displays the Advanced Explicit Clock-Edge dialog wherein

you can adjust the timing relation between reference clock
source and data source.
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Advanced Explicit Clock-Edge

98

To compare the reference clock times to the edge times from the data source, some assumptions must be
made about how they align. The default assumption is that each data source edge is associated with the
reference clock edge to which it is nearest in time. This assumption may not be optimum, for example if
the probes for the reference clock and data signal have different cable lengths.

To change the way the reference clock edges and data edges are associated, you can control the Nominal
clock Offset Relative to Data. The (positive or negative) time delay you specify will be used to shift the
reference clock edges before the measurement software associates each data edge with the closest clock
edge.

Explicit Clock: Edge
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Explicit Clock-PLL

Select Explicit Clock-PLL as the clock recovery method if you want to feed the edges from the selected
clock source through a PLL rather than using them directly. The actual edges from the clock source will
be used to drive a software PLL model, and the edge times coming out of the PLL will be used as the

Explicit Clock-PLL

reference edges for the target measurement. If the Clock Multiplier is set to a number N other than 1, the

output of the PLL will have N edges per actual edge.
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Table 51: Explicit-Clock PLL options

Item

Description

Clock Source

Select Ch1 to Ch4, Ref1 to Ref4 or Math1 to Math4 as
reference source for clock recovery.

Clock Edge

Specify whether the rising, falling or both edges of selected
source should be considered.

Clock Multiplier

Specify the number of edges to be used.

Apply to All

Apply Applies the current clock recovery configuration to all
selected measurement(s) that have Clock Recovery as
configuration tab.

Advanced Displays the Advanced Explicit Clock-PLL dialog wherein

you can adjust the timing relation between reference clock
source and data source.
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Advanced Explicit Clock-PLL

In the Advanced Explicit Clock- PLL, you can specify the PLL type, bandwidth, damping factor and
nominal clock offset relative to data. Damping numeric input is enabled only for Type Il phase-locked loop.

Nominal Clock Offset Relative to Data

To compare the reference clock times to the edge times from the data source, some assumptions must be
made about how they align. The default assumption is that each data source edge is associated with the
reference clock edge to which it is nearest in time. This assumption may not be optimum, for example if
the probes for the reference clock and data signal have different cable lengths.

To change the way the reference clock edges and data edges are associated, you can control the Nominal
clock Offset Relative to Data. The (positive or negative) time delay you specify will be used to shift the
reference clock edges before the measurement software associates each data edge with the closest clock
edge.

LA
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Bit Config for Eye Height Measurements

This configuration tab allows you to select which waveform bit types (Transition bits, Non-Transition or
All bits) are included when measuring Eye Height.
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Table 52: Bit Config for eye height

Item Description

Bit Type

All Bits Eye analysis includes both transition and non-transition bits.
Transition Eye analysis only on transition bits.

Non-Transition Eye analysis only on non-transition bits.
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Bit Config for Mask Hits Measurements

This configuration tab allows you to select the waveform bit type (All bits, Transition, Non-Transition) and
the mask to be used for Mask Hits measurements.
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Table 53: Bit Config for mask hits

Item Description

Bit Type

All Bits Eye analysis includes both transition and non-transition bits.
Transition Eye analysis only on transition bits.

Non-Transition Eye analysis only on non-transition bits.

Mask

Browse Allows selection of the mask file. (If none of the supplied

mask files meets your need, you may create a custom mask
file with a text editor by using one of the existing mask
specification files as a template.)
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Bit Config for Amplitude Measurements

This configuration tab is present only for High, Low and High—Low measurements. You can select the
waveform bit type (All Bits, Transition, Non-Transition) and method.
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Table 54: Bit Config for amplitude measurements

Item Description

Bit Type

All Bits Eye analysis includes both transition and non-transition bits.
Transition Eye analysis only on transition bits.

Non-Transition Eye analysis only on non-transition bits.

Measure the Center X% of the Bit Determines what percentage (1 to 100) of a unit interval,

centered in the middle of the bit, shall be included in each
measurement. The waveform points selected by the
percentage form a distribution (vertical histogram) from
which a single value is extracted, based on the Method
control.

Method Determines whether the Mean value or the Median of the
selected distribution is used for the measurement value for
each unit interval.

About RJ/DJ

This configuration tab allows you to select an appropriate decomposition method for jitter analysis. RJ/DJ
decomposition analysis breaks the timing jitter into various categories and uses the results to predict the
total jitter at a selected bit error rate (BER). The RJ/DJ tab is present for the RJ, DJ, PJ , DCD, DDJ, RJ-39,
DJ-65,TI@BER and Width@BER measurements.

The DPOJET application offers two methods of RJ/DJ analysis:

B A method based on spectral analysis that is appropriate for cyclically repeating data patterns.
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® A method that works for arbitrary data sequences.

Related Topics
B RJDJ Analysis of Arbitrary Pattern
m RJDJ Analysis of Repeating Pattern

RJ/DJ Analysis of Repeating Pattern

This method of RJ/DJ analysis uses a Fourier transform of the time-interval error signal to identify and
separate jitter components. It is described in the Fibre Channel - Methodologies for Jitter and Signal
Quality Specification (MJSQ) and has wide industry acceptance.

This method requires that the data signal be composed of a pattern of N bits that are repeated over and
over. The pattern length (N) must be known, although it is not necessary to know the specific bits that
make up the pattern.

Jittar and Eye Diagram Analysis Tools
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Table 55: RJ/DJ analysis of repeating options

Item Description

Data Signal Settings

Pattern Type Selects between repeating or arbitrary pattern analysis.
Pattern Length When the Pattern Type is set to Repeating, sets the pattern

length of the repetitive pattern data; use for spectrum
analysis RJ/DJ separation.

Total Jitter Component

BER= 1E-? Sets the Bit Error Rate exponent, thereby setting the

I statistical level at which Total Jitter and Eye Opening are
reported.

Apply To All

Apply Applies the current settings to all the measurements having
RJDJ configuration tab.

¥ Only available for TJ@BER and Width@BER measurements.

RJ/DJ Analysis of Arbitrary Pattern

When the data pattern is not repeating, or is unknown, a second method of RJ/DJ analysis may be used. (It
may also be used if the pattern is repeating, and correlates well with the Spectral method in this case.) This
method assumes that the effects of Inter Symbol Interference (ISI) only last for a few bits. For example,
in a band-limited link where a string of ones follows a string of zeros, the signal may require three or
four bit periods to fully settle to the “high” state.

In this method, an analysis window with a width of K bits is slid along the waveform. For each position of
the window, the time interval error of the rightmost bit in the window is stored, along with the K-1 bit
pattern that preceded it. After the window has been slid across all positions, it is possible to calculate the
component of the jitter that is correlated with each observed K-1 bit pattern, by averaging together all the
observed errors associated with that specific pattern.

In the configuration menu for the arbitrary-pattern method, the Window Length field allows you to select
how many bits are included in the sliding window. The window should include enough bits to encompass
the impulse response of the system under test, usually 5 to 10 bits. A good practical test is to check
whether increasing the window length causes any appreciable change in the jitter results; if not, the
window length is effectively capturing all the ISI effects. The disadvantage of increasing the window
length is that it uses more memory and requires additional processing time.

The configuration menu also includes a field for selecting what population of each K-1 bit pattern must be
accumulated before the TIE associated with that pattern is considered accurate. Using a larger population
means that more observations are averaged together, so that the variance of the measurement is reduced.
Specifying a larger population has the disadvantage of requiring a longer measurement period before
results can be calculated and it may be necessary to sequence the instrument several times before enough
statistics are accumulated to provide results.
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The arbitrary pattern approach for measuring jitter may not be appropriate if there are very-long-duration
memory effects in your data link. An example would be if there are impedance mismatch reflections that
arrive long enough after the initial edge to fall outside the analysis window.
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Table 56: RJ/DJ analysis of arbitrary options

Item Description

Data Signal Settings

Pattern Type Selects between repeating or arbitrary pattern analysis.

Window Length When the Pattern Type is set to Arbitrary, sets the pattern window
length in terms of Unit Interval (Ul) used for arbitrary pattern RJ/DJ
separation.

Population When the Pattern Type is set to Arbitrary, sets the minimum population
limit for each pattern to be qualified for arbitrary pattern RJ/DJ
separation.

Total Jitter Component

BER= 1E-? Set the Bit Error Rate exponent, thereby setting the statistical level at
which Total Jitter and Eye Opening are reported.

Apply to All

Apply Applies the current RJ/DJ configuration settings to all the selected

measurement(s) having RJ/DJ configuration tab.

T Available only for TJ@BER and Width@BER measurements.

Configuring Edges

106

This configuration tab allows you to select which waveform edge or edges the application will use to take
each measurement. Depending on the particular measurement, the tab will offer access to other options
and constraints that help guide the analysis. The application is able to automatically detect whether

a signal is clock or data, and will do so by default. This can be overridden by configuring the signal
type as Clock or Data.

The following configuration options apply to most measurements. Please see the subsequent sections for
Edge tabs corresponding to particular measurements.
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Configuring Edges for Skew Measurements

Item Description

Signal Type

Clock Forces the signal type to be interpreted as a Clock.
Measurements will take place on the edges specified by
the Clock Edge control.

Data Forces the signal to be interpreted as a Data. Both rising
and falling edges are used.

Auto Allows the application to automatically detect whether
the signal is clock or data. If the signal is a clock, the
Clock Edge control will determine which edges are used;
otherwise the Clock Edge control will have no effect.

Clock Edge

Rise Only the rising edges of the signal are used.

Fall Only the falling edges of the signal are used.

Both Both the rising and falling edges of the signal are used.

Configuring Edges for Skew Measurements

This configuration tab is displayed for Skew measurements.

Jitter and Eye Diagram Analysis Tools

DPOJET litter and Eye Diagram Analysis Tools

107



Operating Basics Configuring Edges for Differential CrossOver Voltage Measurements

Item Description

From Edge - Defines which edge of the first waveform is used to take measurements.

Rise Only the rising edges of the signal are used.

Fall Only the falling edges of the signal are used.

Both Both the rising and falling edges of the signal are used.

To Edge - Defines which edge on the second waveform is used to take measurements.

Same as From Each measurement is defined by a pair of like edges (Rise
to Rise or Fall to Fall).

Opposite as From Each measurement is defined by a pair of opposing edges
(Rise to Fall or Fall to Rise).

Configuring Edges for Differential CrossOver Voltage Measurements

This configuration tab is displayed for Differential CrossOver Voltage measurements.

Jitter and Eye Diagram Analysis Tools

Item Description

Main Edge - Defines which edges on the Source1 waveform are used to take the measurement.

Rise Only the rising edges of the signal are used.

Fall Only the falling edges of the signal are used.

Both Both the rising and falling edges of the signal are used.
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Configuring Edges for Phase Noise Measurements

This configuration tab is displayed for Phase Noise measurements. Phase noise measurements are
undefined for data signals, so the signal is assumed to be a clock.

The Noise Integration Limits determine the portion of the phase noise spectrum that is integrated to
produce a single measurement per waveform acquisition.

Jitter and Eye Diagram Analysis Tools

Item Description

Active Edge-Defines which edge of the source waveform is used to take measurements.

Rise Only the rising edges of the signal are used.

Fall Only the falling edges of the signal are used.

Both Both the rising and falling edges of the signal are used.
Noise Integration Limits

Upper Frequency Sets the upper end of the noise integration frequency range.
Lower Frequency Sets the lower end of the noise integration frequency range.
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Configuring Edges for N-Period Measurements
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This configuration tab is displayed for N-Period measurements.

Jittes and Eye Diagram Analysis Tools

Item Description

Signal Type

Clock Forces the signal to be interpreted as a Clock.
Measurements will take place on the edges specified by
the Clock Edge control.

Data Forces the signal to be interpreted as a Data. Both rising
and falling edges are used.

Auto Allows the application to automatically detect whether
the signal is clock or data. If the signal is a clock, the
Clock Edge control will determine which edges are used;
otherwise the Clock Edge control will have no effect.

Clock Edge

Rise Only the rising edges of the signal are used.

Fall Only the falling edges of the signal are used.

Both Both the rising and falling edges of the signal are used.

N= Specifies number of cycles or unit interval in each N-period

group.

Edge Increment

Specifies the temporal displacement in edges between
consecutive measurements.
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Configuring Edges for Two Source Measurements

This configuration tab is displayed for two source measurements: Setup and Hold.

Jitter and Eye Diagram Analysis Tools

AT | Measurement Source(s) |
| T chichz || Edges
' | Clock Edge

Filters
General

Glohal

Item Description

Clock Edge

Rise Only the rising edges of the signal are used.

Fall Only the falling edges of the signal are used.

Both Both the rising and falling edges of the signal are used.
Data Edge

Rise Only the rising edges of the signal are used.

Fall Only the falling edges of the signal are used.

Both Both the rising and falling edges of the signal are used.
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Configuring Edges for CC-Period/Duty Cycle Measurements
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This configuration tab is displayed for the CC—Period, +Duty Cycle and —Duty Cycle measurements.
These measurements are only defined for clock signals, and each measurement value is evaluated over one
full clock cycle.

Jitter and Eye Diagram Analysis Tools

Item Description

Clock Edge

Rise Measurements are only initiated on the Rising edges of the
clock signal.

Fall Measurements are only initiated on the Falling edges of
the clock signal.

Both Measurements are initiated on both the Rising and falling

edges of the clock signal.
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Configuring Edges for DCD Measurement

Configuring Edges for DCD Measurement

This configuration tab is displayed for DCD measurement.

Jitter and Eye Diagram Analysis Tools

Item Description

Signal Type

Clock Forces the signal type to Clock. Edges are selectable.

Data Forces the signal type to Data. Both rising and falling edges
are used.

Auto Automatically detects whether the signal is clock or data.

DPOJET litter and Eye Diagram Analysis Tools
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Sequencing

Use the Control Panel to start or stop the sequence of processes the application and oscilloscope use to
acquire information from a waveform. The application then determines if the algorithm for the selected
measurement can be applied to the waveform information. Sequencing is the steps to acquire waveform
information, determine if the information is usable for the measurement, take the measurement, and
display the results (and plots if selected).

When you click Recalc, Single or Run, the corresponding button is changed to Stop and the Progress
indicator is displayed. For more details, refer to the Control Panel.

The Progress Indicator displays the sequencer state. Select Stop, if you want to interrupt the sequence
before its completion.

For more details on progress bar status messages, refer to Progress Bar Status Messages.

Viewing Statistical Results

There are two ways to view the statistical results of measurements:
B Summary
m Details

The application displays results for the measurements for all acquisitions or for the current acquisition. By
default in the detail view, the limits will not be shown unless the limits are turned on.
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Table 57: Results menu options

Item

Viewing Statistical Results

Description

X

Displays an error message. You can click 6 to view the
error log information in a text editor.

N

Displays a warning. You can click _Il to view the error
log information in a text editor.

Description Lists the measurement name and the source.

Mean Lists a statistical mean value for the measurement data.

Std Dev Lists a statistical standard deviation value for the
measurement data.

Max Lists a statistical maximum value for the measurement data.

Min Lists a statistical minimum value for the measurement data.

p-p Lists a statistical peak-to-peak value for the measurement
data.

Population Lists the total number of measurement data points used
for displaying the statistics.

Max-cc Lists the maximum cycle-to-cycle differences per acquisition.

Min-cc Lists the minimum cycle-to-cycle differences per acquisition.

el Click to view Save Current Stats, View Result Summary,
-'. View Result Details, Export to Ref Waveform, View Plot
Options Summary, and Display Units-Absolute options.

Save Current Stats...

Saves the current statistics as log information.

View Results Summary

Displays the summary of the results for all acquisitions.

View Results Details

Displays the detailed results specifying values for High
Limit, Low Limit, Pass/Fail, and current acquisition.

Export to Ref Waveform

Exports time trend data of the selected measurement to
the reference memory.

Default display unit is Absolute.

Display Units- Absolute
=

Click to view the result details.

DPOJET litter and Eye Diagram Analysis Tools
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NOTE. For I\_/Iask Hits measurement, only Mean, Max, Min and Population values are displayed in the results table.
On clicking \&!, Hits in Segment 1, Segment 2 and Segment 3 are displayed. For Mask Hits measurements, mean
indicates the total number of hits for all acquisitions.

The results tab with limits turned on is as follows:

Jitter and Eye Diagram Analysis Tools

MGns | D9FTHERS | 1120ps | 40083 | 26.500ps
High Limi 11210 1.1210ks
Lo Lt
Pass Fail [Fasll Pass
Curresi Aciquisition  D.O700ms Annaz 26,5050

Results with Error/Warning Notification

The results tab with error 8 icon is as shown. You can click View Log to view the error log information
in a text editor.

Jitter and Eye Diagram Analysis Tools Options

DTELRe 00000 |23030ps  31sA0ps 33A70ps | 64721ps 17 51580ps -51491ps
(= RJ1, Reft ]

[# RJ—0id1, Ref1

[+l TJ@BER1, Ref1

= DJ1, Reft

[+ DJ-6id1, Ref1

(+] Phase Noise1, Ref1  44.671ps 0.0000s 44.671ps 14.671ps 0.0000s
[ PJ1, Reft

[+ DDJ1, Ref1

[ DCOM, Ref1

0.0000s 0.0000s

L = T — B — R — I~ R =)

The results tab with warning _!.\ icon is as shown. You can click View Log to view the error log
information in a text editor.
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Jitter and Eye Diagram Analysis Tools Oitions

1] escripton Max  Mm pp Powaton Maxec  Mnce
05 TELRert  00000s | 8600ps  f2adlps |S2426pe  dsAOGps | 3750 | Z36S0ns |-57izps

L:.l RJ1, Ret1 1.5262ps 0.0000s 1.5262ps 1.5262ps 0.00005 1 0.00005 0.0000s

Export Results to Ref Waveform

Using this option, you can export the time trend plot of a measurement to any of the available reference
memory, Refl-Ref4. Click “® on the right corner of the results panel to select the “Export Results to
Ref” option.

The Export Results to Ref waveform dialog box appears. It lists all the possible measurements that have
time trend result data (that is measurements for which time trend plot is enabled in the plot panel).

From the list of measurements, results of any one measurement can be exported to any one of the reference
memory (Refl-Ref4) which is not used as source of any measurement.
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Before exporting results to a reference memory, the application checks for the following:

If any of the ref waveforms are already used as source for one of the measurement(s), then you cannot
export the results on those ref destinations. The application prevents exporting by displaying an
error message 2003.

If all the reference waveforms (Ref1-Ref4) are already used as sources for various measurements, the
“Export Results to Ref Waveform” is not displayed. Instead, an error message 2002 is displayed.

If a ref destination is assigned to a measurement from the list which is not empty (that is, if the ref is
already defined and holds any other recalled waveform), a warning prompts you from overwriting the
existing definition of the selected destination ref.

In case of any error (2002 or 2004) or warning (Overwriting the existing definition) and you select
the response as “No”, the destination ref reverts to its previous value. For example, if the selected
measurement is Period-Ref1, and the destination ref assigned to the measurement is Ref3, and if you
try to change the destination from Ref3 to Refl, an error message 2003 is displayed. Ref3 is retained
as the destination ref.

Time trend result export to the reference waveform for a measurement is independent of time trend
plot. Time trend result can be exported to ref without selecting/defining plots in the plots panel.

If “Export Results to Ref” is selected without any measurement selection, an error message 2005 is
displayed.

If none of the selected measurements have time trend data, an error message 2007 is displayed and
“Export Results to Ref” dialog is not displayed.

If the selected measurements have no results (results are cleared or measurements are not run to produce
results), an error message 2006 is displayed and “Export Results to Ref” dialog box is not displayed.

If the destination is none for all measurements, the results are not exported to ref on clicking OK. An
information/warning 2008 is displayed.

Results as Plots

The application can display the results as two-dimensional plots for easier analysis. Before or after you
take measurements, you can set up the Select Plots and Plots Configure menus to define up to four plots.
The last plot selected is displayed when the application completes sequencing.

If you set up plots after sequencing, the application displays the plot based on the current measurement
and result.

NOTE. When taking measurements in the Run mode, you must stop the sequencing before you can use some
plot features.
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Table 58: Plot type definitions

Results as Plots

Item Description

Time Trend Represents the measurement values versus the time
location.

Data Array Represents the measurement values versus the index
number of the measurement array.

Histogram 1 Represents measurements sorted by value as a distribution
of measurement values versus the number of times the
value occurred.

Spectrum Represents the frequency content computed using the FFT
of the Time Trend of the measurement data.

Transfer Represents the magnitude ratio of spectrum of time trend

data of two measurements from the following set: Clock
Period, Clock Frequency, Clock TIE, Clock PLL TIE, Data
Period, Data Frequency, Data TIE, Data PLL TIE.

Phase Noise 2

Represents the phase noise of a clock signal and is plotted
in the frequency domain for only Clock TIE measurements.

Eye Diagram 3

Represents data for the eye diagram based on the
recovered clock as the timing reference; used for mask
testing.

Waveform 4 Represents the acquired waveform. It is available for use
with eye diagram mask tests to locate bit errors in the
real-time waveform.

Bathtub 5 Represents the Bit Error Rate versus the unit interval for
measurements that include RJ/DJ analysis.

1 Available for all measurements except Mask Hits.

2 Available only for Phase Noise measurement.

3 Available only for all Eye and TIE measurements.

4 Available only for Mask Hits measurement.

5
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You can select the measurements from the displayed measurement list table on the left. The Plots for the
selected measurements are displayed in Select Plots. The plots which are not applicable for the selected
measurement are not available under Select Plots. You can select up to 4 plots.

Plot Usage

120

This section provides a description of various plots such as Histogram, Time Trend, Data Array, Spectrum,
Transfer, Phase Noise, Eye Diagram, Waveform, and Bathtub.

Histogram Plot Usage

A Histogram plot displays the results such that the horizontal axis represents the measurement values and
the vertical axis represents the number of times that each value occurred. Unlike most other plots, a
histogram plot can accumulate measurements over multiple acquisitions, up to a total population size of
2.1 billion.

Histograms are particularly useful in analyzing jitter. A histogram of the Time Interval Error (TIE)
represents the basis of jitter analysis using a histogram approach. In a histogram, Deterministic Jitter (DJ)
is bounded so that the horizontal span of the plot will remain relatively constant. Random Jitter (RJ) is
unbounded and amplitude (horizontal span) will continue to grow as more population is acquired. The TIE
histogram provides a good way to quickly and informally assess jitter.

Spectrum Plot Usage

A Spectrum plot is obtained from the Fourier Transform of measurement data from a Time Trend.
This plot is useful in identifying periodic frequency components that contribute to timing errors, such
as phase modulation.

When the signal has a repetitive data pattern, an analysis of the TIE Spectrum of the signal can be used to
separate Random Jitter (RJ) from Deterministic Jitter (DJ) as well as to separate subcomponents such as
Periodic Jitter (PJ), ISI and DCD. Spectral components (spikes ) that do not correlate with the frequencies
contained in the data pattern can be a clue that external deterministic noise sources are coupling into a
system.

Data Array Plot Usage

A Data Array plot shows measurement values versus measurement index, where the indexes are always
equally spaced along the horizontal axis. In contrast, the measurement values on a Time Trend plot are
not equally spaced along the horizontal time axis.

Time Trend Plot Usage

A Time Trend plot is a waveform trace of a measurement versus time. Each measurement value is placed
precisely at the time at which the measurement took place. Measurements that involve two timing points
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are placed at the midpoint between those two time. For example, a Risetime measurement is placed
halfway between the low threshold crossing and the high threshold crossing.

A Time Trend plot is useful, for example, in determining if the embedded clock in a serial bit stream is
modulated outside the capabilities of your receiver to recover the clock. If the TIE time trend plot starts
to take an unexpected periodic shape, then this could indicate that you have uncorrelated periodic jitter
from crosstalk or from power supply coupling.

Bathtub Plot Usage

A Bathtub curve is the industry standard way of viewing the statistical Jitter Eye Opening. A Bathtub
curve represents eye opening as a function of the BER (Bit Error Ratio). Most serial standards call for
Total Jitter to be measured at a BER of 10-12. The eye opening represented by the Bathtub Curve is what is
left of the unit interval after the total jitter measurement is subtracted.

The Jitter Eye opening and the Total Jitter have the following relationship:
Total Jitter + Jitter Eye Opening = 1 Unit Interval

The Bathtub Curve plot shows the eye opening and total jitter values as functions of the BER level. The
plot is obtained from jitter analysis that performs RJ/DJ separation.
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Phase Noise Plot Usage

A Phase Noise plot shows a frequency domain view of the jitter noise on a waveform normalized in
an industry-standard way. The vertical axis is logarithmic and uses the units of dBc/Hz, which means
“decibels (relative to the carrier) per Hertz”. The horizontal axis is logarithmic with units.
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Transfer Function Plot Usage

A Transfer Function plot shows the magnitude ratio of the frequency spectrums of two measurements
on logarithmic axes. This can be a useful way to depict the response of a system to stimuli at various
frequencies, or to identify poles and zeros in a system characteristic equation. Suppose that x(t) is a
jitter measurement at the input of a device, and y(t) is a corresponding jitter measurement at the output
of the device. The Transfer Function plot can be used to show the following function, where X(f) is
the Fourier Transform of x(t):

Hip= fripl
kol

The horizontal axis of the Transfer Function plot goes up to the Nyquist frequency of X or Y, whichever is
lower. These plots work best if averaged across multiple acquisitions to reduce the effects of measurement
noise.

Waveform Plot Usage

The waveform plot is only applicable to the Mask Hits measurement. It depicts a copy of the source
waveform, with all mask violations denoted in a highlight color. These are the same violations that
appear on the Mask Hits eye diagram, but the waveform plot allows them to be seen in the context of a
continuous-time waveform.

Eye Diagram Plot Usage

An eye diagram is a plot of the voltage versus time for a serial bit stream, with the time axis “wrapped”
so that all unit intervals are superimposed on top of each other in a time-aligned fashion. Because the
resulting plot has many waveforms overlaid, color grading is used to separate areas with many coincident
waveforms from areas that are only rarely crossed.

If there is an area free of waveforms in the center of the diagram, the eye is said to be “open”,

and a comparator circuit repetitively sampling the waveform at this point in the unit interval could
unambiguously separate the two logic states. For experienced signal integrity engineers, the eye diagram
allows many common problems to be recognized instantly.
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Selecting Plots

Before or after you take measurements, you can set up plots for the selected measurements by following
these steps:

Jitter amd Eye Diagram Analysis Teols

F'haso Bose

Spectrum  Transfer
[ATAPRRNTEY
EyeDiagram  Wasform  Hathiub

x

1. Click Plots in the navigation panel to view the Select Plot window. The currently active measurements
and source(s) are displayed in the table on the left (measurement table).

2. Click any of the plot icons that are available for the selected measurement. The corresponding plot type
and measurement are then added to a table on the right (plot table).

3. Add another plot for the current measurement, or select a different measurement and choose from its
plot types. A maximum of four plots can be selected at any given time.

Table 59: Plot selections

Item Description

Plots Lists only the plots which are available for the selected
measurement. Click a plot icon to add the plot type to the
table on the right.

Clear Selected Clears the selected plot from the plot table.
Clear All Clears all plots from the plot table.
Configure Allows you to adjust display options for the selected plot.

About Configuring Plots

Most plot types (except Data Array and Waveform) have display options that can be adjusted for each
instance of the selected plot.
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The steps to configure a plot are:
1.

Select a plot instance by clicking on a row from plot table on the right.

. Click Configure to display a pop-up window with the available configuration options.

2
3.
4

Adjust the configuration options and click OK to accept the changes and close the window.

. Click Show Plots in the control panel to view the configured plot.

NOTE. The Show Plots icon appears in the control panel only when one or more plots are defined.

Related Topics

Configuring a Time Trend

Configuring a Histogram Plot

Configuring a Spectrum Plot

Configuring a Transfer Plot

Configuring a Phase Noise Plot

Configuring an Eye Diagram for Mask Hits
Configuring an Eye Diagram Plot for Eye Height
Configuring a Bathtub Plot

Configuring a Bathtub Plot

124

Select a Bathtub plot in the table on the right and click Configure to configure the plot.
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o

—Conﬁgure Bathtub

Item Description

Vertical Scale

Log Selects logarithmic scaling for the vertical axis.
Linear Selects linear scaling for the vertical axis.

Minimum Displayed BER=1E?

Sets the lower axis limit for logarithmic plots to this value
(expressed as the negative of a base-10 exponent).

OK

Accepts the changes and closes the window.

DPOJET litter and Eye Diagram Analysis Tools
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Configuring a Spectrum Plot

Select a Spectrum plot in the table on the right to and click Configure to configure the plot.

Configure Spectrum

Item Description

Vertical Scale

Log Selects logarithmic scaling for the vertical axis.

Linear Selects linear scaling for the vertical axis.

Base Sets the lower axis limit for logarithmic plots to this value

(expressed as a base-10 exponent). Available only when
the vertical scale is log.

Horizontal Scale

Log

Selects logarithmic scaling for the horizontal axis.

Linear

Selects linear scaling for the horizontal axis.

Mode

Selects whether the plot shows only the most recent
spectrum, the uniform average of all spectrums since
the last time the results were cleared, or the peak of the
envelope of all spectrums since the last time the results
were cleared.

Normal- Shows magnitude values from the most recent
acquisition.

Average - Averages the magnitude values at each
frequency.

Peak Hold - Keeps the maximum value at each frequency.

OK

Accepts the changes and closes the window.
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Configuring a Time Trend

Select a Time Trend plot in the table on the right and click Configure to configure the plot.

Item Description

Vector Connects measurement points with straight lines to form a
continuous waveform.

Bar Places a vertical bar at the horizontal position of each
measurement with a height (positive or negative) that
represents the value of that measurement; a horizontal
baseline represents the mean value of the Time Trend.

OK Accepts the changes and closes the window.
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Configuring a Histogram Plot

Select a Histogram plot in the table on the right and click Configure to configure the plot.

Item Description

Vertical Scale

Linear Selects linear scaling for the vertical axis.

Log Selects logarithmic scaling for the vertical axis.

Number of Bins

Resolution

Defines resolution by the number of bins into which Span is
divided: 25, 50, 100, 250, or 500.

Horizontal Scale

Auto Scale

Causes the horizontal scale of the histogram to be adjusted
automatically based on the accumulated data points.

If subsequently acquired data falls outside the current
horizontal scale, histogram bins are consolidated so that the
number of bins is preserved and the horizontal scale allows
all data to be plotted. When checked, disables the “Center”
and “Span” numerical inputs.

Center

Manually sets the value for the horizontal center of the
Histogram, for subsequent plot updates.

Span

Manually sets the value for the total horizontal range of the
Histogram, for subsequent plot updates.

Autoset

Uses the results of the latest acquisition to determine
the logical values for the Center and Span options (if the
population of the measurement is three or more).

OK

Accepts the changes and closes the window.
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Configuring a Transfer Plot

Select a Transfer Function plot in the table on the right and click Configure to configure the plot.

Configure Transfar Function

Item Description
Definition
Numerator Measurement for which the magnitude spectrum is used as

a reference.

Denominator

Measurement for which the magnitude spectrum is used
to normalize the numerator.

Vertical Scale

Linear Selects linear scaling for the vertical axis.

Log Selects logarithmic scaling for the vertical axis (default).

Horizontal Scale

Linear Selects linear scaling for the vertical axis.

Log Selects logarithmic scaling for the horizontal axis (default).

Mode Selects whether the plot shows only the most recent
spectrum, or the uniform average of all spectrums since the
last time the results were cleared (default).
Normal - updates the plot with current values.
Average - averages the magnitude values at each
frequency.

OK Accepts the changes and closes the window.
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Configuring a Phase Noise Plot

Select a Phase Noise plot in the table on the right and click Configure to configure the plot.

Item Description

Vertical Position

Baseline Sets the lower axis limit for logarithmic plots to this value.
OK Accepts the changes and closes the window.
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Configuring an Eye Diagram Plot for Eye Height

Select an Eye Diagram plot (for all eye measurements other than Mask Hits) in the table on the right and

click Configure to configure the plot.

Configura Eye Diagram

b \TekAppbcalions\DPOUET Wask: PO Expeess\PLE_Rev 21 [CETOMNSE

Item Description

Mask

On Enables display and mask testing.

Off Disables display and mask testing.

Browse Select a mask file to import from the C:\TekApp1ica-

tions\DPOJET\Masks directory.

Horizontal Scale

Auto Scale When checked, causes the horizontal scale to be adjusted
automatically.

Resolution Manually sets the horizontal resolution, when Auto Scale
is unchecked.

OK Accepts the changes and closes the window.

DPOJET litter and Eye Diagram Analysis Tools

131



Operating Basics Configuring an Eye Diagram for Mask Hits

Configuring an Eye Diagram for Mask Hits

An eye diagram plot is activated whenever a mask hits measurement is selected. Click Configure in
the plots panel to configure the plot.

Configure Eye Diagram for Mas

PCE_RuwiD RX.msk

Item Description

Mask Shows which mask has been selected (For the Mask Hits
measurement, the mask selection is performed as part of
measurement configuration rather than plot configuration).

Horizontal Scale

Auto Scale When checked, causes the horizontal scale to be adjusted
automatically.

Resolution Manually sets the horizontal resolution, when Auto Scale
is unchecked.

OK Accepts the changes and closes the window.
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About Viewing Plots

You can create and configure up to four plots. If you already have measurement results, creating a plot will
cause it to be displayed immediately. If there are no current results, the plot will be created when you
sequence the application and results have been calculated. The Show Plots icon appears in the control

panel whenever at least one plot is defined. The Show Plots E icon appears in the control panel
whenever at least one plot is defined. By default, all defined plots windows are grouped in a single window
on the upper half of the display, but the window can be moved, resized, or dragged to a second monitor.
The application includes tools to help you select which plots to view, to size and position the plot windows,
to save plot information, to use the zoom function, and to use the cursors functions.

If your windows desktop is extended to a second monitor, you can drag the plots window to the second
monitor.

NOTE. When sequencing is complete, the plot window displays with the last plot selected. The plot window also
updates whenever you reconfigure a plot.

Using a Second Monitor to View Plots

If your oscilloscope setup includes a second monitor that extends the Windows desktop, you can select and
drag the title bar of the plot window to position it in the second monitor. This allows you to simultaneously
display a waveform on the oscilloscope, measurement results, and the plot for easy viewing.
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Toolbar Functions in Plot Windows

The Plot Toolbar window includes the following functions:

B8 AfanEw ool A BFs0 HBER veaa

Table 60: Plot toolbar functions

Icon Functions

I Export Figure.

= Print Figure.

®, @ ) &M g g Zoom and Pan.

iwimh!ﬂ«} ] ‘éiu’j;‘ Vertical and Horizontal Cursor controls.
R T Moving and Resizing Plots.

Plot properties.

S

ol = = Plot Summary Views.
mE= OO
®+ @’f @,’f @’f Full view of plots 1 to 4.

Moving and Resizing plots

You can move and resize plot windows the same way you would move and resize any window.

You can change the plot size to the whole display of the oscilloscope, or to half the display. When
viewing a plot in half the display, you can position the plot to the top or bottom. The tools also return

the plot to the original size. To position a plot quickly on the oscilloscope, select one of the following
tools in the plot window:

u enlarges the plot to fill the entire display.

=
B T positions the plot to the top.
4 ..
B [ positions the plot to the bottom.

= always keep the plot on top layer.
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Using Zoom in a Plot

Once you have created a plot, you can use the Zoom tools to examine the data at various scales.

TIP. If you prefer to use the zoom functions in a plot window with your finger, you can activate the Touch Screen
on the oscilloscope.

Table 61: Zoom functions in a plot

Item Description

@l Zoom in (Horizontal and Vertical) — Expands part of the plot;
the data appears in more detail.

Zoom out — Contracts part of the plot; the data appears in
less detail.

Zoom in (Horizontal only) — Expands the horizontal axis only
and retains the vertical axis.

J?Iﬁ.;. i

Resets the zoom to 100%.

Changing the Scale of Data in a Plot (Zoom)

To change the scale of the data in a Plot Details window, select one of the following plot zoom tools:
= % zooms in to expand the scale.
n

zooms out to contract the scale.

= R zooms in to expand the horizontal axis only.

3

= moves the plot anywhere within the scale.

J

= zooms in to restore the entire waveform data.

When you select the ® tool, you can use a select-drag-release action to expand part of the waveform
(zoom in) by an arbitrary amount on both axes. After you select (touch with a finger or click with the
mouse) and begin dragging, a bounding box shows what part of the waveform will be expanded upon
release.

Select any part of the plot to expand the data by a factor of two (2X) equally on both axes. Double
selecting expands the data to the maximum factor.

To contract an expanded part of the data (zoom out), select anywhere on the data. The view contracts to
the values that existed before the most recent expansion of the data. Selecting multiple times will restore
successively earlier views. To expand the scale of the horizontal axis only by a factor of two (2X), click a
part of the waveform. The plot retains the scale of the vertical axis.

TIP. Select ™ to see the entire available waveform.
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Using Cursors in a Plot

Cursors allow you to view numerical values associated with a plot based on cursor locations. There are
two types of cursors:

m Horizontal cursors

B Vertical cursors

Table 62: Cursor functions in a plot

Item Description

wal Displays the vertical coordinate where each cursor touches
the plot and the difference (A) between the cursors.

\H\ Displays the horizontal coordinate where each cursor
touches the plot and the difference (A) between the cursors.

Brings the cursors into the visible part of the plot.

o

EZET

&9 Displays the plot properties.

Cursors in a Plot

You can use cursors to read the coordinate where each cursor (line) touches the plot and also view the
difference (A) between the two cursors. The steps to use cursors in a plot details window are:

1. Select any of the following cursors:
- W to use horizontal cursors.
- L4} to use vertical cursors.

- 2!’:1? to bring cursors into the visible plot.

2. Select and drag either cursor to move the cursor to the desired part of the plot. The cursor readout
changes to reflect the cursor position.

NOTE. You can drag cursors only when the Zoom functions are disabled.

TIP. If you prefer to move the cursors in the plot window with your finger, you can activate the touch screen on the
oscilloscope.
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Exporting Plot Files

You can export plot image in Plot Toolbar window. Click = (o save the contents of the plot window in
any of the format as a MATLAB figure format (.fig), .bmp, .jpg, .png, .emf, .tif, .mat and .csv.

The steps to export a plot file are:

1. Set up the plot window.

2. Select B to save the plot as a figure.
3. Select the directory and enter a file name.

4. Click Save. The application saves the file in C:\TekApplications\DPOJET\images.

Printing Plots

The steps to print a plot are:
1. Verify that the printer is configured.

2. Set up the plot window with zoom, cursors, or grid functions.
3. Click & icon in the plot details/summary window. The Print Preview dialog is displayed.

4. Click = to set up the printing options and print a plot file.

NOTE. You can customize the print layout using the MATLAB page setup options. The DPOJET online help does not
provide information on MATLAB page setup. For more information, refer to the MATLAB documentation.

About Reports

You can use the Reports to configure and generate a compliance report to view later or to share with others.
You can also access reports using Analyze > Jitter and Eye Analysis > Reports. You can select the
option which you want to display in the report as shown in the following table:
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Table 63: Report generation options

Item Description
Content Options
Include setup configuration Select/Clear the option to include/exclude the setup

information like DPOJET version, oscilloscope version, and
status in the generated report.

Include complete application configuration Select/Clear the option to include/exclude the complete
configuration details in the generated report.

Include summary pass/fail results Select/Clear the option to include/exclude the pass/fail
status in the generated report.

Included detailed results Select/Clear the option to include/exclude the measurement
result details in the generated report.

Include plot images Select/Clear the option to include/exclude the plot images

like measurement plots and oscilloscope waveform in the
generated report.

Save Options

Auto increment report name if duplicate Select/Clear the option to autoincrement the report name
if its already existed. The autogenerated report is of
YYMMDD_HHMMSS_ savedfile.mht format.

View report after generating Select this option to view the report after generation.

Report Name Lists the directory path where the last generated report is
stored.

Save Saves the changes in the default report directory.

Manipulates the report name based on “Auto increment
report name if duplicate” option.

Save As Displays the browser where you specify the directory to
save the generated report. You can also edit the report
name in the Save As browser. The generated report is
saved in C:\TekApplications\DPOJET\Reports.
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Introduction to the Tutorial

Reports Format

The generated reports are in .mht format and includes the following configured set of information:

Setup Configuration such as DPOJET version, oscilloscope version, and the Pass/Fail status.
Measurement Configuration such as measurement name, source and other configuration parameters.

Source Reference Levels displays the reference voltage levels for the high, mid, and low thresholds
for the rising edge and for the falling edge of all sources, and the hysteresis.

Miscellaneous Settings such as Gating, Qualify and Population status.
Pass/Fail Summary indicating the Pass/Fail status for the selected measurements.
Measurement Results with statistics.

Plot Images includes both selected plots and oscilloscope waveforms.

Introduction to the Tutorial

This tutorial teaches how to set up the application, take measurements, and view results as plots or statistics.

Before you begin the tutorial, perform the following tasks:

Set up the oscilloscope.
Start the application.

Recall the tutorial waveform.

NOTE. The screen captures shown in this section are from a DPO7254 oscilloscope.

Setting Up the Oscilloscope

The steps to set up the oscilloscope are:

1.
2.

Click File > Recall Default Setup in the oscilloscope menu bar to recall the default settings.

Press the individual CH1, CH2, CH3, and CH4 buttons as needed to add or remove active waveforms
from the display.

Starting the Application

Click Analyze > Jitter and Eye Analysis > Select to open the application.
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Waveform Files

Waveform Files
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The application provides the following tutorial waveforms:

Rt-EyeTutorial. wfm
ckminus_50gs 18g 20m_patl.wfm
ckplus 50gs 18g 20m_patl.wfm
dplus 50gs 18g 20m_patl.wfm
dminus_50gs 18g 20m_patl.wfm

The waveform files are found at C:\TekApplications\DPOJET\ExampTles.
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Recalling a Waveform File

To recall a waveform file, follow these steps:

1. Click File > Recall in the oscilloscope menu bar to display the Recall dialog box.

NOTE. If the application is in button mode, select the Recall button to recall the tutorial waveform.

. Click Waveform icon in the left of the Recall dialog box.

. Select Refl, Ref2, Ref3, or Ref4 as the Destination option.

2

3

4. Browse to select the waveform. Use the keypad to edit the waveform file name.

5. Click Recall. The oscilloscope recalls and activates the Reference Waveform control window.
6

. Click On to display the waveform.

. Click E to return to the application. Alternatively, DPOJET can also be accessed from Analyze
> Jitter and Eye Analysis > Select.

Rafarance :
~x - N

|

In the Summary tutorial, the tutorial waveforms are recalled as Math waveforms using the following setup:

m dplus 50gs 18g 20m_patl.wfm is recalled as Refl and dminus_50gs 18g 20m_patl.wfm as Ref2.

NOTE. Using Math Setup ( Select Math > Math Setup in the menu bar to view the Math Setup dialog. For more details,
refer to the “Math Equation Editor: Controls in your oscilloscope online help), set Math1=Ref1-Ref2 (Data signals)..

m ckplus 50gs 18g 20m_patl.wfm is recalled as Ref3 and ckminus 50gs 18g 20m_patl.wfm as Ref4.

NOTE. Using Math Setup, set Math2 =Ref3—Ref4 (Clock Signals).

Taking a Period Measurement

In this lesson, you will learn how to take a period measurement and view the results. You can also learn the
following tasks:

E  Select a measurement and a source
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Taking a Period Measurement

Configure measurement

Take measurements

View results as plots or statistics
View reports

Return to the application

Setting up a Period Measurement

Follow these steps to take a period measurement:

1.

To set the application to default values, click File > Recall Default Setup. This is not necessary if
you have just started the application.

To view the DPOJET application, select Analyze > Jitter and Eye Analysis > Select.

Go to Select in the left navigation panel. Click Period in the Measurements area. The application shows
the measurement and source selection on the right of the display. The current measurement selection is
displayed as Period1. The subsequent selections will be Period2, Period3 and so on. In this example,
Rt-EyeTutorial.wfm is recalled as Refl and is selected as source for Periodl. New measurements
initially use the same source as the earlier measurement, or the most recently used source.

Jitter and Eye Diagram Analysiz Tooks

Click E or the row which lists the selected measurement to configure the source. Select Refl for
Periodl. For more details, refer to Source Setup.

Click Ref Levels Setup. The Configure Reflevel menu appears. For more details, refer to Ref Levels.

Click Configure in the left navigation panel of the main application window to view the configure
tabs. For more details, refer to About Configuring a Measurement.

Click Plots to view the available plots for the selected measurement . Select Time Trend for Period. For
more details, refer to Configuring Time Trend.

Click Single to run the application. When complete, the result statistics is shown in the results tab. The
plots are displayed as shown:
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NOTE. You can log result statistics, measurement data points to a .csv file and worst case waveforms to a .wfm file.

Taking a TIE Measurement

For jitter application, we use PLL TIE measurement. The steps to take a TIE measurement are:

1. To set the application to default values, click File > Recall Default Setup. This is not necessary if
you have just started the application.

2. Go to Select in the left navigational panel. Click Jitter tab to select TIE in the Measurements area. The
application shows the measurement and source selection on the right of the display. In this example,
Rt-EyeTutorial.wfm is recalled as Refl and is selected as source for TIE1.

Jitter and Eye Diagram Analysis Tools

3. Click H or the row which lists the selected measurement to configure the source. Select Refl for
TIE1. For more details, refer to Source Setup.

4. Click Ref Levels Setup in the source configuration dialog. The Configure Reflevel menu appears.
For more details, refer to Ref Levels.
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5. Click Configure in the left navigation panel to view the configure tabs. For more details, refer to
Configuring Measurements.

6. Click Plots to view the available plots for the selected measurement. Select Time Trend and Spectrum
plots for TIE measurement. For more details, refer to Configure Plots.

7. Click Single to run the application. When complete, the result statistics is shown in the results tab. The
plots are displayed as follows:

) DPOJET Plots
EIEEE TS

Y. Time TIET: Time Trend HTi YT TIE1: Spectrum

NOTE. You can log result statistics, measurement data points to a .csv file and worst case waveforms to a .wfm file.

Taking an Eye Height and Width Measurement

For signal integrity application, we use Eye Height and Width measurements.
1. Select Analyze > Jitter and Eye Analysis > Select to run the DPOJET application.

2. Go to Select in the left navigation panel. Click Eye tab to select Height and Width measurement. In this
example, Rt-EyeTutorial. wfm is recalled as Refl and is selected as source for Heightl and Widthl.

Jitter and Eye Disgram Analysis Toolks
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Summary Tutorial

Select Ref1 as source for Height and Width measurements. For more details, refer to Source Setup.

Click Plots to view the available plots for the selected measurement. Select Eye Diagram for Height
measurement.

Select Eye diagram Plot type and click Configure to turn on the Mask in the Configure Eye Diagram
for Eye Height dialog. For more details, refer to the Configuring Eye Diagram Plot for Eye Height.

Select Histogram plot for Width measurement.
Click Single to run the application. When complete, the result statistics is shown in the results tab.

The Plot summary window is displayed as shown in the following figure:

A DeOLIET Plats

L Hips  J00ps  A00es

NOTE. You can log result statistics, measurement data points to a .csv file and worst case waveforms to a .wfm file.

Summary Tutorial

For a summary tutorial, we use the following example:

Case 1: Period measurement with Low pass filters to show SSC profile:

1.

Select Analyze > Jitter and Eye Analysis > Select to run the DPOJET application. For more details
on waveforms recalled on Math1, Refer Recalling a Waveform File.

Select Period measurement on Mathl.

Click Configure. In the Filters configuration tab, select 2nd order low pass filter and specify the cut-off
frequency as 33kHz. (F2= Fi,s/1667).

Go to Plots. Select Time Trend for Period measurement.
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5. Click Single to run the application. When complete, the result statistics is shown in the results tab. The
Time Trend plot is as shown.

H& aganmamw ool FEOTeD

Case 2: A pair of TIE for showing jitter integration caused by SSC and the effect of a high pass filter
on SSC spectrum plots:

1. Click Jitter to select TIE measurement.

2. Select Math1 as the source for both TIE1 and TIE2.

Jitter and Eye Diagram Analysis Tools

Sorcedsh
e At

3. Click Configure. Do the following settings for TIE1 and TIE2 in the Filters configuration tab:
= Select “No Filter” for TIEI.

= Select 2nd order High Pass filter for TIE2. In this example, we have set F1 cut-off frequency as 1
GHz.

Go to Plots. Select Time Trend for both TIE1 and TIE2.
Select Spectrum plot for both TIE1 and TIE2.

Click Single to run the application. When complete, the result statistics is shown in the results tab.

NS e

A Plot Summary window shows Time Trend plots for TIE1, TIE2 and Spectrum plots for TIE1, TIE2.
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NOTE. You can log results as statistics, measurement data points to a .csv file and worst case waveforms to
a .wfm file.

Stopping the Tutorial

If you need more than one session to complete the tutorial lessons, you can stop the tutorial and return
to it later.

To save the application setup , refer to Saving a Setup File . To exit the DPOJET application, click

present at the right corner of the application.

Returning to the Tutorial

To return to the tutorial setup, you can start the application and then recall the saved setup. To recall the
application setup, refer to Recalling a Saved Setup File.
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About Parameters

This section describes the DPOJET application parameters and includes the menu default settings. Refer to
the user manual for your oscilloscope for operating details of other controls, such as front-panel buttons.

The parameter tables list the selections or range of values available for each option, the incremental unit of
numeric values, and the default selection or value.

Refer to the GPIB section for a complete list of the GPIB Command Syntax. The topics include a complete
list of the GPIB commands along with the arguments, variables, and variable values that correspond
to the DPOJET parameters.

Measurement Select Parameters

The Measurement Select includes the following measurement categories:

m Period/Freq : Frequency, Period, CC—Period , N—Period, Pos Width, Neg Width, +Duty Cycle, —Duty
Cycle, +CC-Duty, and —CC-Duty.

= Jitter : TIE, RJ, DJ, PJ, DDJ, DCD, RJ-86, DJ-60, TI@BER, Jitter Summary, and Phase Noise.
B Time : Rise Time, Fall Time, High Time, Low Time, Setup, Hold, and Skew.

® Eye : Height, Width, Mask Hits, and Width@BER.

= Ampl : High, Low, Common Mode, High—Low, T/nT Ratio, and V-Diff —Xovr .

You can set the Source option as any of the following waveforms: Chl, Ch2, Ch3, Ch4, Refl, Ref2, Ref3,
Ref4, Math1, Math2, Math3, or Math4.

Table 64: Source parameters

Option Parameters Default
Source1 Ch1-Ch4, Math1-Math4, Ref1-Ref4 Ch1
Source2 Ch1-Ch4, Math1-Math4, Ref1-Ref4 Ch2

Autoset Parameters
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The Configure Source Autoset includes the following command buttons:
B Vert Scale

® Horiz Res

B Vert & Horiz

B Undo

DPOIJET Jitter and Eye Diagram Analysis Tools



Parameters

Ref Level Menu Parameters

Ref Level Menu Parameters

The Configure Ref Level menu parameters includes the following command buttons:

= Autoset

m  Setup

Table 65: Source autoset ref level parameters

Option Parameters Default setting
Source Ch1-Ch4, Ref1-Ref4, Math1-Math4
Autoset Set, Clear Set
Rise High -20Vto20V 1V
Rise Mid -20Vto20V oV
Rise Low -20Vto20V -1V
Fall High -20Vto20V 1V
Fall Mid -20Vto20V ov
Fall Low -20Vto20V -1V
Hysteresis Oto10V 30 mV
Autoset Ref Levels Parameters
Table 66: Autoset ref levels parameters
Option Parameters Default setting
Base Top Method = Min-Max Auto

®  Low-High Histogram (Full

Waveform)
®m | ow- High Histogram (Center of
Eye)

= Auto
Rise High 110 99% 90%
Rise Mid 110 99% 50%
Rise Low 110 99% 10%
Fall High 110 99% 90%
Fall Mid 110 99% 50%
Fall Low 10 99% 10%
Hysteresis 0 to 50% 3%
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Preferences Parameters

The Analyze > Jitter and Eye Analysis > Preferences includes the following tabs:

® General
B Measurement

B Path Defaults

Table 67: Preferences parameters

Option Parameters Default setting

General

Display Units Seconds, Unit Intervals Seconds

Default Image Type PNG, JPG, BMP PNG

Notifier Duration 21020 s 5s

Measurement

Limit Rise/Fall measurements to Set, Clear

transition bits only

Enable high-performance eye Set, Clear Set

rendering

Dual Dirac Model Fibre Channel, PCI/FB-DIMM
PCI/FB-DIMM

Waveform Interpolation Type Linear, Sin(x)/x Linear

Path Defaults

Default image export directory Browser C:\TekAppTications\DPOJET\Images
Default logging export directory Browser C:\TekApplications\DPOJET\Logs
Default report output directory Browser C:\TekApplications\DPOJET\Reports
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Deskew Parameters

The Analyze > Jitter and Eye Analysis > Deskew includes the following command buttons:

®  Perform Deskew

B Summary

Table 68: Deskew parameters

Option Parameters Default setting
Reference Channel

Source Ch1, Ch2, Ch3, Ch4 Ch1
Mid -20Vto20V oV
Hysteresis Oto10V 30 mV
Channel to be Deskewed

Source Ch1, Ch2, Ch3, Ch4 Ch2
Mid -20Vto20V oV
Hysteresis Oto10V 30 mV
Edges Rise, Fall, Both Rise
Deskew Range

Max Value -249nsto 25 ns 1ns
Min Value -25.0nst0 24.9 ns -1ns
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Data Logging Parameters

The application includes the following Log menus:
m  Statistics
B Measurement

B Worst Case

Table 69: Logging parameters

Option Parameters Default

Statistics

Select Target Measurements Set, Clear Set

Log Statistics Off, On Off

File Name Browser C:\TekApplications\DPO-
JET\Logs\Statistics

Measurement

Select Target Measurements Set, Clear Set

Log Measurements Off, On off

Folder Browser C:\TekApplications\DPO-
JET\Logs\Measurements

Worst Case

Select Target Measurements Set, Clear Set

Log Worst Case Waveforms Off, On Off

Folder Browser C:\TekApplications\DPO-

JET\Logs\Waveforms

Control Panel Parameters
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The Control Panel menu includes the following command buttons:
m Clear

® Recalc

® Single

= Run

® Show Plots

NOTE. Show Plots appears in the control panel only when one or more plots are selected.
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Bit Config Parameters

The Eye configure menu has the following parameters

Bit Config Parameters

Option Parameters Default setting
Bit Type All Bits, Transition, Non-Transition All Bits
Mask * Browser C:\TekApplications\DPO-
JET\Masks

Measure the Center of the Bit t 110 100% 1%
Method Mean, Mode Mean
*  The Mask selector is available only for Mask Hits measurement.
T Available only for High, Low and High-Low measurements.

Edges Parameters
The Edges configure menu depends on the measurement selected.
Edges-Two Source Parameters
Option Parameters Default setting
Clock Edge Rise, Fall, Both Rise
Data Edge Rise, Fall, Both Both
Edges-Phase Noise Parameters
Option Parameters Default setting
Active Edge Rise, Fall, Both Rise
Noise Integration Limits
Upper Frequency 0to1T 1 MHz
Lower Frequency 0to1T 0 Hz
Edges-CrossOver Parameters
Option Parameters Default setting
Main Edge Rise, Fall, Both Both
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Edges-TIE Parameters

Clock Recovery Parameters

Option Parameters Default setting
Signal Type Clock, Data, Auto Auto

Clock Edge Rise, Fall, Both Rise
Edges-Skew Parameters

Option Parameters Default setting
From Edge Rise, Fall, Both Both

To Edge Same as From, Opposite as From Same as From

Edges-N-Period Parameters

Option Parameters Default setting
Signal Type Clock, Data, Auto Auto

Clock Edge Rise, Fall, Both Rise

N= 1t0 1M 6

Edge Increment 1,10K 1
Edges-DCD Parameters

Option Parameters Default setting
Signal Type Clock, Data, Auto Auto

Clock Recovery Parameters
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The Clock recovery configure menu depends on the clock recovery method being selected.

PLL Clock Recovery Method Parameters

Option Parameters Default setting
PLL Standard BW
PLL Model Type |, Type Il Type |
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Option Parameters Default setting
Standard: b/s IBA2500 : 2.5G, PCI-E : 2.5G PCI-E : 2.5G

FC133 : 132.8M, FC266 :265.6M,

FC531: 531.2M, FC1063: 1.063G ,

FC2125:2.125G,

SerATAG1:1.5G, SerATAG2:3.0,

SerATAG3:6.0G

USB FS:12M, USB HS:480M

1394b S400b : 491.5M, 1394b S800b

: 983.0M, 1394b S1600b : 1.966G

GB Ethernet : 1.25G

100BaseT:125M

0C1:51.8M, OC3:155M, 0C12:622M,

0C48:2.488G,

FC4250:4.25G, FC8500:8.5G

PCI_E_GEN2: 5.0G,IBA_GEN2 :

5.0G

FBD1:3.2G, FBD2 : 4.0G, FBD3:

4.8G

XAUI: 3.125G, XAUI_GENZ2: 6.25G

SAS15:1.5G, SAS3: 3.0G, SAS6:

6.0G

RI0125 :1.25G, RI0250 :2.5G ,

RI03125 :3.125G
Damping * 05t02 700 m
Loop BW 1t02.5GHz 1.5 MHz
PLL Custom BW
PLL Model Type |, Type lI Type |
Loop BW 110 2.5 GHz 1.5 MHz
1 Enable only for Type Il PLL models.
Constant Clock Recovery Method Parameters
Option Parameters Default setting
Constant Clock-Mean
Auto Calc First Acq, Every Acq First Acq
Constant Clock-Median
Auto Calc First Acq, Every Acq First Acq
Constant Clock-Fixed
Clock Frequency 1 Hz to 25 GHz 2.5 GHz
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Explicit Clock Recovery Method Parameters

Clock Recovery Parameters

Option Parameters Default setting
Explicit Clock-Edge/Explicit Clock-PLL

Clock Source Ch1-Ch4, Ref1-Ref4, Math1-Math4 Ch2

Clock Edge Rise, Fall, Both Both

Clock Multiplier 10 10K 1

Advanced Clock Recovery Configuration Parameters

Option Parameters Default setting

PLL Custom BW/PLL Standard BW/ Constant Clock-Mean/Constant Clock-Median

Nominal Data Rate Off, On Off

Bit Rate 1 bls to 25 Gb/s 2.5bls

Known Data Pattern On, Off off

Pattern Filename Browse C:\TekApplications\DPO-
JET\Patterns

Explicit Clock: Edge

Nominal Clock Offset Relative to Data -1to1s 0s

Explicit Clock:PLL

PLL Method Type [ Type I Type |

Damping 05t02 700 m

Loop B/W 11t02.5GHz 1.5 MHz

Nominal Clock Offset Relative to Data -1to1s 0s
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RJDJ Analysis Parameters

The RJDJ configure menu has the following parameters:

Table 70: RJDJ analysis parameters

RJIDJ Analysis Parameters

Option Parameters Default setting
Data Signal Settings
Pattern Type Repeating, Arbitrary Repeating
Pattern Length * 2 Ul to 1M 2 Ul
Window Length t 2to 16 Ul 5 Ul
Population t 5 to 5000 100
Total Jitter Component
BER = 1E-?¢% 2 to 18 in whole numbers 12
*  Only for Repeating Patterns.
T Only for Arbitrary Patterns.
1 Only for TIE, TJ@BER and Width@BER measurements.
Filters Parameters
The Filter configure menu has the following parameters:
Table 71: Filters parameters
Option Parameters Default setting
High Pass (F1)
Filter Spec No Filter, 1st order, 2nd order, 31 order No Filter
Freq (F1) 1 Hz to 1000 GHz 1 KHz
Low Pass (F2)
Filter Spec No Filter, 1st order, 2nd order, 3rd order No Filter
Freq (F2) 1 Hz to 1000 GHz 1 KHz
Advanced Filter Configure Parameters
The Advanced Filter Configuration includes the following parameters:
Option Parameters Default setting
Ramp Time 0/F to 10/F 2IF
Blanking Time 0/F to 10/F 4/F

DPOIJET Jitter and Eye Diagram Analysis Tools

157



Parameters

General Parameters

The General configure menu has the following parameters:

Table 72: General parameters

Option

Parameters

General Parameters

Default setting

Measurement Range Limits

Off, On

Off

Maximum and minimum values vary for different measurements. For more details, refer to Measurement

Values.

Global Parameters

The Global configure menu has the following parameters:

Table 73: Global parameters

Option Parameter Default setting

Gating

Gating Off, Zoom, Cursors Off

Qualify

Qualify Off, On Off

Qualify With Logic

Source Ch1-Ch4, Ref1-Ref4, Math1-Math4 Ch1

Mid -20Vto20V ov

Hysteresis Oto10V 30 mV

Active High, Low High

Population

Population Off, On Off

Population Limit

Limits By Population, Acquisitions Acquisitions

Limit 1t02 31 1K

Stop Condition Each Measurement, Last Each Measurement
Measurement
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Histogram Plot Parameters

The Histogram plot has Autoset as the command button.

Histogram Plot Parameters

Option Parameters Default setting
Vertical Scale Log, Linear Linear
Number of Bins
Resolution 25, 50, 100, 250, 500 250
Horizontal Scale
Auto Scale Set, Clear Set
Center -1.00E+12 to 1.00E+12 1.00E-07
Span 1.00E-12 t0 1.00 E+12 4.00E-09
Eye Diagram Plot Parameters
The Eye Diagram plot has the following parameters:
Option Parameters Default setting
Mask On, Off Off
Browser C:\TekApplications\DPO-
JET\Masks
Horizontal Scale
Auto Scale Set, Clear Set
Resolution 2.00E-13 to 2.00E-08 1.00E-12
Spectrum Plot Parameters
The Spectrum plot has the following parameters:
Option Parameters Default setting
Vertical Scale Log, Linear Linear
Base -20t0 15 -15
Horizontal Scale Log, Linear Linear
Mode Normal, Average, Peak Hold Normal
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Time Trend Plot Parameters

The Time Trend plot has the following parameters:

Time Trend Plot Parameters

Option Parameters Default setting

Mode Vector, Bar Vector
Phase Noise Plot Parameters

The Phase Noise plot has the following parameters:

Option Parameters Default setting

Vertical Position

Baseline -200t0 0 -170
Bathtub Plot Parameters

The Bathtub plot has the following parameters:

Option Parameters Default setting

Vertical Scale Log, Linear Log

Minimum displayed BER= 1E-? 2t018" 14

Applicable for Log and Linear scale only.

Transfer Function Plot Parameters

The Transfer Function plot has the following parameters:

Option Parameters Default setting

Vertical Scale Log, Linear Log

Horizontal Scale Log, Linear Log

Mode Normal, Average Average

160

DPOIJET Jitter and Eye Diagram Analysis Tools



Reference Reports

Reports

The Reports menu has the following command buttons:

m  Save

m Save As

Option Parameters Default setting
Include Setup configuration Set, Clear Set

Include complete application Set, Clear Set
configuration

Include pass/fail results summary Set, Clear Set

Include detailed results Set, Clear Set

Include plot images Set, Clear Set

Auto increment report name if Set, Clear Set

duplicate

View report after generating Set, Clear Set

Report Name Browser C:\TekApplications\DPO-

JET\Reports

Progress Bar Status Messages

Function/Measurement module Status/Message Description
Autoset-Source Autoset VertAuto-Chx Vertical autoset for Chx is going on.
Autoset-Source Autoset HorizAuto-Chx Horizontal autoset for Chx is going on.

Autoset-Source Autoset

Zooming Horiz

Zooming the horizontal scale after
horizontal autoset.

Autoset-Ref Level Autoset RefAuto-Chx Reference level autoset for Chx is
going on.

Autoset-Ref Level Autoset RefAuto-Refx Reference level autoset for Refx is
going on.

Autoset-Ref Level Autoset RefAuto-Mathx Reference level autoset for Mathx is
going on.

Sequencing

Sequencing

Refers to the measurement
setup-edge extraction.

Measurement Name

Running the measurement specified
by name.
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Progress Bar Status Messages

Function/Measurement module Status/Message Description

Plots Plotting Plotting is started.
Bathtub Creating Bathtub plot.
Spectrum Creating spectrum plot.
Time Trend Creating time trend plot.
Histogram Creating Histogram plot.

Transfer Func

Creating Transfer Function plot.

Eye Mask Hits

Creating Eye Diagram plot.

Eye Height Creating Eye Diagram plot.
Data Array Creating Data Array plot.
Phase Noise Creating Phase noise plot.

Edge Extraction

Finding Edges

Extracting Edges from signal
waveform.

Clock Data Recovery Recovery Clk Clock and Data recovery.
Worst case logging Saving WC Wfm Logging the worst case waveform.
Trigger Slow Trigger Waiting for trigger/trigger not available.
Measurements Name Progress Bar Display

Amplitude High Low Ampl High-Low

Amplitude HighV Amp High

Amplitude LowV Ampl Low

CMV Common Mode

DCD DCD

DDJ DDJ

DiffXovrV V-Diff-Xovr

DJ DJ

DJdd DJ-36

EdgeExtractor Edge Extractor

EyeHeight Eye Height

EyeMaskHits Eye Mask Hits

EyeWidth Eye Width

EyeWidthBER Eye Width@BER

FallTime Fall Time

Frequency Freq

HighTime High Time

Hold Hold

LowTime Low Time

NegativeDutyCycle —Duty Cycle

NegativeDutyCycleCycle —-CC-Duty

NegativeWidth Neg Width

NPeriod N-Period
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Error Codes

Function/Measurement module Status/Message Description

PerCycleCycle CC-Period

Period Period

PhaseNoise Phase Noise

PJ PJ

PositiveDutyCycle +Duty Cycle

PositiveDutyCycleCycle +CC-Duty

PositiveWidth Pos Width

RiseTime Rise Time

RJ RJ

RJOd RJ-356

Setup Setup

Skew Skew

TIE TIE

T TJ@BER

TNTRatio T/nT Ratio

Code Description

W410 Number of edges are not sufficient for a measurement: Positive Width.

E1001 Vertical Autoset Failed: Signal on Source x has extreme offset.

E1002 Vertical Autoset Failed: Amplitude of Source x is too small.

E1003 Vertical Autoset Failed: Amplitude or DC offset of Source x is too high.

E1004 Vertical Autoset Failed: No signal on Source x.

E1005 Vertical Autoset Failed: Signal on Source x exceeds top of scale.

E1006 Vertical Autoset Failed: Signal on Source x exceeds bottom of scale.

E1007 Vertical Autoset Failed: Signal on Source x is clipped on top.

E1008 Vertical Autoset Failed: Signal on Source x is clipped on bottom.

E1009 Vertical Autoset Failed: Measurement error ( ISDB error code = 6 ) on Source x.

E1010 Vertical Autoset Failed: Measurement error ( ISDB error code =7 ) on Source x.

W1011 A change to Source x vertical settings caused overload disconnect. Original settings
are restored and Source x is reconnected. Ignore oscilloscope message.

E1012 Vertical Autoset Failed: None of the selected measurements use live sources
(Ch1-Ch4). Horizontal autoset works for live sources only.

E1013 Vertical Autoset Failed: Invalid signal on Source x.

E1020 Horizontal Autoset Failed: None of the selected measurements use live sources
(Ch1-Ch4). Horizontal autoset works for live sources only.

E1021 Horizontal Autoset Failed: On Source x, cannot determine resolution of rising/falling

edges.
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Error Codes

Code Description

E1022 Horizontal Autoset Failed: Horizontal resolution is at the maximum.

E1035 Oscilloscope has gone into invalid state. Please restart the system.

E1040 Autoset Failed: None of the live sources (Ch1-Ch4) selected.

W1051 Ref Level Autoset: Waveform for the source x is clipped.

W1053 Ref Level Autoset: Source amplitude is extremely low.

E1054 Ref Level Autoset: Error in setting reference levels.

E1055 Ref Level Autoset Failed: No waveform to measure.

E1056 Ref Level Autoset: Unstable Histogram for waveform on source x.

E1057 Ref Level Autoset: No selected source.

E1058 Ref Level Autoset Failed: Invalid signal on source x.

E1059 Ref Level Autoset Error: Source x is not defined.

E2002 All the refs are used as sources by the measurements. Export to Ref is not possible.

E2003 Ref X’ is already used as a measurement source.

E2004 Ref X’ is already used as a destination for other measurement.

E2005 No measurement(s) are selected. Export to Ref is not possible.

E2006 No results available to export to ref.

E2007 There are no time trend results for the selected measurement(s).

E2008 No ref destination is selected. Results will not be exported to ref.

E3001 Could not open or create a log file. Please ensure that you have read/write permission
to access log folders and files.

E3002 The specified path is invalid (for example: The specified path is not mapped to a drive).

E3003 The specified path, file name or both exceed the system defined length. For Example:
On Windows-based platforms, the path name must be less than 248 characters and file
names less than 260 characters.

E3004 The specified path directory is read-only or is not empty.

E3005 Please ensure that the file is currently not in use by other process and/or has not
exceeded the file size limit.

E3006 Invalid filename: Check whether the file name contains a colon (:) in the middle of
the string.

E3007 Select at least one measurement from the table before you save.

E3008 There are currently no results to save. Please run a measurement.

E3010 Access to file/directory denied. Please ensure that the file/directory has read/write
permissions.

E3011 Mask Hits Measurements will not be selected as this feature is not available for Mask
Hits measurement.

E3012 Folder does not exist.

E4000 Not enough data points. Unable to render plot(s).

E4001 Out of memory. Please remove a measurement and try again.

E4002 Not enough data points for spectrum computation.

E4003 Low Memory. The entire waveform was not processed and the measurement results

are for part of the waveform.
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Measurement Values

Code Description

E4004 Edge Extraction failure.

E4005 Qualifier: Horizontal parameters do not match across waveforms.

W4006 A maximum of 10 qualifier zones are supported. The entire waveform will not be

processed and hence partial measurement results are available.

Measurement Values

The following table lists the maximum and minimum values of all measurements:

Measurement Range Limits (Max) Measurement Range Limits (Min)

Name

Default

Max Min Default Max Min

Period/Freq measurements

Period 1 ms 1ks 0ns Ons 1 ks Ons
CC-Period 1ns 1s 1fs -1ns -1fs -1s
Freq 10GHz 50GHz 1 MHz 10 KHz 50 GHz 1 MHz
N-Period 1ms 1 ks 0ns 0ns 1ks 0ns
Pos Width/ 10 ns 1 Ms 1ps 1ns 1 Ms 1ps
Neg Width

+Duty 90 % 100 % 0% 10 % 100 % 0%
Cycle/-Duty

Cycle

+CC-Duty/ 1ns 1 ks -1ks -1ns 1 ks -1ks
—CC—-Duty

Jitter Measurements

TIE 1ns 1 s -1 us -1ns 1 s -1 us
RJ 1ns 1 s 0ns 1ns 1 s Ons
RJ-86 1ns 1 s Ons 0ns 1 s 0ns
TJ 1ns 1 s 0ns 0 ns 1 us Ons
DJ 1ns 1 s 0ns 0 ns 1 s Ons
DJ-86 1ns 1 s Ons 0ns 1 s 0ns
Phase Noise 1 ms 1ms 0s 0s 1ms 0s
DCD 1ns 1 s 0ns 0 ns 1 s Ons
DDJ 1ns 1 us 0ns 0 ns 1 us Ons
PJ 1ns 1 s Ons 0ns 1 s Ons
Time Measurements

Rise Time 200 ns 1 ks 0ns 0s 1 ks Ons
Setup 10 ns 1s -1s 0ns 1s -1s
High Time 10 ns 1 Ms 1ps 0s 1 Ms 1ps
Fall Time 200 ns 1ks 0ns 0s 1ks 0ns
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Measurement Range Limits (Max) Measurement Range Limits (Min)

Hold 10 ns 1s -1s 0 ns 1s -1s
Low Time 10 ns 1 Ms 1ps 0s 1 Ms 1ps
Skew 10 ns 1s -1s -10ns 1s -1s
Eye Measurements
Height 500 mV 1kV 0mv 50 mVv 1kV 0mv
Width 1ns 1s 0ps 50 ps 1s 0ps
Mask Hits 500 Hits 1 MHit 0 Hits 0 Hits 1 MHit 0 Hits
Width@BER 0.9 Ul 1.0 Ul 0 Ul 0.1 Ul 1.0 Ul 0 Ul
Amplitude Measurements
Common 500 mV 10V -10V -500 mV 10V -10V
Mode
High 500 mV 10V -10V -500 mV 10V -10V
T/nt-Ratio 8 dB 12 dB -12dB 0dB 12 dB -12dB
High-Low 500 mV 10V -10V -500 mV 10V -10V
Low 500 mVv 10V -10V -500 mV 10V -10V
V-Diff-Xovr 500 mV 10V -10V -500 mV 10V -10V

About Algorithms

The DPOJET application can take measurements from one or two waveforms. The number of waveforms
used by the application depends on the type of measurement being taken.

Oscilloscope Setup Guidelines

For all measurements, use the following guidelines to set up the oscilloscope:

1. The signal is any channel, reference, or math waveform.

2. The vertical scale for the waveform must be set so that the waveform does not exceed the vertical

range of the oscilloscope.

3. The sample rate must be set to capture sufficient waveform detail and avoid aliasing.

4. Longer record lengths increase measurement accuracy but the oscilloscope takes longer to measure

each waveform.

Period

166

If the Signal Type is Clock

The Period measurement calculates the duration of a cycle as defined by a start and a stop edge. Edges
are defined by polarity, threshold, and hysteresis. The application calculates clock period measurement

using the following equation:
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PC&J:.'R- =T
]

Where:
PClock is the clock period.

T is the VRefMid crossing time for the selected polarity.

If the Signal Type is Data

The Period measurement calculates the duration of a Unit Interval. The application calculates this
measurement using the following equation:

PP =T =T/ K,

Where:
PData js the data period.
TData ig the VRefMid crossing time in either direction.

K,=C,—C,_is the estimated number of unit intervals between two successive edges. C, is the calculated
data bit index of T, Data,

Each measurement result P, Data is repeated K, times in the measurement result vector, so that the
measurement population is equal to the number of unit intervals in the qualified waveform, rather than the
number of edge pairs.

Positive and Negative Width

Amount of time the waveform remains above/below the mid reference voltage level.

The application calculates these measurements using the following equations:

WI’: = T:d_ - T?:-
Wﬁ_ = T:: - T?!_
Where:

W+ is the positive pulse width.
W— is the negative pulse width.
T— is the VRefMid crossing on the falling edge.
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T+ is the VRefMid crossing on the rising edge.

Frequency

Frequency measurement calculates the inverse of the data period for each cycle.

If the Signal Type is Clock

The application calculates clock frequency measurement using the following equation:

FHCE:':-'R- =1/ aﬂcx’k

Where:
FClock is the clock frequency.

PClock i the clock period measurement.

If the Signal Type is Data

The application calculates data frequency measurement using the following equation:
Fxﬂﬂm =17 P;ihm
Where:

FData ig the data frequency.

PData ig the data period measurement.
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N-Period

If the Signal Type is Clock

The N—Period measurement calculates the elapsed time for N consecutive crossings of the mid reference
voltage level in the direction specified.

The application calculates this measurement using the following equation:
W(:TOE}C _ gllock TC‘?ack

n o tnt N N
Where:

NPClock ig the accumulated period for N clock cycles.

TClock is the VRefMid crossing time for the selected edge polarity.

If the Signal Type is Data
The N—Period measurement calculates the elapsed time for N consecutive unit intervals.
The application calculates this measurement using the following equation:

Dt o Dt Dty
NE™ =1 .w —1,

Where:
NPData is the duration for N unit intervals.
TData ig the VRefMid crossing time in either direction.

If T,,+pPata does not exist for a given n, no measurement is recorded for that position.
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Positive and Negative Duty Cycle

The +Duty Cycle and —Duty Cycle measurements calculate the ratio of the positive (or negative) portion of
the cycle relative to the period.

The application calculates these measurements using the following equations:

Y = H.-,;+ faﬂbck

»
D; =W, (B

Where:

D+ is the positive duty cycle.
D— is the negative duty cycle.
W+ is the positive pulse width.
W— is the negative pulse width.

PClock is the period.

Related Topics
B Period

E Positive and Negative Width

CC-Period

The CC—Period measurement calculates the difference in period measurements from one cycle to the next.

The application calculates CC—Period measurement using the following equation:

Al =PC&J¢F} _Plﬁﬁ'ﬂ.‘;

u+l

Where:
AP is the difference between adjacent periods.

P Clock is the clock period measurement.

170 DPOIJET Jitter and Eye Diagram Analysis Tools



Algorithms Positive and Negative CC Duty

Positive and Negative CC Duty

The + CC— Duty and — CC—Duty measurements calculate the difference in positive (or negative) pulse
widths from one cycle to the next.

The application calculates these measurements using the following equations:

AW} = AW, - A,
AW = A, = AW

Where:

AW+ is the difference between positive pulse widths of adjacent clock cycles.
AW— is the difference between negative pulse widths of adjacent clock cycles.
W+ is the positive pulse width measurement.

W— is the negative pulse width measurement.

TIE

TIE (Time Interval Error) is the difference in time between an edge in the source waveform and the
corresponding edge in a reference clock. The reference clock is usually determined by a clock recovery
process performed on the source waveform. For Explicit-Clock clock recovery, the process is performed
on an explicitly identified source.

If the Signal Type is Clock

The application calculates Clock TIE measurement using the following equation:

TIECS:M.‘:- - Tﬁc?c-'.‘:- - Bk

Where:
TIEClock is the clock time interval error.
T Clock s the VRefMid crossing time for the specified clock edge.

T Clock is the corresponding edge time for the specified reference clock.

If the Signal Type is Data

The application calculates Data TIE measurement using the following equation:
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RJ

TIEP# = JPaa _ b

Where:

TIEData ig the data time interval error.

T Dawa is the VRefMid crossing time in either direction.

T 'Data ig the corresponding edge time for the specified reference clock.

The subscript k is used to indicate that there is one measurement per Unit Interval, rather than one
measurement per actual edge.

Random Jitter (RJ) is the rms magnitude of all timing errors not exhibiting deterministic behavior. A single
RJ value is determined for each acquisition, by means of RJ/DJ separation analysis.

Related Topics
B Jitter Analysis Through RJDJ Separation

Dual Dirac Random Jitter

Dual Dirac Random Jitter (RJ-39) is the rms magnitude of all timing errors not exhibiting deterministic
behavior, calculated based on a simplifying assumption that the histogram of all deterministic jitter can
modeled as a pair of equal-magnitude dirac functions (impulses). A single RJ-86 value is determined for
each acquisition, by means of RJ/DJ separation analysis.

Related Topics
B Jitter Analysis Through RJDJ Separation
® Jitter Estimation Using Dual-Dirac Models

Jitter Summary

172

The Jitter Summary is not a single measurement. The Jitter Summary button on the graphical user interface
simply creates one each of all the other jitter measurements, as a convenience. This convenience function
is not supported via the programmable interface.
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TJ@BER

DJ

Total Jitter at a specified Bit Error Rate (BER). This extrapolated value predicts a peak-to-peak jitter that
will only be exceeded with a probability equal to the BER. It is generally not equal to the total jitter
actually observed in any given acquisition. A single TI@BER value is determined for each acquisition, by
means of RJ/DJ separation analysis.

Related Topics
m Jitter Analysis Through RJDJ Separation
®  Estimation of TIBER and Eye WidthBER

Deterministic Jitter (DJ) is the peak-to-peak amplitude for all timing errors that follow deterministic
behavior. A single DJ value is determined for each acquisition, by means of RJ/DJ separation analysis.

Related Topics
m Jitter Analysis Through RJDJ Separation

Dual Dirac Deterministic Jitter

Dual Dirac Deterministic Jitter (DJ-80) the peak-to-peak magnitude for all timing errors exhibiting
deterministic behavior, calculated based on a simplifying assumption that the histogram of all deterministic
jitter can modeled as a pair of equal magnitude dirac functions (impulses). A single DJ-8d value is
determined for each acquisition, by means of RJ/DJseparation analysis.

Related Topics
® Jitter Analysis Through RJDJ Separation

m Jitter Estimation Using Dual-Dirac Models
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Phase Noise

PJ

DDJ

174

The Phase Noise measurement performs a jitter measurement, converts the result into the frequency
domain, and reports the rms jitter integrated between two specific frequencies selected by the user.

The phase noise measurement is defined only for clock signals. If the source waveform appears to be a
data signal, a warning message will be produced but the measurement will proceed.

A Phase Noise measurement is required in order to enable the Phase Noise plot.

Periodic Jitter (PJ) is the peak-to-peak amplitude for that portion of the deterministic jitter which is
periodic, but for which the period is not correlated with any data pattern in the waveform. A single PJ
value is determined for each acquisition, by means of RJ/DJ separation analysis.

Related Topics
B Jitter Analysis Through RJDJ Separation

Data-Dependent Jitter (DDJ) is the peak-to-peak amplitude for that portion of the deterministic jitter
directly correlated with the data pattern in the waveform. A single DDJ value is determined for each
acquisition, by means of RJ/DJ separation analysis.

Related Topics
m Jitter Analysis Through RJDJ Separation
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DCD

Duty Cycle Distortion (DCD) is the peak-to-peak amplitude for that portion of the deterministic jitter
directly correlated with signal polarity, that is the difference between the mean positive edge displacement
versus that on negative edges. A single DCD value is determined for each acquisition, by means of
RIJ/DJ separation analysis.

Related Topics
m Jitter Analysis Through RJDJ Separation
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Rise Time

The Rise Time measurement is the time difference between when the VRefHi reference level is crossed
and the VRefLo reference level is crossed on the rising edge of the waveform. The Rise Time algorithm
uses the VRef values as the reference voltage level. Each edge is defined by the slope, voltage reference
level (threshold), and hysteresis.

The application calculates this measurement using the following equation:

Risg _ o H+y _ rlov
L= -1

Where:
T Rise is the Rise Time.
T Hi+ is the VRefHi crossing on the rising edge.

T Lo+ is the VRefLo crossing on the rising edge.

Fall Time

The Fall Time measurement is the time difference between when the VRefLo reference level is crossed
and the VRefHi reference level is crossed on the falling edge of the waveform. The Fall Time algorithm
uses the VRef values as the reference voltage level. Each edge is defined by the slope, voltage reference
level (threshold), and hysteresis.

The application calculates this measurement using the following equation:

TF:-:.E.-: - TL:J— _ TH—

Where:

T Fall is the Fall Time.

T Lo- is the VRefLo crossing on the falling edge.
T Hi- is the VRefHi crossing on the falling edge.
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Skew

The Skew measurement calculates the difference in time between the designated edge on a principle
waveform to the designated edge on another waveform. The closest data edge to the clock edge that falls
within the range limits is used.

The application calculates this measurement using the following equation:

T.S.‘:E'W =Tm _Tﬂ?&f

Where:
T Skew ig the timing skew.
T Main ig the Main input VRefMidMain crossing time in the specified direction.

T 2nd is the 2nd input VRefMid2nd crossing time in the specified direction.

High Time

The High Time Measurement is the amount of time that a waveform cycle is above the VRefHi voltage
reference level.

The application calculates the measurement using the following equation:

T;!—.ig.& _ T;!—.E— _Tx.m

Where:
T High is the high time.
T Hi- is the VRefHi crossing on the falling edge.

T Hi*+ is the VRefHi crossing on the rising edge.
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Low Time

The Low Time measurement is the amount of time that a waveform cycle is below the VReflLo voltage
reference level.

The application calculates this measurement using the following equation:

TL::'W - TL:H _ TL::'—

Where:
T Low is the low time.
T Lo+ is the VRefLo crossing on the rising edge.

T Lo- is the VRefLo crossing on the falling edge.

Setup

The Setup Time measurement is the elapsed time between the designated edge of a data waveform and
when the clock waveform crosses its own voltage reference level. The closest data edge to the clock edge
that falls within the range limits is used.

The application calculates this measurement using the following equation:

Sety _ rehbin _ ednd
L= e

Where:
T Sewp is the setup time.
T Main js the Main input (clock) VRefMidMain crossing time in the specified direction.

T 2nd is the 2nd input (data) VRefMid2nd crossing time in the specified direction.
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Hold

The Hold Time measurement is the elapsed time between when the clock waveform crosses its own
voltage reference level and the designated edge of a data waveform. The closest data edge to the clock
edge that falls within the range limits is used.

The application calculates this measurement using the following equation:

T;I:EJH = Tﬂf?dd’ _-Enifxﬂ!?d

Where:

T Hold ig the hold time.

T Mainjg the Main input (clock) VRefMidMain crossing time in the specified direction.
T 2nd i the 2nd input (data) VRefMid2nd crossing time in the specified direction.

Eye Width

The Eye Width measurement is the measured minimum horizontal eye opening at the zero reference level.

The application calculates this measurement using the following equation:

Tove _wimrsr = Ul gy — T g

Where:
Ul is the average UL
TIE, is the Peak-Peak TIE.

Width@BER

Width@BER is the Eye Width at a specified Bit Error Rate (BER). This extrapolated value predicts a
horizontal eye opening that will be violated with a probability equal to the BER. It is generally not equal to
the eye width actually observed in any given acquisition. A single Width@BER value is determined for
each acquisition, by means of RJ/DJ separation analysis.

Related Topics
® Jitter Analysis Through RJDJ Separation
®  Estimation of TJ@BER and Eye Width@BER
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Eye Height

The Eye Height measurement is the measured minimum vertical eye opening at the UI center as shown in
the plot of the eye diagram. There are three types of Eye Height values.

The application calculates this measurement using the following equation:

VF}'F—JEFJ‘GH = VF}'F—HI—W - P;‘PF—ID—M

Where:
Veveury 1s the minimum of the High voltage at mid UL

TIEEye 10-max 18 the maximum of the Low voltage at mid UL

Eye Height-Transition

The application calculates this measurement using the following equation:
Vevm_ mimar-rean = ¥ FYe- AE-TRAV-MIY T ¥ BV 10_TRAN-MAX
Where:

Veveurtran-aay 18 the minimum of the High transition bit eye voltage at mid UL

TIEeyve-10-tRan-max 1S the maximum of the Low transition bit eye voltage at mid UL

Eye Height-Non-Transition

The application calculates this measurement using the following equation:
Y BYF EEIGHT-NTRAN ¥ BYP- BI-NTRAN-MIY ¥ BYE_0-NTRAN-MAX
Where:

Veve-mntravav 18 the minimum of the High non- transition bit eye voltage at mid UL

TIEgve rontrav-max 1S the maximum of the Low non-transition bit eye voltage at mid UI.
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Mask Hits

The Mask Hits measurement reports the number of unit intervals in the acquisition for which mask hits
occurred, for a user-specified mask. In the Results Summary view, the Mask Hits measurement reports
the total number of unit intervals for which a mask hit occurred in at least one mask zone. In the Results
Details view, the number of hits in each of three segments is reported. The population field shows the
total number of unit intervals measured.

The Mask Hits measurement has several unique properties:

B Unlike other measurements, it requires a Mask hits plot. Adding a Mask Hits measurement will cause
the corresponding plot to be created automatically. If you delete a Mask Hits plot, the application will
remove the corresponding Mask Hits measurement after verifying the action with you.

B The Mask Hits measurement does not support the Worst-Case Waveforms logging feature.

m The Mask Hits measurement does not support Measurement Range Limits.
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High

Low
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The High Amplitude measurement calculates the mean or mode of a selected portion of each unit interval
corresponding to a “1” bit.

The application calculates this measurement using the following equation:

Vign)=0OP [‘“'PERCEM (n }]

Where:
Vyr is the high amplitude measurement result.
OP/[* ] is the selected Operation (either Mean or Mode).

v percent 18 the set of voltage samples over the selected portion (percent) of the unit interval, ranging
from 1% to 100%.

n is the index of a high bit, a high transition bit, or a high non-transition bit.

The Low Amplitude measurement calculates the mean or mode of a selected portion of each unit interval
corresponding to a “0” bit.

The application calculates this measurement using the following equation:

Vigln) = OP[”PERCEM(H }]

Where:
Viow 1s the low amplitude measurement result.
OP/[* ] is the selected Operation (either Mean or Mode).

v percenr 18 the set of voltage samples over the selected portion (percent) of the unit interval, ranging
from 1% to 100%.

n is the index of a low bit, a low transition bit, or a low non-transition bit.
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Common Mode

The Common Mode Voltage measurement (also called DC Common Mode) calculates the mean of the
Common Mode voltage waveform.

The application calculates this measurement using the following equation:

Foage = Mean (v, (7))

Where:

Vew 1s the common mode voltage measurement.

—_ (vSourcel + VSource 2)
Vowe =
2

is the common mode voltage waveform.

i is the sample index of common mode waveform values.

T/nT Ratio

The T/nT Ratio measurement reports the amplitude ratio between transition and non-transition bits.

The measurement calculates the ratios of all non-transition eye voltages (2nd and subsequent eye voltages
after one edge but before the next) to their nearest preceding transition eye voltage (1st eye voltage
succeeding an edge). In the accompanying diagram, it is the ratio of the Black voltages to the Blue
voltages. The results are given in dB.

Voltage Recovered edge times

i P S

3 »=Time

The application calculates the T/nT Ratio using the following equations:
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TnT(m) = dB Vors_ urrean (72

Veye  H1- Tran (F2)

following a rising edge.

TnT(m)=dB Verg o nrran U7)

Vere- 1o Trantt)

following a falling edge.
Where:

veve-nr-tray 1S the High voltage at the interpolated midpoint of the first unit interval following a positive
transition.

vevero-trav 18 the Low voltage at the interpolated midpoint of the first unit interval following a negative
transition.

veve-mntran 18 the High voltage at the interpolated midpoint of all unit intervals except the first following a
positive transition.

Veve-Lo-vtran 1S the Low voltage at the interpolated midpoint of all unit intervals except the first following
a negative transition.

m is the index for all non-transition Uls.
n is the index for the nearest transition Ul preceding the Ul specified by m.

In a time trend plot of the measurement results, there is one measurement for each non-transition bit in the
waveform (that is the black arrows in the diagram).
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High-Low

The High—Low measurement calculates the change in voltage level across a transition in the waveform.

The application calculates the High—Low using the following equation:

Virar—row (1) = ’VLEVEL(I- ) —Vigg (i + 1)‘

Where:

Vincu.Low 1s the high-low amplitude measurement result.

n is the index of a selected transition.

i is the index of the UI (bit) location preceding the transition.

i+1 is the index of the UI (bit) location following the transition.

Vigver = OP[vpgrcenr(i)] 1s the state level of the unit interval (bit period).
OP/~ ] is the selected Operation (either Mean or Mode).

vesrcent 18 the set of voltage samples over the selected portion (percent) of the unit interval, ranging
from 1% to 100%.

NOTE. If there are no waveform samples that fall within the identified percentage of the unit interval, the single
nearest waveform sample preceding the center point of the unit interval will be used.

V-Diff-Xovr

The Differential Crossover Voltage measurement (V—Diff—-Xovr) calculates the voltage level at the
crossover voltage of a differential signal pair. If there is timing jitter on one of the pair of signal lines
relative to the other, the crossover point will be modulated by the jitter. The measurement is calculated
using the following equation:

Crossovaey Souree 1 Crossovar
Y =V, )

Where:
JCrossover g the crossing voltage.
V Sourcelig the voltage of the first source waveform.

TCrossover ig the crossover time, when the Sourcel and Source2 waveforms are equal in voltage.
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Jitter Analysis Through RJ/DJ Separation

186

Many of the jitter measurements are based on the concept of RJ/DJ separation. The application begins with
the measured jitter-versus-time (as represented by the TIE measurement array) and analytically determines
the random and deterministic components of the jitter. The deterministic part is further separated into
independent subcomponents with specific characteristics.

The random jitter (RJ) is assumed to be zero-mean Gaussian, and is assumed to have a flat spectrum when
viewed in the frequency domain. The measured R1J is fitted to a Gaussian mathematical model, which is
parameterized by its standard deviation. Using the mathematical model for RJ, statistically probable jitter
extremes may be predicted for much greater populations than actually measured.

The deterministic jitter (DJ) is predictable and can be generated consistently given known circumstances.
The various DJ measurements each report the peak-to-peak value of the corresponding DJ subcomponent.

Once all the jitter components have been identified and the random jitter has been converted to a
mathematical model, the components can be reassembled such that performance may be extrapolated

to extremely low bit error rates. The probabilistic Total Jitter (TJ@BER) and probabilistic Eye Width
(Width@BER) are examples of such measurements. The reported values are predictions that correspond to
a user-specified Bit Error Rate, rather than observed values.

Two approaches are supported for performing jitter separation. The first method is based on spectrum
analysis. It is only possible when the data pattern is repetitive. A clock waveform is always repetitive.
Other repetitive testing data patterns are used, such as the K28.5 data pattern. Patterns may have rather long
repetition lengths; for example, the CJTPAT pattern is 2640 bits. When using this method, you must specify
the pattern length, and you will receive a warning if the pattern length appears to differ from that specified.

The second RJ/DJ separation method, known as arbitrary pattern analysis, may be used when the data
pattern is not necessarily repetitive. This method works by correlating deterministic jitter observed over
many repetitions with the bit pattern within a time-domain window surrounding each observation.
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RJ/DJ Separation via Spectrum Analysis

When the source waveform represents a repeating data pattern, Deterministic Jitter (DJ) has a frequency
spectrum of impulses. The impulses due to the data pattern are equally spaced and occur at predictable
frequencies related to the pattern length and bit rate. Specifically, the pattern-related jitter impulse must
occur at multiples of f,/N, where f, is the data bit rate and N is the data pattern length. Other spectral
impulses may occur due to periodic jitter not correlated with the data pattern.

To obtain measurements of DJ and RJ, all the components of the jitter spectrum that exceed the noise floor
by a chosen margin are attributed to deterministic jitter. Those components that fall at the frequency
increment corresponding to the pattern length are identified as data-dependent jitter, and those occurring
at other frequencies are attributed to uncorrelated periodic jitter. The remaining spectral noise floor
(appropriately normalized to account for the removed deterministic jitter) is integrated to predict the
standard deviation of the underlying Gaussian random noise process.

Once the spectral components corresponding to each deterministic jitter type have been identified, each
component is inverse-transformed back to the time domain. From these waveforms, the peak-to-peak jitter
for each component is determined. For the random jitter, the RMS deviation is directly computable

from the standard deviation of the Gaussian model.

RJ/DJ Separation for Arbitrary Patterns

When the data pattern borne by the source waveform is not cyclically repeating, any periodic jitter still has
a frequency spectrum consisting of impulses but this is not true of the data-dependent jitter.

In this case, analysis of the data-dependent jitter may proceed based on the assumption that any given
bit is affected by a finite (and relatively small) number of preceding bits. By averaging all events for
which a given bit is preceded by a particular bit sequence, the data-dependent jitter attributable to that
bit sequence is obtained. This is because PJ and RJ are not correlated to a particular data sequence and
thus are averaged out.

If each bit is assumed to be affected by N preceding bits, there are a total of 2N possible data sequences.
The sequence length N is a configurable parameter. To get statistically sound average values for the
data-dependent jitter, a minimum population of observations is required for each individual pattern that
occurs at least once. This population limit is also configurable by the user.

By the above means, the data-dependent jitter is characterized. Once characterized, the data-dependent
jitter, on a bit-by-bit basis, may be removed from the original jitter versus time record. The remaining
jitter is composed of periodic and random jitter. This jitter is transformed into the frequency domain,
and the spectral analysis approach is used to separate the impulsive periodic jitter from the broad noise
floor of random jitter.
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Estimation of TJ@BER and Eye Width@BER

One of the outcomes of the RJ/DJ separation was a mathematical model for random jitter’s probability
density function (PDF) and measured values for the PDFs of the deterministic jitter components. Since
all of these components are assumed to be statistically independent, the PDF of the total jitter can be
calculated by convolution.

Integration of the PDF yields the cumulative distribution function (CDF), which can then be used to create
the bit error rate curve (bathtub curve). Based on the bathtub curve, the eye opening (Width@BER) and
eye closure (TJ@BER) can be estimated for a given bit error rate.

The application calculates the eye opening at the specified BER using the following equation:

Eye opening = I-TJ@BER when TJ@BER is less than one Unit Interval

Eye opening = 0 when TJ@BER exceeds one Unit Interval

Jitter Estimation Using Dual-Dirac Models

188

Jitter estimation based on RJ/DJ separation depends in part on the specific jitter components modeled.
For the purposes of analyzing jitter and identifying root cause, it is very useful to identify components
as specifically as possible. But for the purposes of determining compliance, it has been found that a
simplified jitter model yields results that are more consistent across different measurement instruments
and different vendors.

A simplified model that has found acceptance in several industry standards is known as the Dual-Dirac
model. This is because the probability density function (PDF) of all the deterministic jitter is replaced
with a PDF consisting of two Dirac functions such that the total jitter and eye opening at very low bit
error rates is unchanged. The Random Jitter and Deterministic Jitter values derived from this model
are identified as RJ-0606 and DJ-09, respectively.

Two slightly different Dual-Dirac models have been defined. Both models begin with a jitter versus
BER (bathtub) curve, either created from a full jitter analysis based on RJ/DJ separation, or from direct
measurement of error rate versus sample point offset. The two models differ in how the RJ-66 and DJ-33
values are extracted from the curve.

For the Fibre-Channel standard, values for RJ-06 and DJ-66 are chosen such that the Dual-Dirac bathtub
curve exactly matches the measured curve at the BER = 10-5 and BER=10-% points.

For the PCI-Express and FB-DIMM standards, the bathtub curve is re-plotted using a different y-axis.
Instead of directly plotting against the log of the BER, the y-axis is converted to the Q-scale. The BER to
Q-scale transformation was designed such that Gaussian distributions are converted to straight lines, with a
slope that is directly related to the standard deviation of the Gaussian.

When using the Dual-Dirac jitter measurements, it is critical that you select the model that matches the
applicable standard. This may be configured in the DPOJET preferences, which are found under Analyze
> Jitter and Eye Analysis > Preferences, on the Measurement tab.
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Results

The application calculates statistics for all selected measurements. The application displays the following
statistics in the Results menu:

= Mean

B Std Dev (Standard Deviation)

B Max (Maximum Value)

B Min (Minimum Value)

B p-p (Peak-to-Peak)

®  Population

m Max-cc (Maximum positive cycle-to-cycle variation)

B Min-cc (Maximum negative cycle-to-cycle variation)

Mean

The application calculates the mean value using the following equation:

— 1 X
Mean(X=X=—MX%
0-%-L3x,

H=1

Standard Deviation

The application calculates the standard deviation using the following equation:

1 2T

X-X)*
(N-D;{ )

mtdDev( X)) =y = \/

It may seem odd that the equation for the estimate of the Standard Deviation contains a 1/(N-1) scaling

factor. If you knew the true mean of X and used it in place of the estimated mean X then you would, in fact,
scale by 1/N. But, Xis an estimate and is likely to be in error (or bias), causing the estimate of the Standard
Deviation to be too small if scaled by 1/N. This is the reason for the scaling shown in the equation. (Refer to
Chapter 9.2 in A. Papoulis, Probability, Random Variables, and Stochastic Processes, McGraw Hill, 1991.)

NOTE. RMS value can be calculated using the relation (rms)2= (mean value)2+ (stddev)?
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Maximum Value
The application calculates maximum value using the following equation:

Max(X) = Most Positive Value of X

Minimum Value
The application calculates minimum value using the following equation:

Min(X) = Most Negative Value of X

p-p
The application calculates peak-to-peak using the following equation:

p-p(X) = Max(X )— Min(X)

Population
Population is the total number of events or observations over which the other statistics were calculated.

Population (X) =N

Max-cc

The application calculates Max-cc using the following equation:
Max-cc(X) = Max(Xcc )

Where:

Xcc 1s the first difference of X.

Aon =&, &

Min-cc

The application calculates Min-cc using the following equation:
Min-cc(X) = Min(Xcc )

Where:

Xcc is the first difference of X.

Hop =Xy — Xy
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About the GPIB Program

You can use remote GPIB commands to communicate with the DPOJET application. An example
of a GPIB program that can execute the DPOJET application is included with the application in
C:\TekApplications\DPOJET\Examples.

The example shows how a GPIB program executes the application to do the following tasks:
1. Start the application.

Recall a setup.

Take a measurement.

View measurement results and plots.

o wN

Exit the application.

NOTE. Commands are not case and space sensitive. Your program will operate correctly even if you do not follow the
capitalization and spacing precisely.

GPIB Reference Materials

To use GPIB commands with your oscilloscope, you can refer to the following materials:

B The GPIB Program Example in C:\TekAppTications\DPOJET\ExampTles for guidelines to use
while designing a GPIB program.

B The Parameters topics for range of values, minimum units and default values of parameters.

®  The programmer information in the online help of your oscilloscope.
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Argument Types

The syntax shows the format that the instrument returns in response to a query. This is also the preferred
format when sending the command to the instrument though any of the formats will be accepted. This
documentation represents these arguments as follows:

Table 74: Argument types

Symbol Meaning

<NR1> Signed integer value.

<NR2> Floating point value without an exponent.
<NR3> Floating point value with an exponent.

DPOJET: ADDMeas

192

This set-only parameter adds the specified measurement to the bottom of the current DPOJET list of
measurements and will appear in the results summary page.

Syntax

DPOJET:ADDmeas {PERIod | CCPeriod | FREQuency | NPERiod | PwIdth | NwIdth |
PDUTY | NDUTy | PCCDuty | NCCDbuty | TIE | RJ | RIDirac | Tlber | DJ | DIDirac
| PHASENoise | DCD | DDJ | PJ | RISEtime | SETup | HIGHTime | FALLtime | HOLD
| LOWTime | SKEW | HEIght | wIDth | MASKHits | WIDTHBer | COMmonmode | HIGH |
TNTratio | HIGHLOW | LOW | VDIFFxovr}

Arguments

Same as syntax for measurement options.

Outputs

NONE

DPOIJET Jitter and Eye Diagram Analysis Tools



GPIB Commands DPOJET:CLEARALILMeas

DPOJET:CLEARALLMeas

This set-only parameter clears the entire current list of defined measurements in DPOJET.

Syntax

DPOJET:CLEARALLMeas

Arguments

NONE

Outputs

NONE

DPOJET:STATE

Returns the current measurement state of DPOJET.

Syntax

DPOJET:STATE { RUN | SINGLE | RECALC | CLEAR | STOP }

Inputs

{ RUN | SINGLE | RECALC | CLEAR | STOP }

Outputs

The current state of the DPOJET measurement sequencer, including any of the possible inputs.
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DPOJET:LASTError?

Returns the contents of the last pop-up warning dialog box. It returns an empty string should no error have
occurred since startup, or since the last call to DPOJET:LASTError?.

Syntax

DPOJET:LASTError?

Inputs

STRING

DPOJET:MEAS<x>

Returns the branch query for the application measurement slot with index <x>. This will always match
the measurement defined at the associated index <x> displayed in the DPOJET screen, where index 1 is
the first, or top of the measurement list.

Branch queries will only contain the measurement branches for those branches which have measurements
defined. This is required because of the number of measurements that can be defined in DPOJET, is 99.

Syntax
DPOJET :MEAS<X>

DPOJET :MEAS<X>?

DPOJET:MEAS<x>:NAME?

194

Returns the measurement name for the measurement in slot x.

Syntax

DPOJET :MEAS<X>:NAME?

Outputs

String
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DPOJET:MEAS<x>:CUSTomname

This sets or queries the custom measurement name for the measurement in slot x.

Syntax

DPOJET :MEAS<X>:CUSTomname

Inputs

String

Outputs

String

DPOJET:MEAS<x>:MEASStart

Sets or queries the measurement start value.

Syntax

DPOJET :MEAS<X>:MEASStart

Inputs

<NR3>

Outputs

<NR1>
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DPOJET:MEAS<x>:EDGEiIncre

Sets or queries the measurement edge increment value.

Syntax

DPOJET :MEAS<X>:EDGEINcCre

Inputs

<NR3>

Outputs

<NR1>

DPOJET:MEAS<x>:N

Sets or queries the measurement N value.

Syntax

DPOJET :MEAS<X>:N

Inputs

<NR3>

Outputs

<NR1>
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DPOJET:MEAS<x>:SOUrce1

Sets or queries the Sourcel value.

Syntax

DPOJET :MEAS<X>:SOUrcel

Inputs

{CH1 - CH4, MATH1l - MATH4, REFl - REF4}

Outputs

{CH1 - CH4, MATH1 - MATH4, REF1 - REF4}

DPOJET:MEAS<x>:SO0Urce2

Sets or queries the Source2 value. May return NONE for single-source measurement.

Syntax

DPOJET:MEAS<X>:S0Urce?2

Inputs

{CH1 - CH4, MATH1 - MATH4, REF1l - REF4}

Outputs

{CH1 - CH4, MATH1l - MATH4, REF1l - REF4}
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DPOJET:MEAS<x>:EDGE1

Sets or queries the Sourcel edge type.

Syntax

DPOJET :MEAS<x>:EDGE1

Inputs

{RISe, FALL, BOTH}

Outputs

{RISe, FALL, BOTH}

DPOJET:MEAS<x>:EDGE2

Sets or queries the Source2 edge type.

Syntax

DPOJET :MEAS<X>: EDGE2

Inputs

{RISe, FALL, BOTH}

Outputs

{RISe, FALL, BOTH}

DPOJET:-MEAS<x>:EDGE1
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DPOJET:MEAS<x>:SIGNALType

Sets the signal type for various measurements.

Syntax

DPOJET :MEAS<X>:SIGNALTYype

Inputs

{CLOCK, DATA, or AUTO}

Outputs

{CLOCK, DATA, or AUTO}

DPOJET:MEAS<x>:TOEdge

Sets the TOEdge value for the measurement.

Syntax

DPOJET :MEAS<X>:TOEdge

Inputs

{SAMEas, OPPositeas}

Outputs

{SAMEas, OPPositeas}
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DPOJET:MEAS<x>:FROMedge

Sets the FROMedge value for the measurement.

Syntax

DPOJET :MEAS<x>: FROMedge

Inputs

{RISe, FALL, BOTH}

Outputs

{RISe, FALL, BOTH}

DPOJET:MEAS<x>:FILTers:RAMPtime

Sets or queries the current filter ramp time.

Syntax

DPOJET:MEAS<x>:FILTers:RAMPtime

Inputs

<NR3>

Outputs

<NR3>
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DPOJET:MEAS<x>:FILTers:BLANKingtime

Sets or queries the current filter blanking time.

Syntax

DPOJET:MEAS<X>:FILTers:BLANKingtime

Inputs

<NR3>

Outputs

<NR3>
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DPOJET:MEAS<x>:FILTers:HIGHPass:SPEC

Sets or queries the current high pass filter specification.

Syntax

DPOJET :MEAS<X>:FILTers:HIGHPass:SPEC {NONE, FIRST, SECOND, THIRD}

Inputs

{NONE, FIRST, SECOND, THIRD}

Outputs

{NONE, FIRST, SECOND, THIRD}

DPOJET:MEAS<x>:FILTers:HIGHPass:FREQ

Sets or queries the current high pass filter frequency.

Syntax

DPOJET:MEAS<X>:FILTers:HIGHPass:FREQ

Inputs

<NR3>

Outputs

<NR3>
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DPOJET:MEAS<x>:FlILTers:LOWPass:SPEC

Sets or queries the current low pass filter specification.

Syntax

DPOJET:MEAS<X>:FILTers:LOWPass:SPEC {NONE, FIRST, SECOND, THIRD}

Inputs

{NONE, FIRST, SECOND, THIRD}

Outputs

{NONE, FIRST, SECOND, THIRD}

DPOJET:MEAS<x>:FILTers:LOWPass:FREQ

Sets or queries the current low pass filter frequency.

Syntax

DPOJET:MEAS<X>:FILTers:LOWPass:FREQ

Inputs

<NR3>

Outputs

<NR3>
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DPOJET:MEAS<x>:RJDJ:BER

Sets or queries the current RJDJ BER value.

Syntax

DPOJET :MEAS<X>:RJDJ:BER

Inputs

<NR3>

Outputs

<NR3>

DPOJET:-MEAS<x>:RJDJ:TYPe

Sets or queries the current RJDJ measurement type.

Syntax

DPOJET :MEAS<X>:ENVIronment:RID]J:TYPe {ARBITrary, REPEating}

Inputs

{ARBitrary, REPEating}

Outputs

{ARBitrary, REPEating}
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DPOJET:MEAS<x>:RJDJ:PATLen

Sets or queries the current RJDJ pattern length.

Syntax

DPOJET :MEAS<X>:RJDJ :PATLen

Inputs

<NR3>

Outputs

<NR3>

DPOJET:MEAS<x>:RJDJ:WINDOwlength

Sets or queries the current RJDJ window length.

Syntax

DPOJET:MEAS<x>:RJDJ:WINDOwlength

Inputs

<NR3>

Outputs

<NR3>
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DPOJET:MEAS<x>:RJDJ:POPUlation

Sets or queries the current RJDJ population.

Syntax

DPOJET :MEAS<x>:RJIDJ:POPUlation

Inputs

<NR3>

Outputs

<NR3>

DPOJET:MEAS<x>:CLOCKRecovery:METHod

Sets or queries the current Clock recovery method.
Syntax
DPOJET :MEAS<x>:CLOCKRecovery:METHod {STANDARD, CUSTOM, CONSTMEAN, CONSTFIXED,

EXPEDGE, EXPPLL, CONSTMEDIAN }

Inputs

{STANDARD, CUSTOM, CONSTMEAN, CONSTFIXED, EXPEDGE, EXPPLL, CONSTMEDIAN}

Outputs

{STANDARD, CUSTOM, CONSTMEAN, CONSTFIXED, EXPEDGE, EXPPLL, CONSTMEDIAN}
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DPOJET:MEAS<x>:CLOCKRecovery:MODel

Sets or queries the current clock recovery model.

Syntax

DPOJET:MEAS<x>:CLOCKRecovery:MODel {ONE | TwoO}

Inputs

{ONE, TwO}

Outputs

{ONE, TwO}

DPOJET:MEAS<x>:CLOCKRecovery:STAndard

Sets or queries the current clock recovery standard, as specified in the user interface.

Syntax

DPOJET :MEAS<x>:CLOCKRecovery:STAndard

Inputs

String

Outputs

String
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DPOJET:MEAS<x>:CLOCKRecovery:DAMPing

Sets or queries the clock recovery damping value.

Syntax

DPOJET :MEAS<X>:CLOCKRecovery :DAMPing

Inputs

<NR3>

Outputs

<NR3>

DPOJET:MEAS<x>:CLOCKRecovery:LOOPBandwidth

Sets or queries the clock recovery loop bandwidth.

Syntax

DPOJET :MEAS<Xx>: CLOCKRecovery:LOOPBandwidth

Inputs

<NR3>

Outputs

<NR3>
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DPOJET:MEAS<x>:CLOCKRecovery:DATARate

Turns on or off the usage of DATArate.

Syntax

DPOJET :MEAS<X>:CLOCKRecovery:DATARate

Inputs
1/0

Outputs
1/0

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKBitrate

Sets or queries the clock bit rate. Used if DATARate is 1.

Syntax

DPOJET:MEAS<x>:ENVIronment:CLOCKRecovery:CLOCKBitrate

Inputs

<NR3>

Outputs

<NR3>
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DPOJET:MEAS<x>:CLOCKRecovery:CLOCKFrequency

Sets or queries the clock frequency. Used with Constant Clock - Fixed clock recovery method.

Syntax

DPOJET :MEAS<X>:ENVIronment:CLOCKRecovery:CLOCKFrequency

Inputs

<NR3>

Outputs

<NR3>

DPOJET:MEAS<x>:CLOCKRecovery:PATTern

Turns on or off the usage of CLOCKPath to specific a known data pattern.

Syntax

DPOJET :MEAS<X>:CLOCKRecovery:PATTern

Inputs
1/0

Outputs
1/0
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DPOJET:MEAS<x>:CLOCKRecovery:CLOCKPath

Sets or queries the current known clock pattern path.

Syntax

DPOJET :MEAS<X>:ENVIronment:CLOCKRecovery:CLOCKPath

Inputs

String

Outputs

String

DPOJET:MEAS<x>:CLOCKRecovery:MEANAUTOCalculate

Sets or queries how often the clock is calculated, either FIRST, or on EVERY acquisition.

Syntax

DPOJET :MEAS<x>:CLOCKRecovery:MEANAUTOCalculate

Inputs

{FIRST, EVERY}

Outputs

{FIRST, EVERY}
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DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset

Sets or queries the clock offset.

Syntax

DPOJET :MEAS<X>:CLOCKRecovery :NOMINALOFFset

Inputs

<NR3>

Outputs

<NR3>

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKMultiplier

Sets or queries the clock multiplier.

Syntax

DPOJET :MEAS<Xx>:CLOCKRecovery:CLOCKMultiplier

Inputs

<NR3>

Outputs

<NR3>
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DPOJET:MEAS<x>:BITType

Sets or queries the measurement bit type setting.

Syntax

DPOJET :MEAS<X>:BITType

Inputs

{ALLBits, NONTRANsition, TRANsition}

Outputs

{ALLBits, NONTRANsition, TRANsition}

DPOJET:MEAS<x>:BITPcnt

Sets or queries the percentage of the center of bit to measure.

Syntax

DPOJET:MEAS<X>:BITPcCnt

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands

DPOJET:MEAS<x>:BITCfgmethod

Sets or queries the measurement bit configure method.

Inputs

{MEAN, MODE}

Outputs

{MEAN, MODE}

DPOJET:MEAS<x>:MASKfile

214

Sets or queries the current mask file name.

Syntax

DPOJET:MEAS<x>:MASKfile

Inputs

String

Outputs

String

DPOJET:MEAS<x>:BITCfgmethod
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GPIB Commands DPOJET:MEAS<x>:MEASRange:STATE

DPOJET:MEAS<x>:MEASRange:STATE

Turns on or off the measurement range limits.

Syntax

DPOJET :MEAS<X>:MEASRange:STATE

Inputs
1/0

Outputs
1/0

DPOJET:MEAS<x>:MEASRange:MIN

Sets or queries the minimum measurement range limit value.

Syntax

DPOJET :MEAS<X>:MEASRange :MIN

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:MEASRange:MAX

DPOJET:MEAS<x>:MEASRange:MAX

Sets or queries the maximum measurement range limit value.

Syntax

DPOJET :MEAS<X>:MEASRange :MAX

Inputs

<NR3>

Outputs

<NR3>

DPOJET:MEAS<x>:PHASENoise:LOWLimit

Sets or queries the lower phase noise integration limit.

Syntax

DPOJET :MEAS<x>:PHASENoise:LOWLimit

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:PHASENoise:HIGHLimit

DPOJET:MEAS<x>:PHASENoise:HIGHLimit

Sets or queries the upper phase noise integration limit.

Syntax

DPOJET :MEAS<X>:PHASENOise:HIGHLimit

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:L.OGging:STATistics:SELect

DPOJET:MEAS<x>:LOGging:STATistics:SELect

Sets or queries the given measurement for inclusion in any statistic logging. Statistic logging is turned on
or off as a whole, using the DPOJET:LOGging branch.

Syntax

DPOJET:MEAS<X>:L0GgQing:STATistics:SELect

Inputs
1/0

Outputs
1/0

DPOJET:MEAS<x>:LOGging:MEASurements:SELect

Sets or queries the given measurement for inclusion in any measurement logging. Statistic logging is
turned on or off as a whole, using the DPOJET:LOGging branch.

Syntax

DPOJET :MEAS<X>:L0OGging:MEASurements:SELect

Inputs
1/0

Outputs
1/0
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GPIB Commands DPOJET:MEAS<x>:L.OGging:MEASurements:FILEname?

DPOJET:MEAS<x>:LOGging:MEASurements:FILEname?

Queries current file name that will be used for the measurement, should measurement logging be turned on.

Syntax

DPOJET:MEAS<x>:L0OGging:MEASUrements:FILEname?

Outputs

String

DPOJET:MEAS<x>:LOGging:WORSTcase:SELect

Sets or queries the given measurement for inclusion in any worst case logging. Statistic logging is turned
on or off as a whole, using the DPOJET:LOGging branch.

Syntax

DPOJET:MEAS<x>:L0OGging:WORSTcase:SELect

Inputs
1/0

Outputs
1/0
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GPIB Commands DPOJET:GATING

DPOJET:GATING

Sets or queries the gating state.

Syntax

DPOJET :GATING

Inputs

{OFF, zOOM, CURSORS}

Outputs

{OFF, ZOOM, CURSORS}

220 DPOIJET Jitter and Eye Diagram Analysis Tools



GPIB Commands DPOJET:QUALIfy:STATE

DPOJET:QUALIfy:STATE

Turns on or off measurement qualification.

Syntax

DPOJET:QUAL1 fy:STATE

Inputs
1/0

Outputs
1/0

DPOJET:QUALIfy:SOUrce

Sets the qualifier source.

Syntax

DPOJET:QUAL1fy:SOUrce

Inputs

{CH1 - CH4, MATH1 - MATH4, REF1 - REF4}

Outputs

{CH1 - CH4, MATH1l - MATH4, REF1l - REF4}
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GPIB Commands DPOJET:QUALIify:ACTIVE

DPOJET:QUALIfy:ACTIVE

Sets the active state for the qualifier source, either HIGH or LOW.

Syntax

DPOJET:QUAL1 fy:ACTIVE

Inputs

{HIGH, Low}

Outputs

{HIGH, Low}

DPOJET:POPULATION:STATE

Turns on or off population limits.

Syntax

DPOJET : POPULATION:STATE

Inputs
1/0

Outputs
1/0
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GPIB Commands DPOJET:POPULATION:LIMITBY

DPOJET:POPULATION:LIMITBY

Sets or queries the mechanism by limits, either acquisition or population.

Syntax

DPOJET : POPULATION:LIMITBY

Inputs

{ACQuisitions, POPUTation}

Outputs

{ACQuisitions, POPUlation}

DPOJET:POPULATION:LIMIT

Sets or queries the current limit value.

Syntax

DPOJET : POPULATION:LIMIT

Inputs

<NR3>

Outputs

<NR1>
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GPIB Commands DPOJET:POPULATION:CONDition

DPOJET:POPULATION:CONDition

Sets or queries the current population limit condition.

Syntax

DPOJET : POPULATION:CONDition

Inputs

{EACHmeas | LASTmeas}

Outputs

{EACHmeas | LASTmeas}

DPOJET:LIMITRise

Turns on or off the ability to limit Rise/Fall measurements to transition bits only.

Syntax

DPOJET:LIMITRise

Inputs
1/0

Outputs
1/0
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GPIB Commands DPOJET:DIRacmodel

DPOJET:DIRacmodel

Sets or queries the current dirac model.

Syntax

DPOJET:DIRacmode]l

Inputs

{FIBREchannel, PCIExpress}

Outputs

{FIBREchannel, PCIExpress}

DPOJET:INTERp

Sets or queries the current interpolation model.

Syntax

DPOJET:INTERp

Inputs

{LINear, SINX}

Outputs

{LINear, SINX}
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GPIB Commands DPOJET:SOURCEAutoset

DPOJET:SOURCEAutoset

Performs a DPOJET horizontal, vertical, or autoset on both horizontal and vertical for any sources used in
current measurements.

Syntax

DPOJET :SOURCEAutoset

Inputs

{HORIzontal | VERTical | BOTH}

DPOJET:REFLevels:AUTOSet

Performs a DPOJET reflevel autoset on any sources selected using DPOJET:REFLevels:CH<x>:AUTOSet.

Syntax

DPOJET:REFLevels:AUTOSet

Inputs

EXECute

NOTE. All pieces of the reflevel branch have the ability to set ref levels for CH1-CH4, MATH1-MATH4, and
REF1-Ref4. Only the CH<x> portion is shown in this OLH,, but it exists and matches exactly for MATH
(DPOJET:REFLevels:MATH<x> and REF (DPOJET:REFLevels:REF<x>).
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GPIB Commands DPOJET:REFLevels:CH<x>:AUTOSet

DPOJET:REFLevels:CH<x>:AUTOSet

Sets or clears the reflevel autoset state of the given source. When set to 1, the given source will have a ref
level autoset done on it during the next acquisition.

Syntax

DPOJET:REFLevels:CH<x>:AUTOSet

Inputs
1/0

Outputs
1/0

NOTE. The Ref Level Autoset state is shown only for Ch1-Ch4 sources. It is the same for MATH and Ref waveforms.
For example: DPOJET:REFLevels: MATH<x>, DPOJET.REFLevels:REF<x>.

DPOJET:REFLevels:CH<x>:BASETop

Sets the base-top method for autoset.

Syntax

DPOJET:REFLevels:CH<x>:BASETop {MINMax, FULLhistogram, EYEhistogram, AUTO}

Inputs

{MINMax, FULLhistogram, EYEhistogram, AUTO}

Outputs

{MINMax, FULLhistogram, EYEhistogram, AUTO}
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GPIB Commands DPOJET:REFLevels:CH<x>:ABsolute

DPOJET:REFLevels:CH<x>:ABsolute

The ABSolute branch specifies the ref levels in the event a user chooses not to run a ref level autoset on a
given source. In the event the user does run a ref level autoset, the percentage values below are used.

DPOJET:REFLevels:CH<x>:ABsolute:RISEHigh

Sets the ref level voltage relative to base top for autoset.

Syntax

DPOJET:REFLevels:CH<x>:ABsolute:RISEHigh

Inputs

<NR3>

Outputs

<NR3>

DPOJET:REFLevels:CH<x>:ABsolute:RISEMid

Sets the ref level voltage relative to base top for autoset.

Syntax

DPOJET:REFLevels:CH<x>:ABsolute:RISEMid

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:REFLevels:CH<x>:ABsolute:RISELow

DPOJET:REFLevels:CH<x>:ABsolute:RISELow

Sets the ref level voltage relative to base top for autoset.

Syntax

DPOJET:REFLevels:CH<x>:ABsolute:RISELow

Inputs

<NR3>

Outputs

<NR3>

DPOJET:REFLevels:CH<x>:ABsolute:FALLHigh

Sets the ref level voltage relative to base top for autoset.

Syntax

DPOJET:REFLevels:CH<x>:ABsolute:FALLHigh

Inputs

<NR3>

Outputs

<NR3>

DPOIJET Jitter and Eye Diagram Analysis Tools 229



GPIB Commands DPOJET:REFLevels:CH<x>:ABsolute: FALLMid

DPOJET:REFLevels:CH<x>:ABsolute:FALLMid

Sets the ref level voltage relative to base top for autoset.

Syntax

DPOJET:REFLevels:CH<x>:ABsolute:FALLMid

Inputs

<NR3>

Outputs

<NR3>

DPOJET:REFLevels:CH<x>:ABsolute:FALLLow

Sets the ref level voltage relative to base top for autoset.

Syntax

DPOJET:REFLevels:CH<x>:ABsolute:FALLLow

Inputs

<NR3>

Outputs

<NR3>

230 DPOIJET Jitter and Eye Diagram Analysis Tools



GPIB Commands DPOJET:REFLevels:CH<x>:ABsolute:HY STeresis

DPOJET:REFLevels:CH<x>:ABsolute:HYSTeresis

Sets the hysteresis value used for autoset.

Syntax

DPOJET:REFLevels:CH<x>:ABsolute:HYSTeresis

Inputs

<NR3>

Outputs

<NR3>

DPOJET:REFLevels:CH<x>:PERcent

Sets percent reflevel parameters work as the absolute parameters do, only setting the various percentage
levels used by the autoset.

DPOJET:REFLevels:CH<x>:PERcent:RISEHigh

Sets the ref level voltage relative to base top for autoset.

Syntax

DPOJET:REFLevels:CH<x>:PERcent:RISEHigh

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:REFLevels:CH<x>:PERcent:RISEMid

DPOJET:REFLevels:CH<x>:PERcent:RISEMid

Sets the ref level voltage relative to base top for autoset.

Syntax

DPOJET:REFLevels:CH<x>:PERcent:RISEMid

Inputs

<NR3>

Outputs

<NR3>

DPOJET:REFLevels:CH<x>:PERcent:RISELow

Sets the ref level voltage relative to base top for autoset.

Syntax

DPOJET:REFLevels:CH<x>:PERcent:RISELow

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:REFLevels:CH<x>:PERcent:FALLHigh

DPOJET:REFLevels:CH<x>:PERcent:FALLHigh

Sets the ref level voltage relative to base top for autoset.

Syntax

DPOJET:REFLevels:CH<x>:PERcent:FALLHigh

Inputs

<NR3>

Outputs

<NR3>

DPOJET:REFLevels:CH<x>:PERcent:FALLMid

Sets the ref level voltage relative to base top for autoset.

Syntax

DPOJET:REFLevels:CH<x>:PERcent:FALLMid

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:REFLevels:CH<x>:PERcent:FALLLow

DPOJET:REFLevels:CH<x>:PERcent:FALLLow

Sets the ref level voltage relative to base top for autoset.

Syntax

DPOJET:REFLevels:CH<x>:PERcent:FALLLow

Inputs

<NR3>

Outputs

<NR3>

DPOJET:REFLevels:CH<x>:PERcent:HYSTeresis

Sets the hysteresis value used for autoset.

Syntax

DPOJET:REFLevels:CH<X>:PERcent:HYSTeresis

Inputs

<NR3>

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts?

Returns the measurement branch for the currently selected measurement for measurement slot <x>.

Syntax

DPOJET :MEAS<X>:RESULtS?
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GPIB Commands DPOJET:MEAS<x>:RESULts:CURRentacq:POPUlation?

DPOJET:MEAS<x>:RESULts:CURRentacq:POPUlation?

Returns the population measurement value for the currently selected measurement for measurement
slot <x>,

Syntax

DPOJET :MEAS<x>:RESULts:CURRentacq:POPUlation?

Outputs

<NR1>

DPOJET:MEAS<x>:RESULts:CURRentacq:POPUlation:STATus?

Returns the pass/fail status for the population measurement for the currently loaded limit file. (Set using
DPOJET:LIMits:FILEName)

Syntax

DPOJET :MEAS<X>:RESULtS :CURRentacq:POPUTation:STATuUs?

Outputs

{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:MEAN?

Returns the mean measurement for the currently loaded limit file.

Syntax

DPOJET :MEAS<X>:RESULtsS:CURRentacq:MEAN?

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:RESULts:CURRentacq:MEAN:STATus?

DPOJET:MEAS<x>:RESULts:CURRentacq:MEAN:STATus?

Returns the pass/fail status for the mean measurement for the currently loaded limit file. (Set using
DPOJET:LIMits:FILEName)

Syntax

DPOJET :MEAS<X>:RESULtS:CURRentacq:MEAN:STATuUS?

Outputs

{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:STDDev?

Returns the standard deviation of the measurement value for the currently selected measurement for
measurement slot <x>.

Syntax

DPOJET:MEAS<x>:RESULts:CURRentacq:StdDev?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:CURRentacq:STDDev:STATus?
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Returns the pass/fail status for the standard deviation measurement for the currently loaded limit file.
(Set using DPOJET:LIMits:FILEName)

Syntax

DPOJET :MEAS<X>:RESULtS:CURRentacq: STDDev:STATus?

Outputs

{PASS | FAIL}
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GPIB Commands DPOJET:MEAS<x>:RESULts:CURRentacq:MAX?

DPOJET:MEAS<x>:RESULts:CURRentacq:MAX?

Returns the maximum value of the measurement value for the currently selected measurement for
measurement slot <x>,

Syntax

DPOJET :MEAS<X>:RESULts:CURRentacq:MAX?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:CURRentacq:MAX:STATus?

Returns the pass/fail status for the max measurement for the currently loaded limit file. (Set using
DPOJET:LIMits:FILEName)

Syntax

DPOJET :MEAS<X>:RESULtS:CURRentacq:MAX:STATuUS?

Outputs

{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:MIN?

Returns the minimum value for the currently selected measurement for measurement slot <x>.

Syntax

DPOJET :MEAS<X>:RESULts:CURRentacq:MIN?

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:RESULts:CURRentacq:MIN:STATus?

DPOJET:MEAS<x>:RESULts:CURRentacq:MIN:STATus?

Returns the pass/fail status for the minimum measurement for the currently loaded limit file. (Set using
DPOJET:LIMits:FILEName)

Syntax

DPOJET :MEAS<X>:RESULtS:CURRentacq:MIN:STATuUs?

Outputs

{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:PK2PK?

Returns the peak-to-peak value for the currently selected measurement for measurement slot <x>.

Syntax

DPOJET :MEAS<x>:RESULts:CURRentacq: PK2PK?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:CURRentacq:PK2PK:STATus?
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Returns the pass/fail status for the peak-to-peak measurement for the currently loaded limit file. (Set using
DPOJET:LIMits:FILEName)

Syntax

DPOJET :MEAS<X>:RESULts:CURRentacq:PK2PK:STATus?

Outputs

{PASS | FAIL}
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GPIB Commands DPOJET:MEAS<x>:RESULts:CURRentacq:MAXCC?

DPOJET:MEAS<x>:RESULts:CURRentacq:MAXCC?

Returns the maximum positive cycle-to-cycle delta of the selected measurement.

Syntax

DPOJET :MEAS<X>:RESULtS:CURRentacq:MAXCC?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:CURRentacq:MAXCC:STATus?

Returns the pass/fail status for the max cycle-to-cycle measurement for the currently loaded limit file.
(Set using DPOJET:LIMits:FILEName)

Syntax

DPOJET :MEAS<X>:RESULtsS:CURRentacq:MAXCC:STATus?

Outputs

{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:MINCC?

Returns the maximum negative cycle-to-cycle delta of the selected measurement.

Syntax

DPOJET :MEAS<X>:RESULts:CURRentacq:MINCC?

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:RESULts:CURRentacq:MINCC:STATus?

DPOJET:MEAS<x>:RESULts:CURRentacq:MINCC:STATus?

Returns the pass/fail status for the min cycle-to-cycle measurement for the currently loaded limit file.
(Set using DPOJET:LIMits:FILEName)

Syntax

DPOJET :MEAS<X>:RESULtS:CURRentacq:MINCC:STATuUS?

Outputs

{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLAcqgs:POPUlation?

Returns the mean measurement value for the currently selected measurement for measurement slot <x>.

Syntax

DPOJET:MEAS<x>:RESULtSs:ALLAcqgs:POPUTation?

Outputs

<NR1>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MEAN?
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Returns the mean value for all accumulated measurement acquisitions for slot <x>.

Syntax

DPOJET :MEAS<X>:RESULtS:ALLACQS :MEAN?

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:RESULts:ALLAcqs:STDev?

DPOJET:MEAS<x>:RESULts:ALLAcqs:STDev?

Returns the standard deviation for all accumulated measurement acquisitions for slot <x>.

Syntax

DPOJET :MEAS<X>:RESULtS:ALLACQs:STDev?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MAX?

Returns the maximum value for all accumulated measurement acquisitions for slot <x>.

Syntax

DPOJET :MEAS<X>:RESULtS:ALLACQS :MAX?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MIN?

Returns the minimum value for all accumulated measurement acquisitions for slot <x>.

Syntax

DPOJET :MEAS<X>:RESULtS:ALLACQS :MIN?

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:RESULts:ALLAcqs:PK2PK?

DPOJET:MEAS<x>:RESULts:ALLAcqs:PK2PK?

Returns the peak-to-peak value for all accumulated measurement acquisitions for slot <x>.

Syntax

DPOJET :MEAS<X>:RESULtS:ALLAC(QS:PK2PK?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXCC?

Returns the maximum positive cycle-to-cycle delta of the selected measurement.

Syntax

DPOJET:MEAS<X>:RESULtSs:ALLACQs :MAXCC

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MINCC?
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Returns the maximum negative cycle-to-cycle delta of the selected measurement.

Syntax

DPOJET :MEAS<X>:RESULtS:ALLACQS :MINCC?

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:MINHits?

DPOJET:MEAS<x>:RESULts:ALLAcqgs:SEG<x>:MINHits?

Returns the minimum mask hits measurement for the given segment, either SEG1, SEG2 or SEG3.

Syntax

DPOJET :MEAS<X>:RESULtS:ALLACQS : SEG<X>:MINHits?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqgs:SEG<x>:MAXHits?

Returns the maximum mask hits measurement for the given segment, either SEG1, SEG2 or SEG3.

Syntax

DPOJET:MEAS<X>:RESULtS:ALLACQS : SEG<X>:MAXHits?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqgs:SEG<x>:Hits?

Returns the mask hits measurement for the given segment, either SEG1, SEG2 or SEG3.

Syntax

DPOJET:MEAS<X>:RESULts:ALLAC(QS:SEG<X>:Hits?

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:RESULts:ALLAcqs:MINHits?

DPOJET:MEAS<x>:RESULts:ALLAcqs:MINHits?

Returns the minimum mask hits measurement for all segments.

Syntax

DPOJET :MEAS<X>:RESULtS:ALLACQS :MINHits?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXHits?

Returns the maximum mask hits measurement for all segments.

Syntax

DPOJET:MEAS<X>:RESULtS:ALLACQS :MAXHits?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqgs:HITS?

Returns the mask hits measurement for all segments.

Syntax

DPOJET :MEAS<X>:RESULtS:ALLACQS:HITS?

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:RESULts:ALLAcqgs:HITPopulation?

DPOJET:MEAS<x>:RESULts:ALLAcqgs:HITPopulation?

Returns the mask hit population.

Syntax

DPOJET:MEAS<x>:RESULts:ALLAcqs:HITPopulation?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULTS:STATus?

Returns the status of the given measurement values in slot MEAS<x>. Valid for currently valid
measurements, or the error status such as “Not enough edges”.

Syntax

DPOJET :MEAS<X>:RESULTS:STATuUs?

Outputs

String
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GPIB Commands DPOJET:ADDPlot

DPOJET:ADDPIot

This set-only command creates a plot of the specified type on the specified DPOJET measurement. Up
to four plots can be created.

Syntax

DPOJET:ADDPTOt

Inputs

{TIMEtrend | DATAarray | HISTOgram | SPECtrum | TRANSfer | PHASEnoise | EYE |
WAVEform | BATHtub}, MEAS<x>}

Example

DPOJET:ADDPTot HISTOgram, MEAS2

DPOJET:CLEARALLPIots

This set-only parameter clears the entire current list of defined plots in DPOJET.

Syntax

DPOJET:CLEARALLP1OtS

Arguments

NONE

Outputs

NONE
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GPIB Commands DPOJET:PLOT<x>:TYPe?

DPOJET:PLOT<x>:TYPe?

Returns the current plot type for the selected plot.

Syntax

DPOJET:PLOT<X>:TYPe?

Outputs

{TIMEtrend | DATAarray | HISTOgram | SPECtrum | TRANSfer | PHASEnoise | EYE
| WAVEform | BATHtub}

DPOJET:PLOT<x>:SOUrce?

Returns the source measurement for the selected plot.

Syntax

DPOJET:PLOT<X>:SOUrce?

Outputs

{MEAS1 - MEAS99}
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GPIB Commands

DPOJET:PLOT<x>:TREND:TYPe

Sets or returns the trend type setting for Trend plots.

Syntax

DPOJET:PLOT<X>:TREND:TYPe

Inputs

{VECTOR | BAR}

Outputs

{VECTOR | BAR}

DPOJET:PLOT<x>:HISTOgram:AUTOset
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Runs a histogram autoset for the specified slot.

Syntax

DPOJET:PLOT<X>:HISTOgram:AUTOset

Inputs

{EXECute}

DPOJET:PLOT<x>:TREND:TYPe

NOTE. Undefined for non-histogram plots.
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GPIB Commands DPOJET:PLOT<x>:HISTOgram:VERTical:SCALE

DPOJET:PLOT<x>:HISTOgram:VERTical:SCALE

Sets or returns the vertical scale setting for applicable plots, either Linear or Log.

Syntax

DPOJET:PLOT<X>:HISTOgram:VERTical:SCALE

Inputs

{LINEAR | LOG}

Outputs

{LINEAR | LOG}

NOTE. Undefined for non-histogram plots.

DPOJET:PLOT<x>:HISTOgram:HORizontal:AUTOscale

Sets or returns the horizontal auto scale settings.

Syntax

DPOJET:PLOT<X>:HISTOgram:HORizontal:AUTOscale

Inputs
1/0

Outputs
1/0

NOTE. Undefined for non-histogram plots.
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GPIB Commands DPOJET:PLOT<x>:HISTOgram:HORizontal:RESolution

DPOJET:PLOT<x>:HISTOgram:HORizontal:RESolution

Sets or returns the horizontal resolution used in Eye Diagram plots.

Syntax

DPOJET:PLOT<X>:HISTOgram:HORizontal:RESolution

Inputs

<NR3>

Outputs

<NR3>

NOTE. Undefined for non-histogram plots.

DPOJET:PLOT<x>:HISTOgram:NUMBins

Sets or queries the current histogram resolution.

Syntax

DPOJET:PLOT<x>:HISTOgram:NUMBins

Inputs

{TWENtyfive | FIFTY | HUNdred | TwWOFifty | FIVEHundred}

Outputs

{TwWENtyfive | FIFTY | HUNdred | TwWOFifty | FIVEHundred}

NOTE. Undefined for non-histogram plots.
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GPIB Commands DPOJET:PLOT<x>:HISTOgram:HORizontal: CENter

DPOJET:PLOT<x>:HISTOgram:HORizontal:CENter

Sets or returns the histogram center.

Syntax

DPOJET:PLOT<X>:HISTOgram:HORizontal:CENter

Inputs

<NR3>

Outputs

<NR3>

NOTE. Undefined for non-histogram plots.

DPOJET:PLOT<x>:HISTOgram:HORizontal:SPAN

Sets or returns the histogram span.

Syntax

DPOJET:PLOT<X>:HISTOgram:HOR1izontal:SPAN

Inputs

<NR3>

Outputs

<NR3>

NOTE. Undefined for non-histogram plots.
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GPIB Commands DPOJET:PLOT<x>:SPECtrum:VERTical:SCALE

DPOJET:PLOT<x>:SPECtrum:VERTical:SCALE

Sets or returns the vertical scale setting for applicable plots, either Linear or Log.

Syntax

DPOJET:PLOT<X>:SPECtrum:VERTical:SCALE

Inputs

{LINEAR | LOG}

Outputs

{LINEAR | LOG}

NOTE. Undefined for non-spectrum plots.

DPOJET:PLOT<x>:SPECtrum:HORizontal:SCALE

Sets or returns the horizontal scale setting for applicable plots, either Linear or Log.

Syntax

DPOJET:PLOT<X>:SPECtrum:HORizontal:SCALE

Inputs

{LINEAR | LOG}

Outputs

{LINEAR | LOG}

NOTE. Undefined for non-spectrum plots.
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GPIB Commands DPOJET:PLOT<x>:SPECtrum:BASE

DPOJET:PLOT<x>:SPECtrum:BASE

Sets or returns the spectrum base. Undefined for non-spectrum plots.

Syntax

DPOJET:PLOT<X>:SPECtrum:BASE

Inputs

<NR3>

Outputs

<NR1>

DPOJET:PLOT<x>:SPECtrum:MODE

Sets or returns the spectrum mode.

Syntax

DPOJET:PLOT<X>:SPECtrum:MODE

Inputs

{NORMal | AVErage | PEAKhold}

Outputs

{NORMal | AVErage | PEAKhold}
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GPIB Commands DPOJET:PLOT<x>:TRANSfer:VERTical:SCALE

DPOJET:PLOT<x>:TRANSfer:VERTical:SCALE

Sets or returns the vertical scale setting for applicable plots, either Linear or Log. Undefined for
non-transfer plots.

Syntax

DPOJET:PLOT<x>:TRANSfer:VERTical:SCALE

Inputs

{LINEAR | LOG}

Outputs

{LINEAR | LOG}

DPOJET:PLOT<x>:TRANSfer:HORizontal:SCALE

Sets or returns the horizontal scale setting for applicable plots, either Linear or Log. Undefined for
non-transfer plots.

Inputs

{LINEAR | LOG}

Outputs

{LINEAR | LOG}
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GPIB Commands DPOJET:PLOT<x>:TRANSfer:MODE

DPOJET:PLOT<x>:TRANSfer:MODE

Sets or returns the transfer plot mode.

Syntax

DPOJET:PLOT<x>:TRANSfer:MODE

Inputs

{NORMal | AVErage}

Outputs

{NORMal | AVErage}

DPOJET:PLOT<x>:TRANSfer:NUMerator

Sets or returns the transfer plot numerator.

Syntax

DPOJET:PLOT<X>:TRANSfer:NUMerator

Inputs

{MEAS1 - MEAS99}

Outputs

{MEAS1 - MEAS99}

NOTE. Undefined for non-transfer plots.
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GPIB Commands

DPOJET:PLOT<x>:TRANSfer:DENominator

DPOJET:PLOT<x>:TRANSfer:DENominator

Sets or returns the transfer plot denominator.

Syntax

DPOJET:PLOT<X>:TRANSTer:DENominator

Inputs

{MEAS1 - MEAS99}

Outputs

{MEAS1 - MEAS99}

NOTE. Undefined for non-transfer plots.

DPOJET:PLOT<x>:PHASEnoise:BASEline
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Sets or returns the phase noise baseline.

Syntax

DPOJET:PLOT<X>:PHASEnoise:BASETline

Inputs

<NR3>

Outputs

<NR1>

NOTE. Undefined for non-phase noise plots.
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GPIB Commands DPOJET:PLOT<x>:BATHtub:VERTical:SCALE

DPOJET:PLOT<x>:BATHtub:VERTical:SCALE

Sets or returns the vertical scale setting for applicable plots, either Linear or Log.

Syntax

DPOJET:PLOT<X>:BATHtub:VERTical:SCALE

Inputs

{LINEAR | LOG}

Outputs

{LINEAR | LOG}

NOTE. Undefined for non-bathtub plots.

DPOJET:PLOT<x>:BATHtub:BER

Sets or returns the bathtub BER value.

Syntax

DPOJET:PLOT<X>:BATHtub:BER

Inputs

<NR3>

Outputs

<NR1>

NOTE. Undefined for non-bathtub plots.
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GPIB Commands DPOJET:PLOT<x>:EYE:HORizontal:RESolution

DPOJET:PLOT<x>:EYE:HORizontal:RESolution

Sets or returns the Horizontal Eye resolution.

Syntax

DPOJET:PLOT<X>:EYE:HORizontal:RESoTlution

Inputs

<NR3>

Outputs

<NR1>

NOTE. Undefined for non-eye plots.

DPOJET:PLOT<x>:EYE:HORizontal:AUTOscale

Sets or returns the horizontal auto scale setting.

Syntax

DPOJET:PLOT<X>:EYE:HORizontal:AUTOscale

Inputs
1/0

Outputs
1/0

NOTE. Undefined for non-eye plots.
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GPIB Commands DPOJET:PLOT<x>:EYE:STATE

DPOJET:PLOT<x>:EYE:STATE

Sets or returns the eye state, either on or off.

Syntax

DPOJET:PLOT<X>:EYE:STATE

Inputs
1/0

Outputs
1/0

NOTE. Undefined for non-eye plots.

DPOJET:PLOT<x>:EYE:MASKfile

Sets or returns the mask file.

Syntax

DPOJET:PLOT<X>:EYE:MASKfile

Inputs

String

Outputs

String

NOTE. Undefined for non-eye plots.
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GPIB Commands DPOJET:REPORT

DPOJET:REPORT

This set-only parameter executes a DPOJET report save operation for the currently defined report
configuration.

Syntax

DPOJET :REPORT

Inputs

EXECute

DPOJET:REPORT:SETupconfig

Turns on or off including setup configuration in reports.

Syntax

DPOJET:REPORT:SETupconfig

Inputs
1/0

Outputs
1/0
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GPIB Commands DPOJET:REPORT:APPIlicationconfig

DPOJET:REPORT:APPIlicationconfig

Turns on or off including complete application configuration in reports.

Syntax

DPOJET:REPORT:APPlicationconfig

Inputs
1/0

Outputs
1/0

DPOJET:REPORT:PASSFailresults

Turns on or off including pass/fail results in reports.

Syntax

DPOJET:REPORT:PASSFailresults

Inputs
1/0

Outputs
1/0
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GPIB Commands DPOJET:REPORT:DETailedresults

DPOJET:REPORT:DETailedresults

Turns on or off including detailed results in reports.

Syntax

DPOJET:REPORT:DETailedresults

Inputs
1/0

Outputs
1/0

DPOJET:REPORT:PLOTimages

Turns on or off including detailed plot images in reports.

Syntax

DPOJET:REPORT:PLOTimages

Inputs
1/0

Outputs
1/0
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GPIB Commands DPOJET:REPORT:AUTOincrement

DPOJET:REPORT:AUTOincrement

Turns on or off auto increment of report file names.

Syntax

DPOJET:REPORT:AUTOincrement

Inputs
1/0

Outputs
1/0

DPOJET:REPORT:VIEWreport

Turns on or off viewing report after generation.

Syntax

DPOJET:REPORT:VIEWreport

Inputs
1/0

Outputs
1/0
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GPIB Commands

DPOJET:REPORT:REPORTName

264

Sets the current report file name.

Syntax

DPOJET :REPORT : REPORTName

Inputs

String

Outputs

String

DPOJET:REPORT:REPORTName
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GPIB Commands DPOJET:LOGging:SNAPshot

DPOJET:LOGging:SNAPshot

DPOJET export of the specified type, either for statistics or measurements.

Syntax

DPOJET:LOGging:SNAPshot {STATistics | MEASurements}

Inputs

{STATistics | MEASurements}

Outputs

{STATistics | MEASurements}

DPOJET:LOGging:STATistics:STATE

Turns on or off the future logging of statistics. Individual measurements included in the logging are
selected using the DPOJET:MEAS<x>:LOGging node. This parameter turns on or off the entire set of
included measurements.

Syntax

DPOJET:LOGQing:STATistics:STATE

Inputs
1/0

Outputs
1/0
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GPIB Commands DPOJET:LOGging:STATistics:FILEname

DPOJET:LOGging:STATistics:FILEname

Sets or returns the current file used for statistics logging.

Syntax

DPOJET:LOGgQing:STATistics:FILEname

Inputs

String

Outputs

String

DPOJET:LOGging:MEASurements:STATE

Turns on or off the future logging of measurements. Individual measurements included in the logging
are selected using the DPOJET:MEAS<x>:LOGging node. This parameter turns on or off the entire
set of included measurements.

Syntax

DPOJET:LOGging:MEASurements:STATE

Inputs

String

Outputs

String
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GPIB Commands DPOJET:LOGging:MEASurements:FOLDer

DPOJET:LOGging:MEASurements:FOLDer

Sets or returns the current folder used for measurement logging.

Syntax

DPOJET:LOGging:MEASuUrements:FOLDer

Inputs

String

Outputs

String

DPOJET:LOGging:WORSTcase:STATE

Turns on or off the future logging of worst case waveforms. Individual measurements included in the
logging are selected using the DPOJET:MEAS<x>:LOGging node. This parameter turns on or off the
entire set of included measurements.

Syntax

DPOJET:LOGging:WORSTcase: STATE

Inputs
1/0

Outputs
1/0
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GPIB Commands DPOJET:LOGging:WORSTcase:FOLDer

DPOJET:LOGging:WORSTcase:FOLDer

Sets or returns the current folder used for worst case logging.

NOTE. Waveform filenames generated while worst case logging is on will follow the syntax of, “Measurement
Name™“Source”_Min1.wfm and “Measurement Name™-“Source”_Max1.wfm, For example: Period1-Ch1_Max1.wfm,
Period1-Ch1_Min1.wfm, Rise Time1-Ch1_Max1.wfm, Rise Time1-Ch1_Min1.wfm

Syntax

DPOJET:LOGging:WORSTcase:FOLDer

Inputs

String

Outputs

String
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GPIB Commands DPOJET:LIMits:STATE

DPOJET:LIMits:STATE

Turns on or off the pass-fail limit system. Pass-fail status can be queried using the DPOJET:MEAS
<x>:RESULTS node.

Syntax

DPOJET:LIMits:STATE

Inputs
1/0

Outputs
1/0

DPOJET:LIMits:FILEName

Sets or returns the current limits filename.

Syntax

DPOJET:LIMits:FILEName

Inputs

String

Outputs

String
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GPIB Commands DPOJET:DESKEW

DPOJET:DESKEW

Performs a DPOJET deskew operation with the settings specified in DPOJET:DESKEW.

Syntax

DPOJET:DESKEW EXEcute

Inputs

EXEcute

DPOJET:DESKEW:REFChannel

Sets or queries the reference channel used for deskew operation.

Syntax

DPOJET:DESKEW:REFChannel

Inputs

{CH1-CH4}

Outputs
{CH1-CH4}
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GPIB Commands DPOJET:DESKEW:REFMidlevel

DPOJET:DESKEW:REFMidlevel

Sets or returns the reference channel midlevel value.

Syntax

DPOJET :DESKEW:REFMidlevel

Inputs

<NR3>

Outputs

<NR3>

DPOJET:DESKEW:REFHysteresis

Sets or returns the reference channel hysteresis value.

Syntax

DPOJET:DESKEW:REFHysteresis

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:DESKEW:DESKEW-channel

DPOJET:DESKEW:DESKEWchannel

Sets or queries the channel to be deskewed.

Syntax

DPOJET :DESKEW:DESKEWchannel

Inputs

{CH1-CH4}

Outputs
{CH1-CH4}

DPOJET:DESKEW:DESKEWMidlevel

Sets or returns the deskew channel midlevel value.

Syntax

DPOJET :DESKEW:DESKEWMidTlevel

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:DESKEW:DESKEWHysteresis

DPOJET:DESKEW:DESKEWHysteresis

Sets or returns the deskew channel hysteresis value.

Syntax

DPOJET :DESKEW:DESKEWHySteresis

Inputs

<NR3>

Outputs

<NR3>

DPOJET:DESKEW:MAXimum

Sets or returns the maximum deskew value possible.

Syntax

DPOJET : DESKEW : MAXimum

Inputs

<NR3>

Outputs

<NR3>

DPOIJET Jitter and Eye Diagram Analysis Tools 273



GPIB Commands DPOJET:DESKEW:MINimum

DPOJET:DESKEW:MINimum

Sets or returns the minimum deskew value possible.

Syntax

DPOJET : DESKEW :MINimum

Inputs

<NR3>

Outputs

<NR3>

DPOJET:DESKEW:EDGE

Sets or returns the edge types used when calculating deskew.

Syntax

DPOJET :DESKEW: EDGE

Inputs

{RISE | FALL | BOTH}

Outputs

{RISE | FALL | BOTH}
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GPIB Commands DPOJET:VERsion?

DPOJET:VERsion?

Returns the current DPOJET version string.

Syntax

DPOJET:VERsion?

Outputs

String

DPOJET:NUMMeas?

Returns the current number of defined measurements.

Syntax

DPOJET :NUMMeas?

Outputs

<NR1>

DPOJET:HIGHPerfrendering

Sets or queries the current high-performance eye rendering setting.

Syntax

DPOJET:HIGHPerfrendering

Inputs
1/0

Outputs

<NR1>
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GPIB Commands DPOJET:UNITType

DPOJET:UNITType

Sets or queries the current unit typesetting for DPOJET, either Unit Interval, or seconds.

Syntax

DPOJET:UNITType

Inputs

{UNITinterval, SEConds}

Outputs

{UNITinterval, SEConds}

DPOJET:SAVE

Set-only parameter saves the specified DPOJET measurement result, to the specified ref. For Example:
DPOJET:SAVE MEAS4, REF2

Syntax

DPOJET :SAVE

Inputs

{MEAS1-MEAS99, REF1-REF4}
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GPIB Commands DPOJET:EXPORT

DPOJET:EXPORT

This sets-only parameter saves the specified DPOJET plot, to the specified file path. The Format is
determined through the filename extension, with a default of png should no extension be specified.

Supported extensions include jpeg, jpg, tif, tiff, bmp, emf, and png. For example: DPOJET:EXPORT
PLOT1, “savedimage.tif”.

Syntax

DPOJET : EXPORT

Inputs

{PLOT1-PLOT4, <file string>}
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GPIB Commands DPOJET:EXPORT
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